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About this information product

...............................................................................................................................................................................................................................................................

Purpose This User Operations Guide provides information a user needs to
operate LambdaXtreme™ Transport including provisioning equipment,
establishing optical channel connections, and using the
LambdaXtreme™ Transport Craft Interface Terminal (CIT).

Reason for reissue This document addresses LambdaXtreme™ Transport Release 1.1.

Safety labels The following safety labels are used in this document:

DANGER
This admonishment shows the presence of a hazard that will
cause death or severe personal injury if the hazard is not
avoided.

....................................................................................................................................................................................................................................
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WARNING
This admonishment shows the presence of a hazard that can
cause death or severe personal injury if the hazard is not
avoided.

CAUTION
This admonishment shows the presence of a hazard that will
or can cause minor personal injury or property damage if
the hazard is not avoided. Caution is also used for
property-damage-only accidents. This includes equipment
damage, loss of software, or service interruption.

Intended audience This manual is intended primarily for individuals in the field of
telecommunications and for communications network providers.

Descriptive material in this document may be used by anyone desiring
specific information or knowledge on the operational functions and
features of LambdaXtreme™ Transport.

Procedural tasks in this document are written primarily for personnel
responsible for the operation and maintenance of LambdaXtreme™

Transport.

How to use this
information product

The chapters in this document provide the following information:

Chapter 1, “Introduction”, presents a summary description of
LambdaXtreme™ Transport.

Chapter 2, “Operations”, describes the interfaces and software support
of operations for LambdaXtreme™ Transport.

Chapter 3, “Security Administration”, details the security
administration features in LambdaXtreme™ Transport

Chapter 4, “Equipment Provisioning”, provides information for
provisioning LambdaXtreme™ Transport equipment.

Chapter 5, “Establishing Optical Channel Connections”, describes the
autodiscovery and autoprovisioning features of LambdaXtreme™

Release 1.1 About this information product
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Transport and provides information for provisioning optical channel
connections.

Chapter 6, “System Maintenance”, provides detailed “how to”
instructions for performing basic maintenance activities and test
procedures on LambdaXtreme™ Transport.

Chapter 7, “Craft Interface Terminal”, presents a description of the
LambdaXtreme™ Transport Craft Interface Terminal (CIT).

Appendix A, “Using the CIT”, describes step-by-step procedures for
performing tasks using the LambdaXtreme™ Transport CIT.

The “Glossary” provides a list of common terms and acronyms.

The “Index” provides page numbers for key words and subject names.

Conventions used The following typographical conventions are used throughout this
document:

• Bold face type is used to identify CIT menu selections and
button selections.

Related documentation The LambdaXtreme™ Transport User Operations Guide is part of a
set of documents that support the LambdaXtreme™ Transport System.
The following items are included in the set:

Document
Number

Document Title

365–575–780R1.1 LambdaXtreme™ Transport Applications and
Planning Guide, Release 1.1

365–575–781R1.1 LambdaXtreme™ Transport User Operations
Guide, Release 1.1

365–575–783R1.1 LambdaXtreme™ Transport Alarms, Messages,
and Trouble Clearing Guide, Release 1.1

365-575-782R1.1 LambdaXtreme™ Transport Installation Manual
and System Turn-up Services, Release 1.1

Comcode
109163642

LambdaXtreme™ Transport Software Release
Description, Release 1.1

365–575–797 LambdaXtreme™ Transport Software Ordering
Guide

Release 1.1 About this information product

....................................................................................................................................................................................................................................

365-575-781R1.1
Issue 1, June 2002
,

Lucent Technologies - Proprietary
See notice on first page

x v i i



Related training The Lucent Learning (LL) Organization provides management courses
for system planning, engineering, and ordering, as well as courses to
train telecommunications technicians in installation, operations, and
maintenance. To enroll in training classes, call the Lucent Learning
Organization at 1-888-LUCENT8 (1-888-582-3688) Prompt 2 -
Prompt 2, or fax to 1-407-767-2677. The International registration
number is 1-407-767-2798. Suitcasing of these courses is also
available. To arrange suitcase sessions (within USA), call the Product
Training Manager at 1-888-582-3688, Prompt 2 - Prompt 1.

The available LambdaXtreme™ Transport courses are listed in the
following table.

Course Number Course Title

LW2471 LambdaXtreme™ Transport Installation &
Testing

LW2271 LambdaXtreme™ Transport Applications and
Planning

LW2671 LambdaXtreme™ Transport Operations and
Maintenance

Schedule and Registration

For more information or to register for any of these courses, call:

1-888-LUCENT8 and select option 2

Fax: 1-407-767-2677

Or write to:

Lucent Technologies

Lucent Learning

240 E. Central Parkway

Altamonte Springs, FL 32701

Technical Support
Telephone Number

The Lucent Technologies Global TSS Contact Center provides a
technical assistance telephone number that is monitored 24 hours a
day. For technical assistance, call 1-866-LUCENT8 (1-866-582-3688)
and select the appropriate prompt. Outside the continental United
States, call 1-630-224-4672.

Release 1.1 About this information product
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Lightwave Safety
Guidelines

The following precautions should be observed.

General Laser Information

The LambdaXtreme™ Transport and associated optical test sets use
semiconductor laser transmitters that emit light at wavelengths
between approximately 800 nanometers (nm) and 1600 nm. The
emitted light is above the red end of the visible spectrum, which is
normally not visible to the human eye. Although radiant energy at
near-infrared wavelengths is officially designated invisible, some
people can see the shorter wavelength energy even at power levels
several orders of magnitude below any that have been shown to cause
injury to the eye.

Conventional lasers can produce an intense beam of monochromatic
light. Monochromatic light is a single wavelength output of pure color
that may be visible or invisible to the eye. A conventional laser
produces a small-size beam of light, and because the beam size is
small the power density (also called irradiance) is very high.
Consequently, lasers and laser products are subject to federal and
applicable state regulations as well as international standards for their
safe operation.

A conventional laser beam expands very little over distance or is said
to be very well collimated. Thus, conventional laser irradiance
remains relatively constant over distance. However, lasers used in
lightwave systems have a large beam divergence, typically 10 to 20
degrees. Here, irradiance obeys the inverse square law (doubling the
distance reduces the irradiance by a factor of 4 and rapidly decreases
over distance.

Lasers and Eye Damage

Light energy emitted by laser and high-radiance light-emitting diodes
(LEDs) in the 400 to 1400 nm range may cause eye damage if
absorbed by the retina. When a beam of light enters the eye, the eye
magnifies and focuses the energy, magnifying the irradiance. The
irradiance of the energy that reaches the retina is approximately 105 or
100,000 times that at the cornea, and if sufficiently intense, may cause
a retinal burn.

The damage mechanism at the wavelengths used in telecommunica-
tions is thermal in origin, for example, damage caused by heating.
Therefore, a specific amount of energy is required for a definite time

Release 1.1 About this information product
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to heat an area of retinal tissue. Damage is not instantaneous. It
occurs only when one looks at the light sufficiently long enough that
the product of the retinal irradiance and the viewing time exceeds the
damage threshold. Light energies above 1400 nm would cause surface
and skin burns and do not affect the retina. The thresholds for injury
at wavelengths greater than 1400 nm are significantly higher than for
wavelengths in the retinal hazard region.

Classification of Lasers

Manufacturers of lasers and laser products in the United States are
regulated by the Food and Drug Administration’s Center for Devices
and Radiological Health (FDA/CDRH) under 21 CFR 1040. These
regulations require manufacturers to certify each laser or laser product
as belonging to one of seven major Classes 1, 1M, 2, 2M, 3R, 3B,
and 4. The International Electro-technical Commission (IEC) is an
international standards body that writes laser safety standards under
IEC-60825. Classification schemes are similar with Classes divided
into Classes 1, 1M, 3R, 3B, and 4. Lasers are classified according to
the accessible emission limits and their potential for causing injury.
Lightwave systems are generally classified as Class 1, because, under
normal operating conditions, all energized laser transmitting circuit
packs are terminated on optical fibers which enclose the laser energy
with the fiber sheath forming a protective housing. Also, covers are in
place over the circuit pack shelves. The circuit packs themselves,
however, may be FDA/CDRH Class 1 or 3B, or IEC Class 1, 3R, or
3B.

Lightwave Safety Precautions

Under normal operating conditions, the LambdaXtreme™ Transport
System is totally enclosed and presents no risk of eye injury. It is a
Class 1M system under the FDA/CDRH scheme.

The lightguide cables that interconnect various components of a
lightwave system can disconnect or break and may expose people to
lightwave emission. Also, certain measures and maintenance
procedures may expose the technician to emission from the
semiconductor laser during installation and servicing. Unlike more
familiar laser devices, such as solid-state and gas lasers, the emission
pattern of a semiconductor laser results in a highly divergent beam. In
a divergent beam, the irradiance (power density) decreases rapidly
with distance. The greater the distance, the less energy will enter the
eye and the less potential risk for eye injury.

Release 1.1 About this information product
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Inadvertently viewing an unterminated fiber or damaged fiber with the
unaided eye at distances greater than 5 to 6 inches normally will not
cause eye injury provided the power in the fiber is less than a few
milliwatts at the shorter wavelengths and higher at the longer
wavelengths. However, damage may occur if an optical instrument
such as a microscope, magnifying glass, or eye loupe is used to stare
at the energized fiber end.

WARNING
Use of controls, or adjustments, or performance of
procedures other than those specified herein may result in
hazardous laser radiation exposure.

Safety Precautions for Enclosed Systems

Under normal operating conditions, the LambdaXtreme™ Transport
System is completely enclosed; nonetheless, the following precautions
should be observed:

• Because of the potential for eye damage, technicians should
neither disconnect any lightwave cable nor splice or stare into the
optical connectors terminating the cables.

• Under no circumstance should lightwave/lightguide operations be
performed by a technician before satisfactorily completing an
approved training course.

• Since viewing lightwave emission directly with an optical
instrument such as an eye loupe greatly increases the risk of eye
damage, an appropriate label must appear in plain view on the
front of the main frame or lightguide termination/interconnection
equipment.

Safety Precautions for Unenclosed Systems

The Automatic Power Reduction (APR) feature brings the optical
amplifier output power and Raman pump output power to safe levels
in the event of a fiber cut, removed connector or equipment failure.
The main concerns with respect to time to reduce power are human
safety and prevention of optical surges. Once the system has been
repaired or links have been re-established, the feature also ensures
restoration to normal operation.

Release 1.1 About this information product
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DANGER
Automatic Power Reduction (APR) is not available during
maintenance or other applicable scenarios. This includes
system or circuit pack resets. For example, when the SCTL
fails, APR is unavailable until the pack is replaced and the
system rebooted.

During service, maintenance, or restoration, the LambdaXtreme™

Transport System is considered unenclosed. During service,
maintenance, or restoration, observe the following precautions:

• Only authorized, trained personnel should be permitted to do
service, maintenance, and restoration. Avoid exposing the eye to
emissions from unterminated, energized optical connectors at
close distances. Laser modules associated with the optical ports
of laser circuit packs are typically recessed, which limits the
exposure distance. Optical port shutters and APR are engineering
controls that are also used to limit the emissions. However,
technicians removing or replacing regenerators should not stare
or look directly into the vacant regenerator slot with optical
instruments or magnifying lenses. (Normal eyewear or indirect
viewing instruments, such as Find-R-Scope’s infrared optical
viewers, are not considered magnifying lenses or optical
instruments.)

• Only authorized, trained personnel should use the lightwave test
equipment during installation or servicing, since this equipment
contains semiconductor lasers. [Some examples of lightguide test
equipment are Optical Time Domain Reflectometers (OTDRs),
Hand-Held Loss Test Sets, and Feature Finders.]

• Under no circumstances should any personnel scan a fiber with
an optical test set without verifying that all lightwave sources on
the fiber are turned off.

• All unauthorized personnel should be excluded from the
immediate area of lightwave transmission systems during
installation and service.

Consult ANSI Z136.1, American National Standard for Safe Use of
Lasers in the U.S., or outside the U.S., IEC-60825, Part 2, for
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guidance on the safe use of optical fiber optic communication systems
in the workplace.

Laser Safety and Lucent
Products

Lucent is committed to designing optical fiber transmission equipment
that minimizes operator and service personnel exposure to potentially
hazardous levels of optical energy during service and operation.
However, the continued safe use of optical transmission, optical cables
and passive optical connection equipment requires partnership with
customers to assure that these systems are deployed and maintained in
a safe manner. While automatic laser power reduction systems in
Lucent’s higher power transmission equipment respond quickly to
reduce laser emissions to safe levels in the event of fiber
disconnection or break, network operators must take proper action in
the event of an alarm.

In a typical network, our optical cables and passive optical connection
equipment can carry signals from various vendor sources that may
have different degrees of safety controls. We urge our customers to
properly assess the power of these sources to ensure that their safety
controls are adequate.

To strengthen our partnership and to assure the continued safe
deployment and use of optical networks, we urge you to use the
following standards as your guides for laser safety for your customers
and employees:

In the U.S.:

• ANSI Z136.1 – American National Standard for Safe Use of
Lasers.

• ANSI Z136.2 – American National Standard for Safe Use of
Optical Fiber Communication Systems Utilizing Laser Diode
and LED Sources.

Elsewhere:

• IEC 60825 Safety of Laser Products Part 1: Equipment
classification, requirements and user’s guide.

• IEC 60825 Safety of Laser Products Part 2: Safety of optical
fibre communication systems.

It should be noted that recent studies in Europe1 have suggested that
power as low as 50 mW can ignite certain hazardous (classified)
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gaseous/vapor/mist/dust environments under worst case, dusty
conditions. Standards are being written, both in the US and the
International Electrotechnical Commission (IEC), to address optical
installations in hazardous (classified) environments. If you must
deploy high power systems in such environments, you should assess
the impact.
1 Carleton, F.B., Bothe, H., Proust, Ch., Hawksworth, S., Prenormative
research on the use of optics in potentially explosive atmospheres –
PROPEX - EUR 19617 EN. European Commission, 2000 (Brussels,
Belgium), November 1999.

Warning and Compliance
Labels

Warning Label

A warning label is provided on the inside front cover of each shelf
assembly. The warning label shows the word “DANGER” in white
lettering on a safety red background, and the text of the warning label
in black lettering on a white background. See the figure below.

The label states:

DANGER

INVISIBLE LASER RADIATION WHEN OPEN

AND FIBER DISCONNECTED

Avoid direct exposure to beam.

Do not view beam with optical instruments.
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IEC Caution Label

An IEC “CAUTION” label is provided on the inside front cover of
each shelf assembly. See the figure below.

This label uses black lettering on a safety yellow background, and
states in both English and French:

CAUTION

INVISIBLE CLASS 1M LASER RADIATION

WHEN OPEN AND FIBER DISCONNECTED

Do not view directly with optical instruments.

IEC Hazard Level Label

An IEC “HAZARD LEVEL” label is provided on the faceplate of all
circuit packs with optical connectors which could permit access to
IEC 1M emissions. This includes all OA, RP, RPG, and OD Circuit
Packs. See the figure below.

For additional information on laser output power measurements, see
the LambdaXtreme™ Transport Applications and Planning Guide,
Release 1.1.

Rear Cover Warning Label

A warning label is provided on the rear cover of each equipment bay,
cabinet, and miscellaneously mounted shelf that states:
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NOTICE: UNTERMINATED OPTICAL CONNECTORS MAY
EMIT LASER RADIATION. AVOID DIRECT EXPOSURE TO
THE BEAM. DO NOT VIEW BEAM WITH OPTICAL
INSTRUMENTS.

System Compliance Label

A compliance label stating that the system has been certified, along
with the manufacturer’s name and place of manufacture, is attached to
the rear of each equipment bay, cabinet, and miscellaneously mounted
shelf. The following figure shows an example of a compliance label.
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The compliance label is located on the rear of the equipment cabinet
(at eye level) and miscellaneously mounted shelves.
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Laser Diode Compliance Label

A Laser Diode Compliance Label is attached to the non-component
side of each circuit pack containing a laser diode. This includes all
OA, OT, RP, RPG, and SUPVY circuit packs. See the figure below.

Electrostatic Discharge
(ESD)

Introduction

The following information must be considered whenever working on
the LambdaXtreme™ Transport System, or one of its components.

CAUTION
Industry experience has shown that all integrated circuit
packs can be damaged by static electricity that builds up on
work surfaces and personnel. The static charges are
produced by various charging effects of movement and
contact with other objects. Dry air allows greater static
charges to accumulate. Higher potentials are measured in
areas with low relative humidity, but potentials high enough
to cause damage can occur anywhere.
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Precautions

The following precautions must be observed when handling circuit
packs/units to prevent damage by electrostatic discharge:

• Assume all circuit packs contain solid-state electronic
components that can be damaged by electrostatic discharge
(ESD).

• When handling circuit packs/units (storing, installing, removing,
etc.) or when working on the backplane, always wear a grounded
wrist strap or wear a heel strap and stand on a grounded,
static-dissipating floor mat.

• Handle all circuit packs/units by the faceplate or latch and by the
top and bottom outermost edges. Never touch the components,
conductors, or connector pins.

• Observe all warning labels on bags and cartons. Whenever
possible, do not remove circuit packs/units from antistatic
packaging until ready to insert them into slots.

• If possible, open all circuit packs/units at a static-safe work
position, using properly grounded wrist straps and
static-dissipating table mats.

• Always store and transport circuit packs/units in static-safe
packaging. Shielding is not required unless specified.

• Keep all static-generating materials such as food wrappers,
plastics, and styrofoam containers away from all circuit
packs/units. When removing circuit packs/units from a cabinet,
immediately place the circuit packs/units in static-safe packages.

• Whenever possible, maintain relative humidity above 20 percent.

• Always keep the front covers on the shelves except during an
upgrade or maintenance procedure. Be sure to put blanks in slots
that are not used. Once a circuit pack/unit is replaced in the
shelf, immediately close the front cover.

Grounding Wrist Straps

Any connectors on the shelf interconnection panel that are not cabled
should be fitted with a plastic dust cap to provide ESD protection. To
reduce the possibility of ESD damage, shelves are equipped with
grounding jacks to enable personnel to ground themselves using wrist
straps while handling circuit packs/units or working on a shelf. See
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the figure below. The wrist straps should be checked periodically with
a wrist strap tester to ensure that they are working properly.

Important! The grounding jacks for connection of wrist straps are
located at the front of the bay on the right side, just below the hinge
for each shelf cover.

Safety Instructions

Save These Instructions

READ AND UNDERSTAND ALL INSTRUCTIONS

When using this telecommunication equipment, basic safety
precautions should always be followed to reduce the risk of fire,
electric shock, and injury to persons, including the following:

• Follow all warnings and instructions marked on the product.

• Slots and openings in this product at the front and top are
provided for ventilation. To protect it from overheating, these
openings must not be blocked or covered.

• Opening or removing rear covers or sheet-metal parts may
present exposure to high current or electrical energy levels, or to
other risks.
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• Never push objects of any kind into this product through slots as
they may touch dangerous voltage points or short out parts that
could result in a risk of fire or electrical shock. Never spill liquid
of any kind on the product.

• Refer servicing to qualified service personnel.

• Use caution when installing and modifying telecommunications
lines.

• Never install telecommunication wiring during a lightning storm.

• Never install telecommunication jacks in wet locations unless the
jack is specifically designed for wet locations.

• Never touch uninsulated telecommunication wires or terminals
unless the telecommunication line has been disconnected at the
network interface.

• Installation must include an independent frame ground conductor
to building ground. Grounding/bonding circuit continuity is vital
for safe operation of this equipment. Never operate with
grounding/bonding conductor disconnected.

• This product has four -48Vdc input power feeders per bay.
Disconnecting one power feeder will not de-energize the product.
To reduce the risk of injury, disconnect the four power supply
cables when removing power from the system.

• Metallic telecommunication interfaces should not leave the
building premises unless connected to telecommunication devices
providing primary and secondary protection, as applicable.

• For continued protection against risk of fire, replace only with
same type and rating of fuse.

• Use only Lucent Technologies manufactured, recognized circuit
packs/units/modules. Refer to the LambdaXtreme™ Transport
Applications and Planning Guide, Release 1.1.

• This equipment is intended for installation in Restricted Access
Locations where access is controlled or where access can only be
gained by service personnel with a key or tool. Access to this
equipment is restricted to qualified service personnel only.
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• Power the unit only from -48Vdc (-60Vdc for ETSI and similar
applications) sources providing Safety Extra Low Voltage (SELV)
outputs.

• This equipment must be provided with a readily accessible input
power disconnect device as part of the building installation (such
as a main power disconnect switch or external circuit breaker).

SAVE THESE INSTRUCTIONS.

How to comment To comment on this information product online, go to
http://www.lucent-info.com/comments or email your comments to
ctiphotline@lucent.com (mailto:ctiphotline@lucent.com).

How to order The LambdaXtreme™ Transport customer documents can be ordered
as individual paper copies or as a set on a CD-ROM (Comcode
#109163683). One-time orders include a binder (if applicable) and the
document contents for the current issue in effect at the time of the
order. Also, placement on the standing order list for all later reissues
of the document may be requested. The standing order list for each
document provides automatic distribution of all reissues of the
document.

Note: For commercial customers, a credit card is required for orders
totaling $1000 or less. Visa, Mastercard, and American Express are
accepted. Prepayment by check is also acceptable. Orders totaling
over $1000 may be paid for using credit card, check, or invoice upon
receipt of a purchase order. Orders placed by Lucent Associates are
billed using the cost center.

To order additional copies of this document and/or request placement
on the standing order list, send or call in the request as follows:

By mail:

Lucent Technologies

Attention: Order Entry

2855 N. Franklin Road

P.O. Box 19901

Indianapolis, IN 46219

Phone/Fax within USA:

Phone: 1-888-LUCENT8 (1-888-582-3688)
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Fax: 1-800-566-9568

Phone/E-mail outside USA for Canada, North American Region:

Phone: 1-317-322-6615

E-mail: intlnaorders@lucent.com

Phone/E-mail outside USA for Europe, the Middle East, and Africa
(EMEA); Asia, Pacific Region, and China; Caribbean, Latin
America (CALA):

Phone: 1-317-322-6416

E-mail: intlorders@lucent.com

Worldwide Fax: 1-317-322-6699

Internet for Commercial Customers:

http://www.lucentdocs.com

or

http://www.lucent8.com

Internet for Lucent Associates:

http://www.cic.lucent.com
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1 Introduction

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides a brief description of Lucent Technologies
LambdaXtreme™ Transport optical networking product.
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System Overview
....................................................................................................................................................................................................................................

Introduction LambdaXtreme™ Transport is Lucent Technologies next generation
Dense Wavelength Division Multiplexing (DWDM) optical networking
solution that uniquely offers one common platform for both ultra high
capacity (up to 2.56 Tbps) and ultra long reach (up to 4000 km
without electrical regeneration).

In combination with Lucent’s LambdaUnite™ MultiService Switch
(MSS) and LambdaRouter™ All Optical Switch (AOS) products,
LambdaXtreme™ Transport provides a comprehensive set of
wavelength-level control and management solutions that provides
customers with unprecedented flexibility in their network.

LambdaXtreme™ Transport uses a platform of common amplifiers,
common element and network management systems, common
controller packs, and common physical design for LambdaXtreme™

Transport Long Haul (LH), LambdaXtreme™ Transport Ultra Long
Haul (ULH), and LambdaXtreme™ Transport Ultra High Capacity
(UHC) applications. Using a single platform across multiple
applications means lower operational cost and faster time-to-market
for service providers.

LambdaXtreme™ Transport operates in a single band of the optical
spectrum. Since no bandsplitters/combiners are employed, the system
features a smaller footprint, enhanced system margins, simpler system
growth, and easier operations management, all of which lead to lower
overall system costs.

The LambdaXtreme™ Transport 10G (LH/ULH) system supports
transmission of up to 1.28 Tbps as 128 OC-192 (10 Gbps) extended L
Band channels with WaveWrapper Forward Error Correction (FEC).
OC-48 (2.5 Gbps) signals are handled by a 4:1 multiplexing
WaveWrapper Optical Translator (OT). This system can yield up to
4000 km reach.

The LambdaXtreme™ Transport 40G (UHC) system supports
transmission of 64 channels for a capacity of 2.56 Tbps. Payload (per
channel) is four OC-192 (10 Gbps) signals handled by a 4:1
multiplexing WaveWrapper OT. This can yield up to 1000 km reach.
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Application Architectures LambdaXtreme™ Transport is suited to the following service
environments:

• Point-to-Point systems

• Linear Add-Drop chains

• Mesh systems

Benefits that LambdaXtreme™ Transport brings to these service
environments include increased component density and reduced
footprint (compared to previous Lucent products and competitor
products).

For a complete detailed product overview including system
components and specifications, see the LambdaXtreme™ Transport
Applications and Planning Guide, Release 1.1.

System Overview Introduction

....................................................................................................................................................................................................................................

365-575-781R1.1
Issue 1, June 2002

Lucent Technologies - Proprietary
See notice on first page

1 - 3





2 Operations

Overview
....................................................................................................................................................................................................................................

Purpose This chapter explains the external physical interfaces, external NE
communication links, link protocols and link establishment
mechanisms that are utilized to support LambdaXtreme™ Transport
operations. It also provides an overview of Fault and Performance
Management. Finally, it describes the software support of operations
including the functionality that is provided and the data that is
processed.

Contents
Introduction 2-2

EMS-NE Interface 2-5

CIT-NE Interface 2-8

Orderwire 2-10

History Logs 2-11

Office Alarm Display 2-12

Fault Management 2-13

Miscellaneous Discretes Management 2-20

Performance Management 2-22

Software and Database Administration 2-24
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Introduction
....................................................................................................................................................................................................................................

Overview As illustrated below, the LambdaXtreme™ Transport NE external
communications are the EMS-NE TL1 interface and the CIT-NE TL1
interface. The Supervisory Data Link is used as a data communication
channel from a gateway NE to a remote NE.

The Element Management System (EMS) interface and the Craft
Interface Terminal (CIT) interface are both used for NE management.
The NE supports system/security administration functions over both
these interfaces via TL1 messages carried over TCP/IP connections.
Users perform their maintenance functions using an Element
Management System such as Lucent Technologies Navis™ Optical
Element Management System (EMS).

The System Input/Output Panel (SIO) circuit pack is the main user
interface to LambdaXtreme™ Transport. The SIO faceplate includes
various ports including one for an EMS connection and one for the
CIT (see Figure 2-2, “SIO Panel” (2-3)). For more information on the

Figure 2-1 LambdaXtreme™ Transport External Communication
Links
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SIO circuit pack see the LambdaXtreme™ Transport Applications and
Planning Guide, Release 1.1.

Maintenance Subnetwork A maintenance subnetwork consists of all of the NEs that can
communicate via the Data Communications Network (DCN).
Connectivity for all CIT/EMS messages between NEs is through the
DCN. The following applies:

• All LambdaXtreme™ Transport NEs within a maintenance
subnetwork are accessible from any EMS/CIT (EMS-NE/CIT-NE)
interface within the subnetwork. This enables all operations,
administration, maintenance, and provisioning (OAM&P)
functions to be performed on any NE within a maintenance
subnetwork from any NE within the same subnetwork.

• The EMS/CIT NE interface behaves as an End System (ES) in an
IP network. There is no routing performed at those ports.

Figure 2-2 SIO Panel
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Gateway Network Element

A Gateway Network Element (GNE) is defined to be an NE that
provides user access to all NEs within the maintenance subnetwork.
The GNE routes the messages between members of the maintenance
subnetwork. All NEs are capable of being GNEs. The following figure
illustrates LambdaXtreme™ Transport GNE connectivity/login
capabilities.

Remote Maintenance

LambdaXtreme™ Transport includes remote maintenance capabilities
which allow the CIT/EMS to access all NEs in a maintenance
subnetwork. NE communication is performed over the Supervisory
Data Link.

Figure 2-3 GNE Connectivity/Login Capabilities
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EMS-NE Interface
....................................................................................................................................................................................................................................

Overview The EMS-NE TL1 interface provides a link between the
LambdaXtreme™ Transport NE and an EMS such as Lucent
Technologies’ Navis™ Optical Element Management System (EMS).
The application data exchangeable over this interface is the set of
LambdaXtreme™ Transport TL1 messages which are transported over
a TCP/IP network. These messages include both input commands and
responses, and autonomous outputs (alarms and events).

Navis™ Optical Element Management System (EMS)

Navis™ Optical EMS, a separate Lucent Technologies product, can be
used as an end user management system. When used as such, Navis™

Optical EMS provides a Graphical User Interface (GUI) for users to
access and manage LambdaXtreme™ Transport with visibility down to
the circuit pack, port, and tributary levels. As an end user system,
Navis™ Optical EMS provides a complete suite of element
management functionality including fault, configuration, and security
management. For more information, see the Navis™ Optical Element
Management System (EMS) Applications and Planning Guide, Release
8.0 (190-224-160R8.0).

EMS Link Establishment The EMS interface connection on the SIO provides a link to the
connected NE (GNE). An EMS accesses a GNE and all remote NEs
by using the IP Address of the GNE EMS port. While it is true that
provisioning of a GNE is not required, the user must provision the IP
address of the EMS port of an NE that is going to be used as a GNE.
Specific step-by-step instructions for creating a Gateway Node are
covered in Appendix A, “Using the CIT”.

The following capabilities apply to TL1 application sessions over an
EMS-NE link (see Figure 2-3, “GNE Connectivity/Login Capabilities”
(2-4)):

• Can establish up to 16 EMS-NE data links to the GNE.

• Can establish and administer more than one functional data
channel between an EMS and any particular NE. Specifically an
EMS may login to a maximum of 128 remote NEs through a
GNE.

Operations
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• The functional data channels to any NE allow for command and
response, autonomous output, and maintenance (a combination of
the two).

• There can be more than one EMS-NE TL1 link to a given
LambdaXtreme™ Transport NE meaning there can be application
sessions between the NE and more than one EMS.

Session Administration For an EMS login session, it is possible to suppress/allow NE
autonomous outputs (notification messages are enabled by default).

The date format for all solicited and autonomous outputs depends on
the provisionable parameter that distinguishes between the SONET
and SDH environments and whether the year format for the login
session is provisioned as a two or four digit number.

Thus the date format for solicited and autonomous outputs is shown in
the following table:

Table 2-1 Date Formats for Autonomous and Solicited
Outputs

State of Provisionable
Parameter

Date Format

SONET YY-MM-DD (year-month-day) or
YYYY-MM-DD
(year-month-day)

SDH DD-MM-YY (day-month-year) or
DD-MM-YYYY
(day-month-year)

Trouble Reporting
Mechanisms

A LambdaXtreme™ Transport NE displays fault conditions (EMS Link
Failure) for an EMS interface that experiences equipment/signal
failures. The EMS Link Failure will only be alarmed if the EMS port
state has been provisioned to MON (monitor) using the ENT-SYS
command.

The RJ45 connector on the SIO circuit pack that terminates the EMS
interface has a green Link Integrity LED. When an attached link is
operating normally, the green LED is lit. If the attached link is not
operating normally the green LED is turned off. The green LED is
also not lit if there is no attached link. When an EMS-NE link
external fault has been detected , NE software declares an EMS Link
Failure alarmed condition (severity MJ).

EMS-NE Interface Operations
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An EMS Link Failure alarmed condition results in an autonomous
TL1 output message, and blinking of the red FAULT LED on the SIO
circuit pack.

For a complete description of LambdaXtreme™ Transport fault
conditions, see the LambdaXtreme™ Transport Alarms, Messages, and
Trouble Clearing Guide, Release 1.1.

EMS-NE Interface Operations
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CIT-NE Interface
....................................................................................................................................................................................................................................

Overview The LambdaXtreme™ Transport Craft Interface Terminal (CIT) is a
desktop or laptop computer that contains the LambdaXtreme™

Transport CIT software. The CIT (as well as the Navis™ Optical
EMS) provides a user-friendly GUI that allows customers to interact
with LambdaXtreme™ Transport NEs locally through a physical
connection, or to remotely located network elements that are
appropriately connected to the NE that has a physical connection to
the CIT. The CIT provides a fully functional GUI with pull-down
menus and context-sensitive, on-line help. The CIT gives craftspeople
a unified set of features for provisioning, testing, and reporting.

User input-output capabilities on the CIT-NE interface are identical to
those of the EMS-NE interface and all TL1 commands and
autonomous messages are applicable over both interfaces.

Note: The CIT-NE connection is intended for a direct connection from
a PC to the NE using a straight wired RJ-45 cable and not for a
network connection. For a CIT network type connection, the CIT
should be connected via a network that terminates to the EMS-NE
interface.

CIT Link Establishment The CIT-NE Link connects to a port on the SIO circuit pack via an
RJ-45 jack. This jack has a green Link Integrity LED that is lit when
the connected link is good (see Figure 2-2, “SIO Panel” (2-3)).

The CIT-NE interface is a 10/100 BaseT LAN interface running
TCP/IP. Its IP address is dynamically determined via a CIT-resident
non-standard DHCP server, meaning that no provisioning is required
to connect to the CIT interface.

Note: The PC NIC parameters must be properly provisioned as this is
independent of the CIT software.

The following capabilities apply to TL1 application sessions over a
CIT-NE link (see Figure 2-3, “GNE Connectivity/Login Capabilities”
(2-4)):

• Can establish up to 5 CIT-NE data links to the GNE.

• Can establish and administer more than one functional data
channel between a CIT and any particular NE. Specifically a CIT
may login to a maximum of 128 remote NEs through a GNE.

Operations
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• The functional data channels to any NE allow for command and
response, autonomous output, and maintenance (a combination of
the two).

• There can be more than one CIT-NE TL1 link to a given
LambdaXtreme™ Transport NE meaning there can be application
sessions between the CIT and more than one NE.

DHCP Server

When a CIT user directly connects the CIT PC (via the CIT port) to
the NE, the CIT-resident DHCP server and the NE will communicate
to configure the NE’s CIT port IP address to be a part of the CIT
PC’s subnet. The CIT user will not have to provide any CIT port IP
administration.

Session Administration A CIT user can establish a CIT-NE application session with the
“local” NE (the NE to which the CIT is physically connected) or with
a remote NE. Communication between the local/gateway NE and the
remote NE is over the LambdaXtreme™ Transport Inter-Node DCN. In
GUI mode, CIT users can maintain up to four CIT-NE application
sessions (logins) with several different NEs. In CIT cut-through mode,
a user can login to 128 simultaneous sessions.

Trouble Reporting
Mechanisms

The CIT-NE Interface Link Integrity LED located on the SIO circuit
pack is used to determine if there is a signal failure.

CIT-NE Interface Operations
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Orderwire
....................................................................................................................................................................................................................................

Description The Orderwire channel is used to establish voice communication
between LambdaXtreme™ Transport nodes. The Orderwire channels
are derived from the supervisory signal traversing between the
LambdaXtreme™ Transport nodes.

Each orderwire interface consists of clock, sync, and data signals in
the transmit direction (external orderwire equipment to Optical
Supervisory Channel (OSC)) and clock, sync, and data signals in the
receive direction (OSC to external orderwire equipment). The clock
and sync signals are outputs of the SUPVY for both transmit and
receive. The transmit data signal is an input of the SUPVY (see
“Supervisory Channel Provisioning” (4-14)).

LambdaXtreme™ Transport uses a packetized orderwire transmission
scheme that automatically adjusts the play-out data rate at the
receiving end of an orderwire connection to the transmission data rate
at the transmitting end. The benefits of this are:

• The customer does not need to provision the timing mode for
basic orderwire to work. (There may be customer applications
such as digital bridging between orderwire ports, that may
require clock synchronization of the NEs).

• Greater flexibility is possible in the orderwire connections.
Instead of only local or express orderwire options, it is possible
for any of the six orderwire interfaces in an NE to connect to
orderwire interfaces at any other NE.

Orderwire Implementation There are six DB15S connectors located on the SIO panel for
Orderwire interfaces. The drivers, receivers, and terminations are on
the SUPVY pack. The SUPVY supports three orderwire circuits from
each direction. Three orderwire channels are carried in the East OSC
and three in the West OSC. The three channels can be independently
provisioned by the user as either local (dropped to the orderwire
connectors on the SIO) or express. The default is local.

Operations
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History Logs
....................................................................................................................................................................................................................................

Overview To help users track their command activities and the events
autonomously output by the system, each LambdaXtreme™ Transport
NE keeps and maintains the following logs:

• Event History Log

• History Detail Event Log (Autonomous Output Log)

Event History Log LambdaXtreme™ Transport uses a single log to store and retrieve
events. This log provides a complete history of the 500 most recent
events that have occurred in the system. Events include the start and
end of alarm and status conditions, and all input activities that affect
or would affect the state on the NE, successfully completed or denied.
These events are listed in order of occurrence. This log is available
via the CIT, TL1 cut-through interface (RTRV-LOG command), or
EMS.

The following events are displayed:

• User transactions that affect or would affect the state of the
network element.

• Events identifying the start and end of alarm and status
conditions.

• Transient events.

Specific step-by-step instructions for viewing the Event History Log
are covered in Appendix A, “Using the CIT”.

History Detail Event Log
(Autonomous Output Log)

Each NE keeps a log of the 4000 most recent autonomous outputs.
Users are able to retrieve this log and to filter the messages that are
displayed. The log exists not only for user convenience, but because
events will show up here even if they do not show up elsewhere
(possible reasons being EMS-NE link or network failure or user
inhibiting of autonomous TL1 message reporting).

The History Detail Event Log is retrievable via the RTRV-AO TL1
command. It is not available through the CIT.

Operations
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Office Alarm Display
....................................................................................................................................................................................................................................

Description The Office Alarm Display has two control buttons/switches, three
alarm indicators, and three status indicators. One control button turns
off local audible office alarms and the other restarts the system
software. Alarm indicators display the highest severity level of the
current alarm conditions. Status indicators display the status of the
Alarm Cut-Off (ACO), the presence of abnormal conditions on the
NE, and the presence of any alarm or status conditions on the NE.

The reset switch (labeled RESTART) restarts system software using
the provisionable parameter values that were defined prior to the reset.
Pushing this button effects a power cycle of the Network Element
Controller (NCTL). The result is a “hard reset” of the NCTL and a
“soft reset” of the rest of the circuit packs (transmission is not
interrupted).

The following figure shows the Office Alarm Display and its location
in the System Bay.

Figure 2-4 Office Alarm Display
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Fault Management
....................................................................................................................................................................................................................................

Overview The main focus in Fault Management is to present the user with the
current alarms of a LambdaXtreme™ Transport NE in summaries and
different views, so that the user gets a quick overview of what is
going on with the NE. These views also support the user in analyzing
fault conditions and quickly finding a solution for the problem.

An alarm is a notification of a failure and also an external visible
indication of a failure by enabling the contact closure on the alarm
grid. An autonomous message is generated to report the alarm and the
Fault Light-emitting diode (LED) on the circuit pack or user panel
may be turned on or blinking depending on the severity and type of
alarm.

When multiple conditions with two or more different alarm attributes
are active, only the highest level alarm will be active (both audible
and visual). When the highest severity alarm has been cleared, the
next highest alarm, if any, will be activated (both audible and visual).

Note: For detailed procedures on clearing alarms, see the
LambdaXtreme™ Transport Alarms, Messages, and Trouble Clearing
Guide, Release 1.1.

Active Condition/Alarm
Log

The NE keeps a log of active (outstanding) conditions which are the
result of both alarmed and non-alarmed events. Users can retrieve an
Alarm List Report that displays all active alarms. This alarm log
summarizes the total number of alarms retrieved as well as the
informational messages.

Each alarm is represented as a line in a table. The following six
columns comprise the table:

• Level - This indicates the highest severity alarm present in the
system at the time the alarm was generated (not the severity of
the alarm itself). The possible values are Critical, Major, and
Minor for the SONET environment, and Prompt or Deferred for
the SDH environment.

• AID - This indicates the access identifier (AID) of the equipment
on which the alarm occurred.

• Occurred - This indicates the date and time at which the reported
alarm began.

Operations
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• Description - This contains the text description of the reported
condition.

• Service - This indicates the effect the reported alarm has on
service. Possible values are Service affecting (SA) or
Non-Service affecting (NSA).

Specific step-by-step instructions for viewing the Alarm List Report
are covered in Appendix A, “Using the CIT”.

Alarm Definitions The provisionable parameter called STD (standard) determines the set
of supported alarm severities. The value of this parameter can be set
to “SONET” or “SDH”.

The mapping and the set of supported alarm severities for the SONET
and SDH environments are shown in the following table:

SONET SDH

CRITICAL (CR) PROMPT

MAJOR (MJ)

MINOR (MN) DEFERRED

NOT ALARMED (NA) NO ALARM

NOT REPORTED (NR) NO REPORT

Alarm Severity Levels In order to tailor a customer’s operations plans to specific operations
environments, LambdaXtreme™ Transport allows customers to
provision (customize) alarm levels and the inhibiting of the
generation/reporting of specific alarms.

An Alarm Severity Assignment (ASA) associates a set of alarm
severities with one or more Alarm Identifiers. The basic outline of the
feature is as follows:

• The NE’s alarms are uniquely categorized into groups - with each
alarm residing in one and only one group.

• A default (original value) of alarm severity is given to each alarm
in each group. There is thus a default set of Alarm Group
severities.

Fault Management Operations
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• The user has the capability to change any individual alarm
severity.

• Changes of alarm severities do not affect outstanding (current)
alarms.

Alarm severity levels can be set via the CIT, TL1 cut-through
(ED-SEV command), or the EMS. Specific step-by-step instructions
for setting alarm severity levels via the CIT are covered in Appendix
A, “Using the CIT”. For provisioning procedures via the EMS, see the
Navis™ Optical Element Management System (EMS) Maintenance
Guide, Release 8.0 (190-224-157R8.0).

Alarm Groups

The LambdaXtreme™ Transport Alarm Groups are as follows:

• Slot – Slot, Circuit Pack and Equipment alarms

• PortOT – Signal alarms detected at OT ports

• PortOther – Signal alarms detected at SUPVY or OMON circuit
pack ports

• OCHAN – OCHAN AIDs

• PortOA_RP– Signal alarms detected at OA or Raman Pump
circuit pack ports

• PortOM_OD – Signal alarms detected at Optical Multiplexor or
Demultiplexor ports

• Line

• Shelf

• Fan – Fan Assembly alarms

• System

Alarm Displays and Status
Indicators

The Office Alarms interface is a set of discrete relays that control
audible and visual office alarms that includes the following:

• Equipment LEDs

• NE Level Alarm LEDs

• Power-On LED

• Abnormal Condition LED

• Activity-Near End/Info-N LED

Fault Management Operations
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Equipment LEDs

There are two LEDs on each circuit pack. The FAULT LED is red
and is illuminated steadily when there is a failure of the circuit pack
or when the circuit pack is booting. This red LED flashes (at a rate of
one second on and one second off) to indicate the failure of an input
to the circuit pack.

The ACTIVE LED is green and is illuminated steadily when the
circuit pack is booted and flashes when the circuit is booting. The
LEDs are off when the pack is not powered up.

NE Level Alarm LEDs

NE Level Alarms are displayed on the Fan Assembly User Panel (for
details of the Fan Assembly, see the LambdaXtreme™ Transport
Applications and Planning Guide, Release 1.1). Separate LEDs display
the severity level of the received alarm as follows:

• The alarm indicator for alarm conditions that are consistent with
the definitions for Critical (SONET environment) or Prompt
(SDH environment) is Critical/Prompt. The indicator is labeled
CR/Prompt and is a red LED.

• The alarm indicator for alarm conditions that are consistent with
the definitions for Major (SONET environment) or Deferred
(SDH environment) is Major/Deferred. The indicator is labeled
MJ/Deferred and is a red LED.

• The alarm indicator for alarm conditions that are consistent with
the definition for Minor (SONET environment) is Minor. The
indicator is labeled MN and is a yellow LED.

Both audible and visual alarms are activated during an alarm
condition. User provisioning and control of setting (changing)
severities of individual alarm events is possible with LambdaXtreme™

Transport making it adaptable to various operations environments.
Step-by-step instructions for alarm provisioning via the CIT are
covered in Appendix A, “Using the CIT”. For provisioning procedures
via the EMS, see the Navis™ Optical Element Management System
(EMS) Maintenance Guide, Release 8.0 (190-224-157R8.0).

Power-On LED

A green LED labeled PWR OUTPUT is associated with and located
on each power filter on each shelf within an NE. The LED is
illuminated when the filter is powered, and is extinguished when the

Fault Management Operations
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filter is not powered. The PWR OUTPUT LED is extinguished if the
low-voltage shutdown feature located on the power filter is activated.

Abnormal Condition LED

This LED labeled ABN/Abnormal is not utilized for the current
release.

Activity-Near End/Info-N LED

A yellow LED on the Fan Assembly User Panel is labeled NE-ACTY/
INFO-N and is illuminated whenever there is an alarm or status
condition active on the local NE. This includes any condition
identified regardless of the alarm level. An alarm condition is one
with a severity attribute of Critical (CR), Major (MJ), Minor (MN),
Prompt, or Deferred. A status condition is one with an alarm attribute
of NA, NR, NO, or No_Alarm. The NE-ACTY/ INFO-N LED is
illuminated for both types of conditions.

Alarm Cut-Off and Alarm
Cut-Off Clearing

Capabilities

The Alarm Cut-Off (ACO/Suppress) button located on the Office
Alarm Display turns off any local audible office alarms. Once the
ACO/Suppress button has been pressed, any subsequent alarmable
conditions will activate the audible alarm again.

The NE sends an autonomous message over both the CIT-NE and
EMS-NE interfaces whenever the ACO condition is raised (audible
alarms silenced) or cleared (audible alarms activated again).

LED Functional Testing LambdaXtreme™ Transport software supports the testing of circuit
pack LEDs (single or multiple) or user panel LEDs simultaneously.
The testing of circuit pack and user panel LED functionality does not
have any impact on LambdaXtreme™ Transport office alarms.

LED and Alarm Behavior
During Circuit Pack

Reboots and System
Restart

This subsection describes LED and Alarm behavior during circuit
pack reboots and system restarts.

Circuit Pack Reboots

During a circuit pack reboot the following applies:

• There is an alarm condition: “XXX booting in progress” where
“XXX” represents a particular circuit pack type. The values for
“XXX” are the full set of LambdaXtreme™ Transport circuit pack
types that have a FAULT LED and an ACTIVE LED with the
exception of the SIO and Fan Assembly.

Fault Management Operations
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Note: This applies only to an individual circuit pack reboot.
During a system reboot, there is no “XXX booting in progress”
for every circuit pack in the NE.

• The circuit pack LEDs are illuminated as follows: FAULT (red)
LED lit continuously; ACTIVE (green LED) flashing.

When the boot cycle is completed:

• There is an appropriate “Clear” of the “XXX booting in
progress” alarm.

• The ACTIVE (green) LED ceases flashing and remains lit.

• If the circuit pack is determined to be good, the FAULT (red)
LED is extinguished.

• If the Fault software determines that the circuit pack failed, the
FAULT (red) LED remains lit and an appropriate FAILED
condition for the circuit pack is declared.

• If the Fault software determines that the circuit pack is of an
unexpected type, the FAULT (red) LED remains lit and an
“Unexpected circuit pack type” alarm condition is declared.

• If the Fault software determines that a transmission circuit pack
is good but has an incoming signal fault, the FAULT (red) LED
begins to flash and the appropriate alarm condition is declared.

System Restart

During system restart the following applies:

• On the NCTL circuit pack, on each SCTL circuit pack and on
each of the remaining circuit packs (in sequence) the following
occurs:

- The FAULT (red) LED turns on following pack reset.

- The ACTIVE (green) LED begins to flash following pack
reset. It remains flashing until the network element
completes booting.

• The FAULT (red) LED on each circuit pack remains on while the
NE software is being loaded; it is extinguished when the system
software determines that the circuit pack is good.

• If the system software determines that the circuit pack failed, the
FAULT (red) LED remains lit and an appropriate FAILED
condition for the circuit pack is declared.

Fault Management Operations
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When the NE completes booting the following applies:

• The “Reset in Progress” condition clears.

• The ACTIVE (green) LEDs on all the circuit packs cease
flashing and remain lit.

• The ACTIVE (green) LEDs remain lit until the NE software
starts again, or until the double shelf loses power.

• Circuit pack fault conditions are handled on an individual circuit
pack basis.

Fault Management Operations
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Miscellaneous Discretes Management
....................................................................................................................................................................................................................................

Description Miscellaneous Discretes are provided as a mechanism for controlling
and monitoring NEs via remotely activated relay closures. The
electronics are located within the NCTL circuit pack. LambdaXtreme™

Transport NEs contain Miscellaneous Discrete Interfaces (MDIs) for
provisioning two types of miscellaneous discretes – Environmental
points (inputs) and control points (outputs). For LambdaXtreme™

Transport there are sixteen environmental points in each NE and four
control points.

Environmental points provide a way to monitor the environment
around the bay; there are 16 discrete points that can be provisioned to
send a message to the CIT, (e.g., alarms for smoke, intruders, flood,
or fire).

Control points provide a way to activate/deactivate various equipment
external to the NE through the use of NE control relays that are
commanded via NE messages.

Environmental and Control
Points Functionality

Environmental Points allow the user to define the alarm severity and
alarm message for the miscellaneous discrete alarms. Control Points
allow the user to define (describe) the condition name for the controls.
These descriptions are used for information purposes when a user
seeks to operate or release external miscellaneous discrete controls.
For example, the user may want to verify that aid=CONT-1 is
associated with a fan (and not a sprinkler) before operating it. The
following applies to internal and external environmental and control
points:

• LambdaXtreme™ Transport provides 16 internal miscellaneous
discrete environmental input points and 4 internal miscellaneous
discrete control output points.

• Each LambdaXtreme™ Transport NE is capable of sensing any
individual contact closure for the environmental input points and
generating an appropriate autonomous message over the EMS-NE
and CIT-NE interfaces.

• Each point can be uniquely labeled for EMS/CIT requests,
responses, and notifications.

Operations
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• The EMS/CIT is capable of activating/releasing any control
output point.

• Users can test any discrete interface output (control) point. It is
possible to test all the control points on an NE or just on a per
output basis.

Environmental Points Parameters

The Environmental Points provisioning window in the CIT contains
the following fields:

• AID – This identifies the miscellaneous discrete environmental
point.

• Alarm Message – This is the condition description to be
associated with the environmental point. The description may be
a string of up to 26 characters consisting of upper and lower case
alphanumeric, spaces and periods.

• Alarm Severity – This parameter defines the level of the alarm to
be associated with the environmental point if a failure occurs.

Control Points Parameters

The Control Points provisioning window in the CIT contains the
following fields:

• AID – This identifies the miscellaneous discrete control point.

• Control Point Name – This is a text string associated with the
selected miscellaneous discrete control. It is an alphanumeric
string, upper and lower case, spaces and periods allowed, up to
26 characters long. It is case sensitive. A Control Point Name
entry is required.

• Status – Displays the current status of the control point. Possible
values are Open or Closed.

• Action – This field allows you to operate the control point. If the
current status is Open, then possible values are Close, Pulse, and
None. If the current status is Closed, then possible values are
Open and None.

Miscellaneous Discretes Management Operations
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Performance Management
....................................................................................................................................................................................................................................

Description Performance Management (PM) refers to the in-service, non-intrusive
monitoring of transmission quality and equipment health.
LambdaXtreme™ Transport systematically tracks the signal quality and
equipment health through continuous collection and analysis of
performance data. The user can retrieve current and past values of the
system and through this, get an overview of the health of the system.
Performance Management capability exists for optical lines, channels
(both data traffic and supervisory) and for equipment monitoring.
Users have the ability to provision threshold parameters to levels that
might be indicative of impending performance degradation.

Responding to a performance degradation before there is a failure and
system alarms are raised, is termed proactive maintenance.
Responding to system alarms is termed reactive maintenance.
Crossing of a performance parameter threshold indicates a potential
network quality or performance degradation while the services being
transported have not been impacted. If a condition continues to
deteriorate, then alarms are raised and immediate attention may be
required to resolve or repair the problem.

Step-by-step instructions for performance management provisioning
via the CIT can be found in Appendix A, “Using the CIT”. For
provisioning procedures via the EMS, see the Navis™ Optical Element
Management System (EMS) Maintenance Guide, Release 8.0
(190-224-157R8.0).

Thresholds A threshold is the mechanism for generating a defined notification
resulting from changes in PM parameter values. LambdaXtreme™

Transport allows provisioning of performance parameter thresholds
which can be set by the user to show degraded performance.

PM Event Reporting By definition, a Threshold Crossing Alert (TCA) or Quality of Service
(QOS) event means that a threshold associated with a performance
parameter has been exceeded. The QOS notification message is
reported to the TL1 interface where threshold crossings associated
with a particular path can be correlated, and the likely source of the
degradation can be identified. The EMS receiving the QOS message
should interpret the QOS as an early warning regarding the health of
the signal.

Operations
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The TCA/QOS notification flag is used to turn on or off the
TCA/QOS autonomous message notification of any parameter. All
TCAs are retrievable either locally or remotely via the CIT/EMS and
can be provisioned to send autonomous messages.

Performance Management Operations
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Software and Database Administration
....................................................................................................................................................................................................................................

Overview This section describes the software management features of
LambdaXtreme™ Transport. Software management involves copying
and moving executable code and provisioned data between volatile
and non-volatile memory within the NE and between the NE and CIT
or EMS. These activities are done upon initial installation, when
power is restored to an NE, when circuit packs are inserted, and in
response to user commands from the EMS or CIT.

LambdaXtreme™ Transport supports the following user capabilities:

• Installing initial NE software generic

• Downloading software

• Copying NE software to remote NEs

• Database Backup and Restore

• Rebooting the System

Step-by-step instructions for software administration via the CIT are
covered in Appendix A, “Using the CIT”. For software administration
procedures via the EMS, see the Navis™ Optical Element Management
System (EMS) Provisioning Guide, Release 8.0 (190-224-156R8.0).

Installing Initial NE
Software Generic

The NCTL has a removable PCMCIA FlashDisk Memory Module
(FMM) for non-volatile memory storage of executable code and
provisioned data. The CIT PC contains a PCMCIA Type II card slot in
which to insert the FMM to copy the NE software from the PC hard
drive to the FMM. The FMM contains two directories (Active and
Inactive) for storing the active and inactive NE software. During an
initial installation startup, a copy of the software to be run on the NE
is stored in the active directory of the FMM.

The process for installing the initial software generic on an NE
includes the following steps:

• Insert the FMM into the PCMCIA FMM slot on the CIT PC.

• Install the NE software on the FMM (see Appendix A, “Using
the CIT”.)

• Remove the FMM from the CIT.

• Insert the FMM into the slot on the NCTL and the software will
automatically be used on the NE.

Operations
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Note: An NCTL or FMM should never be removed without first
pressing the FMM LED button and waiting for it to flash. If an NCTL
or FMM is removed without following this procedure, there is a risk
of FMM file corruption. When an FMM is removed and then
reinserted, DBBACKUPTIME is reset to the default date and time.

An FMM can be placed into a powered or unpowered NCTL. The
NCTL will not boot without an FMM (PCMCIA card) present. If the
NCTL circuit pack attempts to boot without an FMM, the boot
process is halted, the FAULT LED is turned on, and the MJ audible
and visual Office Alarms are activated. If a valid FMM is inserted at a
later time, the NCTL will automatically start booting with the new
FMM and will not have to be reset.

Important! Do not press the FMM LED button twice (a second time)
and then remove the FMM. Pressing the button a second time cancels
the request to remove the FMM. If removed at this point, the database
will become out of sync and damage to the FMM can occur.

Downloading Software LambdaXtreme™ Transport supports the capability to download NE
generic software from the CIT or EMS to the backup (inactive)
directory of the GNE NE’s FMM. Also supported are software
downloads to the GNE, remote copies from the GNE, and
backup/restores through the GNE. The download is done via the FTP
protocol.

Software and Database Administration Operations
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The following figure shows the respective software generic used for
download/copy operations.

Important! In order to perform a software download, the user must
first create the proper directory structure on the CIT-PC and launch an
FTP server task. The DWNLD-SW command can only be issued on
the physical port on which the participating FTP server IP address,
provided in this command, is reachable.

Copying NE Software to
Remote NEs

LambdaXtreme™ Transport supports the capability to copy NE
software from the NE to which the user is logged into, to the inactive
directory of the FMM of an NE anywhere within the maintenance
subnetwork. The software copy (from one network element to another)
occurs in the background. Once the software transfer is initiated, there
is no mechanism to cancel the operation. The command completion
and various events/conditions during the copy are reported on the TL1
interface.

Note: The software copy operation cannot be executed at a source NE
while a backup, restore, or download operation is occurring at the
same NE, as each of these operations locks the FMM.

Figure 2-5 Software Download/Copy from FMM
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New Software Activation The user can issue a command that swaps the active and inactive
software on the FMM and then reboots the system. This capability
allows users to reboot the NE and also provides the option of
swapping the NE software between the FMM active and inactive
directories and/or swapping the active and inactive versions of the
database.

Important! Before executing this command, be aware of the
following:

• Execution of this command may affect service.

• Execution of this command at any NE will affect EMS
communication with that NE; all EMS users logged into that NE
will be logged out.

• Rebooting the NE will wipe out the History Log.

Viewing Software Release Information

The user can view software release information about the various
copies and releases of the NE software as it resides in the NE. When
the user requests software release information, the user will see the
following for the NE:

• Software release version for the active and inactive directory of
the FMM

• The current status of the software release in the active and
inactive directory.

OLS Software Upgrade Customers should upgrade all network elements in an OLS as quickly
as possible when upgrading to a different software release. Having
different software releases running on different nodes at the same
time, may cause supervisory communications to fail which may
impact functionality including (but not limited to):

• APR recovery

• Transient response

• Remote commands

The upgrade should be done such that the new software is copied to
all the nodes. Then, the farthest away nodes should be reset before the
closer nodes. This is necessary because if the local node gets
upgraded first, it may no longer be able to communicate with the
farther away nodes.

Software and Database Administration Operations
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Note: The terms farthest and closest refer to network topology and not
actual distance from the local node.

The process for performing a software upgrade includes the following
steps:

• Download the software to the GNE. See “Downloading
Software” (2-25).

• Copy the software from the GNE to all other nodes. See
“Copying NE Software to Remote NEs” (2-26).

• Activate the new software – one node at a time starting from the
farthest End Terminal. See “New Software Activation” (2-27).

Important! After a software upgrade, the provisioned database in the
inactive directory (used for backup) is wiped out and replaced with
the new generic database. Therefore, in order to perform a rollback
using a previously provisioned database, the user must first execute
the RESTORE-DB command.

Database Backup and
Restore

Important! In order to perform database backup and restore, the user
must first create the proper directory structure on the CIT-PC and
launch an FTP server task. A BACKUP-DB or RESTORE-DB
command can only be issued on the physical port on which the
participating FTP server IP address, provided in the command, is
reachable. For example, a RESTORE-DB command cannot be issued
via the CIT-NE interface to perform a database restore to a server
reachable via the EMS-NE interface.

The Backup/Restore feature allows a user to either backup or restore
NE database files which contain provisioning data. LambdaXtreme™

Transport supports an FTP protocol for the purpose of NE database
Backup to and Restoral from a remote system.

The Backup command causes a transfer of an NE’s FMM mirror
database to the backup database and to a specified remote system
(e.g., EMS or CIT). The Restore command causes a transfer of a copy
of a LambdaXtreme™ Transport database from a remote system to a
specified NE with the intention of having the NE restart using the
values in the transferred database as the working database.

Note: If the NE is in the middle of an operation where a reboot would
cause the NE software or database to be corrupted, the reboot is
denied and an error message is returned.

Software and Database Administration Operations
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The following applies to the provisioned database:

• There is one copy in RAM that is the “working copy” with the
most up-to-date information.

• One copy is stored in the Active Directory of the FMM. The
mirror is kept in sync with the working copy and is used during
a reboot.

• One copy is stored in the Inactive Directory of the FMM to be
used when a backup is performed.

The following figure shows the respective database used for
backup/restore operations.

The database backup and restore features are not available from the
CIT PC GUI. This functionality is available only through the TL1
cut-through interface commands BACKUP-DB and RESTORE-DB.
The backup/restore commands are executed at the GNE. The target
NE for the backup/restore is specified as a command parameter. Only
one backup or restore may take place on a node at any given time.

Figure 2-6 Database Backup/Restore from FMM
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For details of the TL1 cut-through interface, see Chapter 7, “Craft
Interface Terminal” and “Execute Commands Interactively via TL1
Cut Through” (A-28). For backup/restore functionality via Navis
Optical EMS, see the Navis Optical Element Management System
(EMS) Administration Guide, Release 8.0 (190-224-158R8.0).

Database Backup

The following principles apply during an NE database Backup:

• Upon receipt of a Backup request from an EMS user that
includes a server address, user id, password, TID and a
pathname, the NE initiates an FTP session with the remote
system for the purposes of making a backup copy of the
database.

• The NE makes a snapshot copy of the memory database and
stores it in the backup FMM database.

• After successful initiation of the FTP session, the NE issues FTP
write request(s) to copy all of the backup FMM database file(s)
to the supplied remote system and pathname.

• In the case of a Backup from a remote NE, the database file(s) to
be backed up are remotely copied from the remote NE through
the GNE to the CIT/EMS.

• The NE notifies the command initiator, EMS or CIT, via an
autonomous message of the outcome (success or failure) of every
invocation of the Backup function. This notification is generated
at both the GNE and the destination NE.

Note: An NE Backup is uninterruptible (i.e., user-initiated actions will
be delayed until the backup is completed).

Database Restore

The following principles apply during an NE database Restore:

• Upon receipt of a Restore request from a user via the remote
system that includes a server address, user id, password, TID and
a pathname, the NE initiates an FTP session with the supplied
address for the purposes of restoring the database from a remote
system.

• After successful initiation of the FTP session, the NE issues a
read request to get a listing of all of the file(s) in the remote
system directory pointed to by the supplied pathname.

Software and Database Administration Operations
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• Using this directory listing, the NE copies all of the database
file(s) to the backup FMM copy of the database.

• In the case of a restore to a remote NE, the backup database
file(s) are remotely copied from the CIT/EMS through the GNE
to the remote NE.

• Database Restore is a two step process: RESTORE-DB is used to
get the database into the backup area; an INIT-SYS is used to
verify, swap, and reset.

• The NE notifies the remote system user of the outcome (success
or failure) of every invocation of the Restore function.

• An autonomous notification is issued before the system executes
any Reset function.

Software and Database Administration Operations
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3 Security Administration

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides information on security administration for
LambdaXtreme™ Transport. The LambdaXtreme™ Transport NE
security functions handle NE access and control capabilities that occur
over the CIT-NE and EMS-NE TL1 interfaces.

Step by step instructions for security administration provisioning via
the CIT are covered in Appendix A, “Using the CIT”. For
provisioning procedures via the EMS, see the Navis Optical Element
Management System (EMS) Administration Guide, Release 8.0
(190-224-158R8.0).
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Security Levels/Functions
....................................................................................................................................................................................................................................

Description The purpose of security administration is to manage user accounts
(logins, passwords, authorization levels, external links) and to monitor
system security so that only valid users can perform permitted actions
and receive authorized information from the system.

The CIT GUI provides the user the capability of security
administration for the NE(s). The NE does not provide an “unsecure”
user external port. That is, all user external LambdaXtreme™ Transport
ports require a login/password in order to gain access.

The NE provides security administration mechanisms that allow an
administrator to control the usage and management of user logins,
security features, and database of the NE, and to generate security
audit trails when necessary via the corresponding network
management interfaces. The following security administration
functions are offered:

• Administration of NE user logins that are used on both the
EMS-NE and CIT-NE interfaces.

• Administration of the NE command permissions (User Access
Privileges) for each NE user login.

• Administration of NE-wide security characteristics such as login
aging, password aging, user ID lockout thresholds, and inactivity
time-out periods (on a per port basis with the ports being the
EMS-NE and CIT-NE interfaces).

The following material explains the basis of the LambdaXtreme™

Transport command permissions structure including Functional
Categories, Authorization Levels, User Privilege Codes, and User
Access Privilege Assignments.

Functional Categories All LambdaXtreme™ Transport TL1 commands supported by NEs are
grouped into the following five functional categories (FCs):

• Security Administration (S)

• Provisioning (P)

• Performance Monitoring (PM)

• Maintenance (M)

• Test Access (T)

Security Administration
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Authorization Levels Authorization Levels (AL) are used to add a measure of fine
granularity to access control within each functional category by
tailoring a user’s access to commands within the functional category.

LambdaXtreme™ Transport supports six command authorization levels.
These are listed below in order of descending privilege

• Level 5 (Super User) – Full authorization access (controls user
security functions)

• Level 4 (Privileged User) – Authorized for service affecting
actions

• Level 3 (General User) – Authorized for potentially service
affecting actions

• Level 2 (Maintenance) – Basic authorization

• Level 1 (Reports Only) – No access to user login security
information (Default)

• Level 0 – No command access or authorization

User Privilege Code User Privilege Codes (UPC) determine the tasks a user is permitted to
perform. The UPC is the mechanism whereby a user’s NE TL1
command permissions profile is tailored. Each NE supports the use of
a UPC determining the set of commands that any given user is
authorized to execute.

The UPC is a composite of two attributes: the Functional Category
plus the Authorization Level as described above. The UPC is a
one/two-letter and one-digit number associated with functional job
categories. The letters represent the functional job category. The
one-digit number represents the user’s authorization level. The UPC is
assigned when a login is created or modified.

User Access Privilege The User Access Privilege (UAP) is a collection of UPCs that are
assigned to a user based on the user’s work/functional responsibility.
A UAP is specified for each newly created user ID. A user with
Security Administration privileges (UPC of S5) has the ability to
assign a UAP to each new user ID added to the NEs local database
according to the TL1 commands the new user is authorized to
execute. A minimum UAP level of S1 must be assigned to each user
login so that the user can log into the NE.
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A non-super-user has the following assigned authorization levels in
each of the following categories:

• S[1, 4, 5] – For System Administration, Authorization Level 1, 4,
5.

• T[0, 4] – For Test Access, Authorization Level 0, 4.

• PM[0, 1, 3] – For Performance Monitoring, Authorization Level
0, 1, 3.

• P[0, 1, 3] – For Provisioning, Authorization Level 0, 1, 3.

• M[0, 1, 3] – For Maintenance, Authorization Level 0, 1, 3.

An authorization level of “0”, indicates that the user has no privileges
in the functional category.

Super-users have an authorization level of “5” in all of the categories;
non-super-users will not be allowed to have an authorization level of
“5” in any of the areas.

If the user has some other authorization level other than those listed
here, because it was provisioned by some mechanism other than the
CIT GUI (e.g., an NE provisioned by an EMS and then linked to the
maintenance subnetwork) then the next most restrictive authorization
level is assigned (e.g., T3 becomes T0, and S3 becomes S1).

Because many CIT screens require at least retrieve privileges (i.e.,
authorization level of 1) in several functional categories, setting an
authorization level to “No Authorization” for a functional category
may restrict a user’s access to screens for which they would need to
have authorization. Thus, if the privilege level is set to “No
Authorization” in the Maintenance, Provisioning or Performance
Management categories, a warning message is displayed indicating
“No Authorization” when the user attempts to access the screen.

UAP Provisioning Example

A user ID that requires a high provisioning privilege can be
provisioned via the CIT as follows where each functional category is
assigned the following Authorization Level:

• Provisioning – Level 3

• Test Access – Level 4

• Performance Monitoring – Level 1

• System Administration – Level 1

• Maintenance – Level 0 (no authorization)

Security Levels/Functions Security Administration
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Logins
....................................................................................................................................................................................................................................

Introduction Login security controls access to the NE(s) by individual users. User
identity is specified using a user ID which is a unique identifier used
by an NE for security management. The user ID consists of a string of
case-sensitive alphabetic and/or numeric characters containing a
minimum of three characters and a maximum of ten characters from
the defined character set (see Tables 3-1, 3-2, and 3-3). The NE
authenticates the user ID against the NE’s local security database.
Based on this, the NE either accepts or denies login access to the NE.

At the heart of security administration is the ability to deny a user
access to the NE. Access may be denied during one of the following
points in time:

• When the user first attempts to login and the login attempt is
denied.

• During an active session and the user is disconnected by the NE.

Once the user logs into an NE with a valid user ID (and Password),
user functions can then be performed based on the assigned User
Access Privilege (UAP).

Table 3-1 shows the set of symbolic characters for use in User Login
ID and Password applications.

Table 3-1 Symbolic Character Set

! * / [ ] | ’ + < >

^ ( ) - { } ~ . _ ′

Table 3-2 shows the set of numeric characters for use in User Login
ID and Password applications.

Table 3-2 Numeric Character Set

0 1 2 3 4 5 6 7 8 9

Table 3-3 shows the set of alphabetic characters for use in User Login
ID and Password applications.

Table 3-3 Alphabetic Character Set

A B C D E F G H I J K L M

N O P Q R S T U V W X Y Z

Security Administration
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Table 3-3 Alphabetic Character Set (continued)

a b c d e f g h i j k l m

n o p q r s t u v w x y z

Super User Logins The LambdaXtreme™ Transport NE supports three Super User logins.
When shipped from the factory, the three original Super User IDs are:

• “LUC01” (lucent-zero-one)

• “LUC02” (lucent-zero-two)

• “LUC03” (lucent-zero-three)

The Super User login IDs cannot be removed and no additional Super
User logins can be created. The Super User logins have full privileges
(UAP of M5, P5, PM5, S5, T5) in all functional categories including
those affecting security, access to the NE, system initialization, NE
testing, software installation, and database and software management.
It is not possible to modify a Super User’s access or permissions
capabilities.

The three default Super User logins are supported over the CIT-NE,
EMS-NE, and DCN remote login interfaces. The NE allows any Super
User to be simultaneously logged in via the CIT-NE and EMS-NE
TL1 interfaces (i.e., multiple Super User login sessions are permitted).
The NE manages each login session independently and allows the user
to obtain information regarding who is currently active on which
channel for each of the NE’s interfaces.

Non-Super User Logins The LambdaXtreme™ Transport NE supports up to 100 Non-Super
User logins. A Non-Super User is able to have only one login session
to a given NE at any given instance (i.e., multiple Non-Super User
login sessions are not permitted). If a Non-Super User is logged into
the NE over the EMS-NE, CIT-NE, or DCN interface, and then
attempts to log in over any of the other interfaces, the login attempt
will be rejected. An error message will be shown stating that a
Non-Super User cannot be simultaneously logged into the NE over
more than one external interface.

Temporary (Visitor) Logins The NE allows a user with Security Administration privileges to
create temporary logins with expiration dates that can be provisioned.
These temporary logins are automatically deleted on the specified date
regardless of the frequency of use of the login.

Logins Security Administration
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A login can be changed from “regular” (Non-Super User) into
“temporary”. There is no way to change a temporary login to a
regular login, although a temporary login can be deleted and the same
login ID used to create a regular login.

User Login Aging The NE allows a user with appropriate security administration
privileges (UPC of S4 or higher) to globally set a login lifetime
(aging) parameter. As long as a Non-Super User logs in more
frequently than the login lifetime parameter, the user’s login is
retained. If a user does not login to the NE within the specified
period, the login is deleted and the condition recorded in the NE
history log. Login aging applies only to Non-Super User logins. Super
User logins never expire and cannot be deleted.

The login lifetime parameter can be globally set within the range of 7
to 999 days. The default is 60 days.

Non-Super User/Temporary
Login Expiration

User logins are checked for expiration every hour on the hour.
Therefore, a user login will be deleted within one hour of its expiry. If
the login has expired but has not yet been deleted and the user
attempts to login, the login will not be permitted. Once a user login
has expired, it is not possible to create a new login with the same user
ID until the old login has been deleted.

Logins Security Administration
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Passwords
....................................................................................................................................................................................................................................

Introduction All external LambdaXtreme™ Transport ports require a password in
addition to a user ID in order to gain access. Passwords are used
along with user IDs to verify the identity of users. A password
consists of a string of alphanumeric and symbolic characters
(minimum of six and maximum of ten). Each password contains at
least one alphabetic character, one numeric character, and one
symbolic character. Passwords are case-sensitive.

Passwords are stored or retained in encrypted form using strong
industry standard encryption although they are not encrypted when
transmitted from the CIT or EMS to the NEs. Passwords are never
transmitted from the NE to the CIT or EMS.

For security purposes, when a password is entered, the actual
password is not displayed on the GUI interface. Instead, an asterisk
(*) appears as the user enters each character of the password.

Super User Passwords The original Super User default passwords as shipped from the factory
are:

• “LUONG+01”

• “LUONG+02”

• “LUONG+03”

Each Super User has the capability to change their own password or
the password of any of the other Super Users. It is highly
recommended that passwords be changed after the first use.

Important! Do not forget your password. Make sure to backup your
database.

Password Administration The NE provides each user the ability to change their own password
on demand or based on password aging requirements. Passwords may
be changed via either the CIT or EMS interface. The NE keeps track
of the date when each user password was last changed. When a user
logs in, this date is compared with the current date. If the current date
is more than the provisioned number of days after the last changed
date, then the NE considers the password as expired.

A Non-Super User’s password is also considered expired the very first
time the user logs in successfully. This feature is intended to force
users to select a password different from the original password

Security Administration
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provided by the security administrator. This does not apply to Super
Users.

To change a password, the user must enter the current password, the
new password, and the confirmed new password. The
LambdaXtreme™ Transport NE checks the password for proper length
and syntax in accordance with established password requirements.
Before updating the NE’s database, the NE ensures that the current
password is different from the new password and that the new
password and confirmed new password are the same. An error
message is generated to notify the user if any of the password
requirements is not met.

Password Aging The NE maintains a provisionable Password Aging interval that is
applicable system-wide to all Non-Super User login IDs. This
parameter can be globally set by a user possessing the appropriate
system administration privilege (UPC of S4). With the Password
Aging feature, a user’s password expires if it is not changed within
the provisioned period of time. Once the password expires, the user
cannot login until the password is changed.

The range of allowed values for the Password Aging interval is 7 to
999 days. The default is 30 days.

When Password Aging is enabled, a user is not able to change their
password again until at least seven (7) calendar days have passed
since the last time the password was successfully changed. If fewer
than seven calendar days have passed, any attempt to change the
password will be denied. If the Password Aging feature is disabled,
passwords may be changed without any elapsed time restrictions.
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Login Sessions
....................................................................................................................................................................................................................................

Introduction The NE supports the simultaneous existence of 29 login sessions
which can be any combination of Super-User and Non-Super User
login IDs.

A login session (channel) can be in one of the following three
possible channel states:

• Login Active

• Login Inactive

• Password Expired

Login Active State A channel enters the Login Active state when a valid login command
without an expired password is received by the NE. Only one login
session is allowed per channel. A login request received on a channel
that is already in the Login Active state will be denied with
explanatory text. A user who attempts to login to a channel that they
are already logged into, will receive an appropriate message.

A channel exits the Login Active state (reverts to Login Inactive state)
when any one of the following occurs:

• A valid logoff command is received by the NE on that channel

• A condition occurs in the NE or local NE that requires a
cancellation of a login session

• The TCP/IP connection is lost

Login Inactive State All channels are, by default, in the Login Inactive state. A channel
transitions out of this state only when a valid login command is
received by the NE. When a channel is in the Login Inactive state, the
NE does not respond to any requests other than valid login requests.
In addition, no notification messages appear on a channel in the Login
Inactive state. A login session transitions to the Login Inactive state
when a user logs off and terminates a login session.

Password Expired State A login session enters the Password Expired state when the NE
receives a valid login command on a channel that is in the Login
Inactive state, but the password for the user ID has expired. The NE
rejects the login command and displays text explaining that the user’s
password has expired.

Security Administration
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In this state, the NE only accepts a valid login command (using a
different user ID), or a Modify Password command to change the
expired password for the user ID. Using either of these options, the
login proceeds normally with the channel entering the Login Active
state. Otherwise, the login session returns to the Login Inactive state.

Login Procedure A login attempt is considered successful if the following conditions
are met:

• A provisioned user ID and correct password is entered and

• The user login and NE login security is enabled (i.e., Non-Super
Users are permitted to log onto the NE) and

• The user ID lockout threshold has not been exceeded

If the login attempt is successful, it is recorded in the history log.

If any of the above conditions are not met, the security feature denies
access to a user attempting to log in, or may disconnect a user during
an active session.

When a login attempt fails due to user ID lockout threshold, the
following occurs:

• The login is denied until the lockout period has expired.

• Each unsuccessful login attempt is recorded in the NE history
log.

• The login ID entered on the last attempt and reasons why the
login failed are recorded in the history log.

• Error return text to the user reads Login Failed but reasons why
the login failed are not reported.

If the user login attempt is unsuccessful because the user ID has been
disabled, the following occurs:

• Each unsuccessful login attempt is recorded in the NE history
log.

• A logout:user-id-forced disconnect message is recorded in the
NE history log.

• Error return text to the user reads Login Disabled.

Login Sessions Security Administration

....................................................................................................................................................................................................................................

365-575-781R1.1
Issue 1, June 2002

Lucent Technologies - Proprietary
See notice on first page

3 - 1 1



Login Session Disconnect If a login session is active on a particular channel and the NE or
remote NE must disconnect the session for some reason, the following
occurs:

• Any commands that originated on the channel currently executing
on the NE are dropped.

• A logout:user-id message is recorded in the local NE’s history
log.

• Before disconnecting the session, the NE sends notification of the
impending disconnect to the appropriate EMS or CIT.

Login Session Denied A login session is denied for any one of the following reasons:

• The user fails to enter a valid ID and password.

• The login ID of the individual user has been administratively
disabled.

• Another user is already logged into the same NE using the same
EMS-NE or CIT-NE data link.

• A Non-Super User is already logged in over a different CIT-NE,
EMS-NE, or DCN data link.

• NE logins are disabled (Non-Super Users).

• Login attempts exceed the user ID lockout threshold.

• The user ID lockout period is not over.

When a login attempt on a channel is denied, the following occurs:

• A login:user-id-DENY message is recorded in the history log.

• A login denied message is sent on the channel associated with
the login attempt.

User ID Lockout The NE allows a user possessing the appropriate system
administration privilege (UPC of S4 or higher) to provision the
following user ID lockout parameters:

• User ID Lockout Threshold – the number of sequential invalid
login attempts permitted after which the user ID is locked out
and an Intruder Alert Alarm is raised and recorded in the NE
history log. The range of values is 2 to 99. The default value is
5.

• User ID Lockout Period – the number of minutes that a user is
locked out once the User ID Lockout Threshold is reached. The
range of values is 1 to 99.
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Important! The user will automatically be re-enabled once the
elapsed time since lockout exceeds the provisioned value of the User
ID Lockout Period. The user cannot be manually re-enabled by
anyone during this waiting period. Once re-enabled, the NE resets the
User ID Lockout Threshold and the User ID Lockout Period to the
default values.

Inhibiting Individual User
IDs

The NE allows a user with the appropriate privilege (UPC of S5) to
disable an existing Non-Super User ID. Disabling a user ID prevents
the user from establishing a session. If the user ID is actively logged
into a session, the login session is automatically terminated and any
attempt by the user to log back into the NE is denied.

Globally Inhibiting User
Login Activity

The NE allows a user with the appropriate privilege (UPC of S5) to
control login access on a per network element basis by temporarily
inhibiting all Non-Super Users from logging into the NE. This
capability might be used during routine maintenance or upgrade
activities. The three Super Users are not affected by this security
measure and are always allowed to log in.

When the command is issued to disable logins, all Non-Super Users
currently logged in are disconnected, and any attempt to log into the
NE is denied. A “Logins Inhibited” condition is raised by the NE and
recorded in the NE history log. The NE-ACTY user panel LED is
activated when logins are inhibited.

When logins are once again enabled, the “Logins Inhibited” condition
is cleared and recorded in the NE history log. The NE-ACTY user
panel LED is deactivated (turned off) when logins are enabled.

Inactivity Time-out For each NE, an inactivity time-out period can be globally
provisioned for all user sessions (logins) on a per-port and per-channel
basis (the GNE enforces the time-out). All the user sessions associated
with an NE’s particular point of attachment port and channel
combination have the same Inactivity Time-out period (whatever is
provisioned for the port). If a user does not interact with an NE
during the provisioned period of time over the given port and channel
combination, the user is automatically logged off from ALL login
sessions to NEs maintained over the given port and channel
combination and a Logout:user-id-timeout message is recorded in the
history log.
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The Inactivity Time-out Period range is 1 to 999 minutes. The default
is 30 minutes. If the Inactivity Timer is enabled, it applies to all user
sessions (logins) maintained on the given port and channel
combination. There is a separate timer maintained for each channel on
a given port.

The Inactivity Timer is active only when there is an active login
session on the channel and the NE is expecting the user to input data.
If the NE is busy processing a request, the inactivity timer is disabled.
It is activated when, at the completion of a user-generated command,
there is no pending message being processed by the NE.

Security Notification
Management

The NE sends appropriate notification whenever any of the following
attributes change for an existing login in the NE database:

• User ID

• User Access Privilege

• User ID Lockout Threshold

• User ID Lockout Period

• Temporary Login Aging

• User Login Aging

• Password Aging

• Inactivity Time-out Period

• Last User ID Disabled Time

The NE sends a notification whenever the following security events
occur:

• Login Creation

• Login Modification

• Login Deletion

• Login

• Logout

• Logout – Remote Link Down

• Intrusion Alert

• Logins Inhibited

• Logins Inhibited Cleared

Login Sessions Security Administration
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Security Data Storage All security data related to the NE or individual user logins is stored
in non-volatile memory (NVM). This ensures that data is retained in
the event of a system failure or shutdown. All security information,
except passwords, can be printed, viewed, and accessed as read only
by users possessing the appropriate system administration privilege.

Audit Trail Record The NE maintains a record in the NE history log of all login attempts,
user logouts, and provisioning commands. The following information
is logged for all commands, except retrieve (RTRV) and test (TST)
commands:

• User ID

• Time Stamp (start and end for each event occurrence)

• User login attempts (success and failure)

• Reason for denial (invalid user ID and/or password, association
or communication link failures)

Login Sessions Security Administration
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4 Equipment Provisioning

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides information for provisioning the
LambdaXtreme™ Transport equipment.
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Introduction
....................................................................................................................................................................................................................................

Description Provisioning is the process of assigning values to parameters which
determine the operating characteristics of the system. The values of
the provisioned parameters determine how you interface with an NE
and how the NE functions with various installed entities. Each
provisionable parameter has a factory supplied original value when
software is first loaded into an NE. These values become the current
value upon launching the software and are the values used by the
system. All provisioned parameters and values are preserved in the
system’s nonvolatile memory and are protected and retrievable on
demand in the event of a power failure. Copies of these parameter
settings can also be used by other identical NEs.

All externally user provisionable parameters can be set using either
the CIT, TL1 cut-through, or EMS (for remote provisioning). For
detailed equipment provisioning procedures via the CIT, see Appendix
A, “Using the CIT”. To provision via the TL1 cut-through, see
Chapter 7, “Craft Interface Terminal”. For provisioning procedures via
the EMS, see the Navis™ Optical Element Management System (EMS)
Provisioning Guide, Release 8.0 (190-224-156R8.0).

Equipment Provisioning
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Provisioning System Level Attributes for the NE
....................................................................................................................................................................................................................................

Overview The system administration capabilities of LambdaXtreme™ Transport
enable the user to retrieve and provision system level NE attributes.
Changing some system level attributes cause the NE to reboot, while
changing other system level attributes cause the SUPVY circuit to
reboot. Changing still other system level parameters do not cause any
reboot.

In the following sections, all the parameters which cause a reboot of
the system are set from within a single CIT screen. The CIT warns
the user to finish setting all system parameters that cause a reboot of
the NE before executing the change for any of these parameters.

The NE resets (reboots while powered) if a user changes the value of
one or more of the following parameters:

• NE Type

• NE Number

• Optical Interface Standard

• Channel Rate

• the KEEP_PUMPS_ON flag

Note: The user is able to change an NE’s TID and not cause an NE
reset.

NE Node Type (NETYPE) There are three LambdaXtreme™ Transport 2-fiber NE terminal
configurations (NETYPEs): End Terminal (ET), Repeater Shelf (RPT),
and Optical Add-Drop Multiplexor (OADM). The ET provides
add/drop access to 100% of the channels and two collocated ETs may
be arranged in a back-to-back fashion to provide ring-like terminal
transmission. The OADM allows add/drop access to 64 of the 128
available channels. The RPT has no add/drop capability.

The NE allows the user to provision one of the following NE node
types for the NE:

Table 4-1 NE Node Types

NE Node Types Node Type Identifier

2 Fiber End Terminal 2F_ET

2 Fiber Repeater 2F_RPT
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Table 4-1 NE Node Types (continued)

NE Node Types Node Type Identifier

2 Fiber OADM 2F_OADM

When a node is installed it will have an original (default) Node Type
value of 2F_RPT. If the node is in fact not of the default type, various
“Unexpected Circuit Pack” and “Circuit Pack Removed” alarm
conditions will occur when the node is first booted. The user must
then provision the correct NETYPE. The node will automatically
reboot when the NETYPE is changed and all existing connections are
deleted. Also, when the NETYPE is changed, any data provisioned by
the ENT-OTPS, SET-TH-OTPS, ENT-OCHTRC, or ENT-SECTRC
TL1 commands will be set back to the original values.

NE Number (NENUM) The user is required to provision an NE Number which is used to
generate a set of unique internal NE-specific IP addresses for each NE
in the control network. The range for this parameter is 1 to 800.
Changing this parameter causes the NE to reboot.

Note: It is strongly recommended that NENUM not be provisioned
with a value of 1 (which is the original value for NENUM) as this
may cause a duplicate NENUM condition to occur. When provisioning
an NE Number, if a new NE Number is entered and the NE knows
that the NE Number is not unique (already exists), the command fails.

Optical Interface Standard The Optical Interface Standard is the standard environment in which
the NE is provisioned to operate. The NE allows the user to provision
the NE’s synchronous signal format and reporting standard to be
either SONET or SDH. The original value is SONET. Changing this
parameter causes the NE to reboot.

The reporting standard specifies whether SONET or SDH alarm
severity notification codes, Performance Monitoring parameter data
formats, and date formats are used.

Provisioning System Level Attributes for the
NE
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Channel Rate The optical channel rate is an NE-wide parameter that specifies the
rate for all optical channels on all optical lines with which the NE
interfaces. The NE requires the user to provision the optical channel
rate for the NE. Allowed values for the optical channel rate are 10
Gbps and 40 Gbps. The NE automatically reboots if the optical
channel rate value is changed and all existing connections are deleted.
All port states are reset to Automatic (OOS-MA-AS).

The original value for optical channel rate is 10 Gbps. The NE
validates and only allows booting of OTs which transmit at the
provisioned optical channel rate.

Maintain Transmission
Upon Raman Pump Failure

This determines whether transmission should be maintained in the
event of a single Raman Pump failure. A provisionable field in the
CIT displays Yes or No according to the retrieved value for the
KEEP_PUMPS_ON parameter. The original value is Yes. Changing
this parameter will cause the NE to reboot.

NE Target Identifier (TID) The TID is the unique NE identifier that is used to address the NE. It
is the highest level “object” of the TL1 command. The user is
required to provision a unique TID for each NE in the
LambdaXtreme™ Transport control network. The user must ensure the
TID is unique across the maintenance subnetwork. For a new NE, the
default is TID=LT_XTREME. Changing the TID will terminate the NE
session.

The TID must adhere to the following specifications:

• The TID is a string of 20 or fewer characters from the set:
[A-Z][a-z][0-9].+-%#/

• The first character of the TID need not be alphabetic

• The NE is insensitive to the case of a TID (upper case and lower
case letters are treated the same)

When provisioning a TID, the following applies:

• If a new TID is entered and the NE knows that the TID already
exists, the command fails.

• If the NE doesn’t know that the TID already exists and then later
learns that there is a duplicate TID (because nodes get hooked
together), then the NE yields an alarmed output that describes the
attempt to provision a TID that is not unique to the control
network.

Provisioning System Level Attributes for the
NE
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EMS Port IP Address;
EMS Default Router IP
Address; Subnet Mask

The EMS-NE data link communications protocol stack is a TCP/IP
stack. The NE’s EMS-NE data link IP address is initially
provisionable via the CIT and subsequently through EMS.

Every NE can be a Gateway Network Element (GNE). The only NEs
that should be provisioned with EMS IP parameters are those that may
serve as EMS Gateway NEs. Potential Gateway NEs are defined by
the overlay management network topology.

An EMS accesses a GNE and all remote NEs by using the IP Address
of the GNE EMS Port. While it is true that provisioning of a GNE is
not required, the user must provision the IP address of the EMS port
of an NE that is going to be used as a GNE.

Provisioning these parameters will not cause a reboot, but will bring
the EMS-NE link down. If the user is connected to the NE via the
EMS port of the NE, and the user attempts to modify these
parameters, the CIT displays the following message to the user:
Modifying these parameters will result in losing the

EMS-NE link. Therefore this login session will terminate

and you will be required to login again.

If the user is connected to this NE via the CIT port or supervisory
channel of the NE, and the user attempts to modify the EMS Port IP
Address, the CIT displays the following message to the user:
Modifying these parameters will result in losing the

EMS-NE link. Any communications via EMS link of this NE

will be lost.

After the appropriate message is displayed, the user can confirm the
change of the parameter values or cancel.

Date/Time LambdaXtreme™ Transport maintains a Date and Time of Day clock.
The clock is used to time stamp events such as reporting and clearing
of alarm conditions and interactions with the operations system. The
NE Date and Time can be set via the CIT, TL1 cut-through, or EMS
interfaces.

Optical Amplifier
(OA)-Pack in Repeater

Nodes

This feature allows the user to provision the presence or non-presence
of an OA (DGEF) circuit pack on the optical line. There is one
parameter for optical line 1W and a separate one for optical line 1E.
This feature is only present in the CIT for Repeater nodes. The
allowable values are Yes or No.

Provisioning System Level Attributes for the
NE
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“Yes” indicates that an OA (DGEF) circuit pack is installed on the
optical line. “No” indicates that the OA installed on the optical line is
either an OA (Raman) circuit pack, or an OA (Raman, EDFA) circuit
pack.

Changing either of these values causes the Repeater’s SCTL circuit
pack to reboot, (i.e., the shelf will reboot).

Provisioning System Level Attributes for the
NE
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Port Provisioning
....................................................................................................................................................................................................................................

Overview This subsection describes the requirements for setting Optical
Translator (OT) port states as they relate to channel connections. OT
ports can be provisioned via the CIT, the TL1 cut-through
(ENT-OTPS command), or via EMS. For detailed port provisioning
procedures via the CIT see Appendix A, “Using the CIT”. For
provisioning via the TL1 cut-through, see Chapter 7, “Craft Interface
Terminal”. For provisioning procedures via the EMS, see the Navis™

Optical Element Management System (EMS) Provisioning Guide,
Release 8.0 (190-224-156R8.0).

Methods of Provisioning There are two distinguishable methods of port provisioning –
autoprovisioning and manual provisioning. Whenever possible, the
LambdaXtreme™ Transport NE will discover and provision optical
channel connections without the user having to enter any provisioning
commands. When the NE discovers a newly added optical channel
frequency with no command input from the user, this is referred to as
autodiscovery of an optical channel. When the NE automatically
provisions the autodiscovered optical channel (without command input
from user), this is referred to as autoprovisioning. The autodiscovery
and autoprovisioning features are implemented together to enable the
automatic discovery and provisioning of optical connections by the
NE.

Autoprovisioning

To enable autodiscovery and autoprovisioning for new optical
connections in the LambdaXtreme™ Transport NE, the user installs the
appropriate circuit packs and physically connects ports between the
packs (such as an OT port to an OM port). Then, given a valid signal
to the client side of an add/drop OT, the NE software automatically
discovers and provisions the corresponding optical connections made
by the user. The NE software will provision the discovered
connections in its database.

Autoprovisioning is enabled only when the client side port is in the
Automatic state (see Figure 4-1, “OT Port State Diagram” (4-9)).

Manual Provisioning

Autodiscovery and autoprovisioning do not apply to all optical
channel connections. For these exceptions the user provisions the NE

Equipment Provisioning
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optical channel connections using the CIT, TL1 commands, or the
EMS. Manual provisioning is the process by which system parameters
are set (provisioned) using a series of user-entered commands via the
CIT, TL1 cut-through, or EMS.

Compatible optics channels must be manually provisioned by the user.
For these connections, the client side signal connects directly to OM
and OD ports bypassing OT circuit packs. These connections must be
provisioned by the user as external connection types.

All TL1 port provisioning commands, parameters, original values, and
allowed values can be viewed via the CIT TL1 cut-through (see
Chapter 7, “Craft Interface Terminal”.

Provisioning Port State This section describes the requirements for setting Optical Translator
(OT) port states as they relate to channel connections. The following
figure shows the port states that are supported and the transitions
between these states.

Figure 4-1 OT Port State Diagram
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For any OT type (except Through OTs), the user can provision the
following OT Port parameters:

• Port Mode – This field displays the current port mode setting and
allows the user to specify the port mode of the OT Client In Port.
The LambdaXtreme™ Transport NE supports the following states
for the OT client side input port:

- Automatic (OOS-MA-AS) - At installation time, the default
state (original value) that the OT port assumes is Automatic
and the OT laser is off.

- Monitored (IS) - This is the state that the OT port assumes
for monitoring. The user is not able to set the OT port state
to In Service.

- Not Monitored (OOS) - This is the state that can be set in
case the fault monitoring on this port needs to stop.

Port Provisioning Equipment Provisioning
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Once the parameter value has been chosen, the user then has the
option of applying the settings to just the Client In Port being
provisioned, all Client In Ports on this Pack, all Client In Ports
on this Shelf, all Client In Ports on this Bay, or all Client In
Ports on this Bay and Selected Bays. The TL1 command to
provision this parameter is ENT-OTPS. To provision the port
mode via the CIT, see “Provision Mode for OT Client Side Input
Port” (A-44).

• Error Response – These fields allow the user to provision various
OT Line In Error Response parameters related to OT ports.

- Optical Channel Signal Defect Response - This field
determines how an OT which is sending its output to
external equipment will respond when there is a defect in
the received WaveWrapper signal. Two possible responses
can be provisioned - “Shut Off Client Side OT Laser” or
“Insert Unframed AIS to Client Signal”.

- Optical Channel Path Trace Mismatch Response - This field
indicates whether the OT will take action when Optical
Channel Path Trace Mismatch is detected. The allowed
values are: “Apply Optical Channel Signal Defect Response”
or “Pass Signal to Client Side”.

- Optical Channel Payload Type Mismatch Response - This
field indicates whether the OT will take action when Optical
Channel Payload Type Mismatch is detected. The allowed
values are: “Apply Optical Channel Signal Defect Response”
or “Pass Signal to Client Side”.

Once the parameter values have been chosen, the user then has
the option of applying the settings to just the Line In Port being
provisioned, all Line In Ports on this Pack, all Line In Ports on
this Shelf, all Line In Ports on this Bay, or all Line In Ports on
the NE. The TL1 command to provision these parameters is
ENT-OTPS.
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Optical Line Provisioning
....................................................................................................................................................................................................................................

Overview Optical Line Provisioning allows the user to provision all parameters
associated with an optical line. The user is required to provision the
outside plant fiber type for each line AID with which an NE
interfaces. This information is used to optimize performance. Optical
lines can be provisioned via the CIT, the TL1 cut-through (ENT-OLPP
command), or via EMS.

Provisioning Optical Lines Line AIDs are selected as follows:

• On Repeater and OADM nodes the allowable choices for line
AID are 1E and 1W.

• On End Terminals the only allowable choice for line AID is 1E.

The user selects an optical line AID and then provisions the following
Optical Line parameters:

• Optical Line Fiber Type – This parameter denotes the optical
fiber type in this span (both directions of transmission). Possible
values are:

- Standard Single-Mode

- Lucent TrueWave-Classic

- Lucent TrueWave-Plus

- Lucent TrueWave Reduced Slope

- Corning LEAF

• Tx Outside Plant Span Loss – In this field the user can set the
value for SPAN_LOSS. The allowable values are floating point
values in tenths of dBs between 0.0 and 75.0 dB.
Note: This is the “S-NE to R-NE” loss and therefore includes all
office patch panels, office connections, and the office to outside
plant splice losses as well as the actual outside plant loss.

• Tx Outside Plant Connector – In this field the user can set the
value for the type of connector that terminates the outside plant
(OSP) transmit fiber at the NE. The allowed values are “ST”
(Straight Tip) or “Not ST”.

Equipment Provisioning
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• Line Compensation DCM Type – In this field the user can select
the type of Dispersion Compensation Module (DCM) associated
with the transmit amplifier. Allowed values are:

- Standard Single-Mode

- Lucent TrueWave-Classic

- Lucent TrueWave Reduced Slope

- Corning LEAF
Note: Each possible value consists of fiber type and span length
for which DCM is being applied.

• Soliton OT Pulse Width Vector – In this field the user can select
one of eight Soliton OT pulse width profiles pre-set in the NE.
Each profile specifies the Soliton OT pulse widths for every
channel in this optical line.

• Comment – This field displays a comment field of up to 128
characters. The user has the option to populate this field with a
description of line characteristics.

Optical Line Provisioning Equipment Provisioning
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Supervisory Channel Provisioning
....................................................................................................................................................................................................................................

Overview The Supervisory Circuit Pack (SUPVY) is a low-speed transmission
pack that facilitates communication between LambdaXtreme™

Transport NEs. The SUPVY is the termination point of the
supervisory channels. In node-to-node communication, the controller
core in the SUPVY pack communicates with the SUPVY controller
core in other NEs via the Optical Supervisory Channel (OSC). All
such internode communication flows through the SUPVY controller
core before transmission on the OSC. SUPVY packs allow the user to
provide remote system operations such as performance maintenance
and provisioning via the CIT and EMS.

The Supervisory Channel can be provisioned via the CIT, the TL1
cut-through (ENT-SUPR command), or via EMS.

Orderwire In Orderwire communication, connections are established across NEs
using external Orderwire equipment. The Orderwire channels which
are used to establish voice communication between LambdaXtreme™

Transport nodes, are derived from the supervisory signal traversing
between the LambdaXtreme™ Transport nodes. The user is able to
provision up to 3 Orderwire links at each SUPVY interface of the
LambdaXtreme™ Transport node.

The orderwire interface has the following characteristics:

• Each Orderwire interface consists of clock, sync, and data signals
in the transmit direction and in the receive direction. The clock
and sync signals are outputs of the SUPVY for both transmit and
receive. The transmit data signal is an input and the receive data
signal is an output of the SUPVY.

• Orderwire signals are RS-485. The drivers, receivers, and
terminations are on the SUPVY pack.

• One DB15S connector is used per orderwire interface. The
connectors are on the SIO panel.

• The transmit clock is derived from the local SUPVY common
clock. The receive clock automatically tracks the local SUPVY
common clock of the transmitting NE.

For additional details of the SUPVY pack and Orderwire interface, see
the LambdaXtreme™ Transport Applications and Planning Guide,
Release 1.1.
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Provisioning Orderwire
Channels

Each Orderwire channel is provisioned by the user to be local
(terminating on the node) or express (non-terminating on the node). It
is also important that the timing source at each node be provisioned
such that synchronous operation is attained, otherwise slips will occur.
While slips have no apparent adverse effect on the node-to-node
transmission, slips do cause clipping of speech or data errors on the
Orderwire channels.

Provisioning Port
Monitoring

Note: This feature is not supported in the current release but will be
available in the future.

These fields allow the user to provision the monitoring status of
various ports. The user selects one of the values presented
(“Monitored” or “Not Monitored”). For the SIO pack ports,
“Monitored” indicates monitoring for LAN failure (Link integrity
failure). The TL1 command to provision this is ENT-SUPR. The
monitoring status of the following ports can be provisioned:

• Data Port 1 – In this field the user can set the state of
PORT-DATA_1. This port is located on the SIO pack.

• Data Port 2 – In this field the user can set the state of
PORT-DATA_2. This port is located on the SIO pack.

• Customer LAN Port – In this field the user can set the state of
PORT-CUSTLAN. This port is located on the SIO pack.

• Private LAN Port 1 – In this field the user can set the state of
PORT-PVTLAN_1. This port is located on the SIO pack.

• Private LAN Port 2 – In this field the user can set the state of
PORT-PVTLAN_2. This port is located on the SIO pack.

Supervisory Channel Provisioning Equipment Provisioning
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Miscellaneous Discretes Provisioning
....................................................................................................................................................................................................................................

Overview This feature allows the user to provision miscellaneous discrete alarms
(inputs) and controls (outputs). The user defines the alarm severity
and alarm message for the miscellaneous discrete alarms and also
defines the condition name for the controls. The user can specify the
desired control action to produce a continuous output to an external
device or just produce output momentarily to test the control points.

Miscellaneous Discretes can be provisioned via the CIT, the TL1
cut-through (SET-ATTR command), or via EMS.

Provisioning
Environmental and Control

Points

The alarm severity level for each of the miscellaneous discrete
environmental points is provisionable via the CIT/EMS. The following
capabilities are available:

• The state of the environmental points is available as
message-based EMS messages and are reported on demand at the
CIT and EMS interfaces.

• Users can operate and release the control points via either the
CIT or EMS interface.

• If the network element experiences a RESET, the states of the
environmental and control points remain unaffected.

• All discretes are provisioned with their values upon initialization.
Alarms are given an original value of MN.

To define the miscellaneous discrete alarms and controls, the CIT user
defines the alarm severity and alarm message for the miscellaneous
discrete alarms and defines the condition name for the controls. For
control points, the user can opt to produce a continuous output to an
external device or just produce output momentarily to test the control
points.

The following fields are displayed to the user on the CIT
Miscellaneous Discrete Alarms Provisioning screen.

• Environmental Alarm AID
This field displays the selected Environmental Alarm AID. This
is ENV-(1-16) for the internal Environmental Alarms and
ENV-(17-144) for the external Environmental Alarms. The CIT
displays the value that is currently stored in the NE for this field.

• Environmental Alarm Message
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In this field, the user enters the alarm message (up to 26
characters) for this AID.

• Environmental Alarm Severity
In this field, the user enters the alarm severity for this AID. The
user can modify this field with values that are based on the
operations standard (SONET or SDH) provisioned on the NE. If
the NE is provisioned for the SONET standard, then the allowed
values for this field are: Critical (CR), Major (MJ), Minor (MN),
Not Alarmed (NA), Not Reported (NR), NO (Ignored). If the NE
is provisioned for the SDH standard then the allowed values are:
Prompt, Deferred, No Alarm, No Report, Not Indicated.

• Control Point AID
This field displays the selected Control Point AID. This is CONT
(1-4) for internal Miscellaneous Discrete Controls and CONT
(5-36) for external Miscellaneous Discrete Controls.

• Control Point Name
In this field, the user enters the name of the Control Point (up to
26 characters) for this AID.

• Control Point Status
This field displays the current status of the control point (“Open”
or “Closed”).

• Control Point Action
This is selectable by the user to produce a continuous output to
an external device or just produce output momentarily to test the
control points. The possible values are: None, Pulse, Closed, or
Open (depending upon the current Control Point Status).
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5 Establishing Optical Channel
Connections

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes the autoprovisioning/autodiscovery features for
establishing LambdaXtreme™ Transport optical channel connections.
Step-by-step instructions for provisioning of compatible optics
connections via the CIT are covered in Appendix A, “Using the CIT”.
Provisioning of optical channel connections can also be done via the
TL1 ENT-CONN command (see Chapter 7, “Craft Interface
Terminal”. For EMS provisioning procedures, see the Navis™ Optical
Element Management System (EMS) Provisioning Guide, Release 8.0
(190-224-156R8.0).
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Introduction
....................................................................................................................................................................................................................................

Overview For LambdaXtreme™ Transport an optical channel connection is
defined as two connectivity paths within a LambdaXtreme™ Transport
NE traveling in opposite directions. These two paths are the input and
output of the same customer signal and have the same grid frequency.
The connection begins from the customer source point, through the
NE, to the appropriate ports at the exit point of the NE. An optical
channel connection may consist of multiple point to point connections
within an NE which are used to add, drop, or pass through an optical
channel.

The approach taken with LambdaXtreme™ Transport is to eliminate
having to provision channel connections. Whenever possible, the
LambdaXtreme™ Transport NE discovers and provisions optical
channel connections without the user having to enter any provisioning
commands. When a valid client signal is applied to an OT, the NE
senses the presence of the valid signal and turns on the OT line side
signal, thus allowing transmission over this channel. Successful
discovery of the new connection leads to creation of the connection
record in the database that triggers Fault and Performance Monitoring
of the newly created channel. For LambdaXtreme™ Transport,
autodiscovery of optical channel connections is supported for End
Terminals and OADM nodes where OTs are used. It is not applicable
for Repeater nodes.

Compatible optics connections (also known as external connections)
do not require the use of OTs and are the only type of connections
that cannot be autodiscovered and autoprovisioned by the NE. The
user provisions connections for compatible optics using the CIT, TL1
commands, or the EMS.

Autodiscovery and
Autoprovisioning of

Optical Channel
Connections

To autoprovision an optical connection, the user first installs the
appropriate OT pack and makes all the necessary fiber connections to
the OM/OD. The final step is to connect externally to the operating
customer equipment and apply a valid signal to this OT for the first
time. When all the necessary connectivity information is discovered
by the NE, the software provisions the connection in the database.

Note: For a valid channel connection, the user has to drop the
customer signal on the same OT as the add side of the same signal or
else the software cannot automatically discover the connection

Establishing Optical Channel Connections
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correctly. Also, the connection will not be autoprovisioned if any of
the involved circuit packs are in alarm (e.g., OT boot in progress or
OT warming).

After a new connection has been provisioned in the NE database via
autoprovisioning, the NE sends an autonomous message to the user
that a connection has been successfully provisioned and the following
connection information is recorded in the database:

• All necessary point to point connections within the NE that make
up the 2-way connection within the NE. This includes the
applicable point to point connections within the NE (add, drop,
or pass-through connections) with the corresponding OT, OM and
OD AID’s.

• Grid frequency of the channel.

• Line AID (1E, 1W).

• Connection Type.

• Tributary Identifier (if applicable)

LambdaXtreme™ Transport will reject the provisioning of optical
channel connections which attempt to place a new connection on a
line having a grid frequency with the same value as one provisioned
previously on that line.

Note: Autodiscovery/autoprovisioning of a connection may take a few
minutes (typically less than 2 minutes) to provision a single optical
connection. The LambdaXtreme™ Transport will provision connection
autodiscovery requests one at a time. Users may connect many OTs
and initiate multiple autodiscovery requests at the same time, but they
will be provisioned sequentially.

Optical Channel
Connection Types

LambdaXtreme™ Transport supports the following types of optical
channel connections. These connections are two-way and include an
add and corresponding drop within an NE.

• 10G connection

• 2.5G Trib connection

• 10G Trib connection

• 40G Through connection for back-to-back End Terminals

• External connection for compatible optics

Introduction Establishing Optical Channel Connections
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10G Connections
....................................................................................................................................................................................................................................

10G Optical Connections 10G optical channel connections are supported on the 10G End
Terminals and OADM Terminals. These connections include the
following types of OTs:

• 10G:WW10G Add/Drop, I-64.1, LH, 30mm wide, 1310 nm client
signal

• 10G:WW10G Add/Drop, S-64.2b, LH, 30mm wide, 1550 nm
client signal

• 10G:WW10G Add/Drop, I-64.1, ULH, 60mm wide, 1310 nm
client signal

• 10G:WW10G Add/Drop, S-64.2b, ULH, 60mm wide, 1550 nm
client signal.

OTs can be interchanged by users for existing connections as follows:

• A 10G:WW10G Add/Drop OT with I-64.1, 1310 nm client signal
can be interchanged with another OT with the same frequency of
type 10G:WW10G Add/Drop OT with S-64.2b, 1550 nm client
signal.

• A 10G:WW10G Add/Drop ULH OT with I-64.1, 1310 nm client
signal can be interchanged with another OT with the same
frequency of type 10G:WW10G Add/Drop ULH OT with
S-64.2b, 1550 nm client signal.

The user can replace an OT pack with a 10G OT pack with different
client side characteristics without having to delete the connection and
recreate it. If an incompatible type of OT is plugged into the slot then
an alarm will be raised for an “Unexpected CP type”. To replace the
OT in this case, the user will need to delete the existing OT
connection first and then install the new OT with a valid customer
signal. This event would cause autoprovisioning of the connection
with the new OT type.

Each LambdaXtreme™ Transport 10G OT supports a bidirectional
channel via client side ports (IN ADD, OUT DROP) and line side

Establishing Optical Channel Connections
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ports (IN wxyz, OUT wxyz). The 10G OT ports are shown in the
following figure:

Figure 5-1 10G OT Ports
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2.5G/10G Trib Connections
....................................................................................................................................................................................................................................

2.5G Trib Optical
Connections

2.5G Trib optical channel connections are supported on 10G End
Terminals and OADM Terminals. These connections are supported by
a 10G Mux OT and include the following:

• Four 2.5G bidirectional channels connected to four customer
signals (ports TRIB 1 IN & OUT, TRIB 2 IN & OUT, TRIB 3
IN & OUT, TRIB 4 IN & OUT)

• One line side WW10G signal input connected to the OD (port IN
wxyz)

• One line side WW10G signal output connected to the OM (port
OUT wxyz)

The 2.5G Trib connection is shown in the following figure:

Figure 5-2 2.5G Trib Connection
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10G Trib Optical
Connections

10G Trib optical channel connections are supported on 40G End
Terminals. These connections are supported by a 40G Mux OT and
include the following:

• Four 10G bidirectional channels connected to four customer
signals (ports TRIB 1 IN & OUT, TRIB 2 IN & OUT, TRIB 3
IN & OUT, TRIB 4 IN & OUT)

• One line side WW40G signal input connected to the OD (port IN
wxyz)

• One line side WW40G signal output connected to the OM (port
OUT wxyz)

The 10G Trib connection is shown in the following figure:

Figure 5-3 10G Trib Connection
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Autoprovisioning of
2.5/10G Trib Optical

Connections

When a new 10G/40G Mux OT pack is properly connected by the
user and one to four 2.5G/10G valid signals are sent to the client side
ports of the OT the following occurs:

• the LambdaXtreme™ Transport NE establishes a 10G/40G
channel on the line side. On the customer side there may be up
to four 2.5G/10G customer channels.

• the LambdaXtreme™ Transport NE automatically discovers the
underlying connections and automatically provisions the
corresponding two-way channels for a 2.5G/10G Trib connection.
These channels are bidirectional and include both the adds and
the corresponding drops.

• the LambdaXtreme™ Transport NE provisions one connection per
2.5G/10G Trib customer input. Since there may be one through
four 2.5G/10G customer inputs, there may be one through four
2.5G/10G Trib connections provisioned.
Note: The four 2.5G/10G Trib connections may be connected to
the Mux OT at different times.

When provisioned, the parameters for these types of connection are
stored as follows:

• The connection type parameter has the value of “2.5G Trib” or
“10G Trib”.

• The tributary identifier has the value of the tributary being used
in this connection. The values are: Trib1, Trib2, Trib3, or Trib4.

2.5G/10G Trib Connections Establishing Optical Channel Connections

....................................................................................................................................................................................................................................

5 - 8 Lucent Technologies - Proprietary
See notice on first page

365-575-781R1.1
Issue 1, June 2002



OADM Connections
....................................................................................................................................................................................................................................

Overview OADM nodes support autodiscovery and autoprovisioning of
connections where OTs are used. As with End Terminals, the
compatible optics connections are provisioned by the user as External
connections.

OADM NEs autoprovision optical connections in the same manner as
End Terminals. When a new OT is installed, and a valid signal is
applied, autodiscovery of the connection is triggered. The OADM NE
supports 10G systems and has the capability to add/drop 50% of the
total channels supported on the node. The odd channels (referring to
the frequency grid) are always express (i.e., travel through the node);
the even channels can be set to through or configured to Add/Drop.
For each even channel, the OADM NE has two through channels, one
for each direction of transmission. By default, all channels are set to
through.

OADM NE types differ from other LambdaXtreme™ Transport node
types in the manner connections are provisioned because for OADM
nodes the user has the capability to reconfigure connections via the
CIT, TL1 commands, or the EMS. A through connection may be
reconfigured to add/drop connections and vice-versa.

For the very first reboot of the OM and OD packs, the software sets
the through channels for all frequencies to the through position and
the add side channels to blocked position. This sets the channels to
through by default. For any subsequent reboots of the OM or OD
packs the channels assume their previous position.

Adding OADM Connections

An OADM connection is added by first setting the through channels
for a specific frequency to the Add/Drop position. By this operation,
the frequency is blocked from being a through channel and then can
be added/dropped.

Note: This type of connection can be provisioned either via the CIT,
the TL1 cut-through (ENT-OADM-CONFIG command), or the EMS.
See Appendix A, “Using the CIT” for provisioning via the CIT. See
Chapter 7, “Craft Interface Terminal” for provisioning using TL1
commands. See the Navis™ Optical Element Management System
(EMS) Provisioning Guide, Release 8.0 (190-224-156R8.0), for
provisioning via the EMS.

Establishing Optical Channel Connections
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The following parameters must be specified when configuring the
OADM:

• the frequency to be added/dropped
Note: In an OADM NE, the NE only validates and allows
booting of OTs which have frequencies that can be
added/dropped. In the R1.1 OADM NE, only OTs that have
frequencies that end in 0 (as opposed to 5) can be used to
add/drop channels. The express channels (frequencies that end in
5) cannot be added/dropped.
Note: The RTRV-TH-OCHAN command is not applicable to
express channels on the OADM. A request for this data will be
denied by the network element.

• the add/drop position for the OADM through channels

To add an optical connection on the OADM the following events must
take place (in any order).

1. Configure through channel to add/drop position.

2. Connect OT and turn valid client signal on.

When a valid signal is applied to an OT on an OADM the following
occurs:

• The software retrieves the position of the OADM through
channels. If the through channels are set to add/drop for this
frequency, the NE proceeds to provision the connection. If the
OADM through channels are positioned to through for this
frequency, the NE produces an autonomous error message.

• If the through channels are set to add/drop for this frequency, the
software sets the corresponding add channel to pass. This allows
autodiscovery and autoprovisioning of the new connection to take
place.

• When the autoprovisioning of the new connection is completed
and the corresponding line AID is identified, the software ensures
that the add channel for the frequency on the other line is at the
block position if there is no connection. The add channel is set to
pass only if there is a corresponding valid connection.

OADM Connections Establishing Optical Channel Connections
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The OADM may be configured at any point in time.

• A channel may be configured from through to add/drop which
will create the connection in the NE database if the client signal
is present.

• A channel may be configured from add/drop to through which
will delete the connection(s) if any are present for this channel.

Note: The through channels are not provisioned as connections. Only
the add/drop channels are provisioned.

When adding a compatible optics connection on an OADM, this
operation must be performed after the through channels have been
configured to the add/drop position. Provisioning a connection
(automatically or manually) will occur only when the corresponding
through channels are configured to add/drop position.

OADM Connections Establishing Optical Channel Connections
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40G Through Connections for Back-To-Back End Terminals
....................................................................................................................................................................................................................................

Overview 40G through connections are only supported on 40G End Terminals.
The through connections are supported by through OTs. The through
OTs are unidirectional and only have one input and one output. The
through connections for back-to-back End Terminals are
autodiscovered and autoprovisioned by LambdaXtreme™ Transport
when valid signals are applied to the OTs. A 40G through connection
for back-to-back End Terminals is shown in the following figure:

Figure 5-4 40G Through Connection for Back-to-Back End
Terminals
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The following conditions must exist for a valid through connection for
back-to-back End Terminals:

• The two through OTs must be configured in the same End
Terminal. The other End Terminal must be configured for a
compatible optics connection.

• The same grid frequency must be used as input and output from
the through OTs.

• The output grid frequency of the through OTs will be the same
as the input (no frequency conversion).

In Figure 5-4, “40G Through Connection for Back-to-Back End
Terminals” (5-12), the 40G through connection will get
autodiscovered/autoprovisioned in End Terminal X. For the other End
Terminal (End Terminal Y), the user must manually enter an external
connection for compatible optics.

Autoprovisioning of 40G Through Optical Connections

Before provisioning the 40G through connection in the database, the
NE will verify that a second 40G through OT with the same
frequency is installed on the same system. This second OT may or
may not have a valid input signal at the time the first through OT gets
discovered.

If a second through OT does not exist, the NE generates an alarmed
condition for an invalid 40G through connection. In this case, the 40G
through connection will not be provisioned until both through OTs are
installed.

Autodiscovery of a 40G through optical channel begins when a valid
signal is applied to the add side of any one of the two through OTs.
Given the back to back End Terminal configuration shown in End
Terminal X in Figure 5-4, “40G Through Connection for
Back-to-Back End Terminals” (5-12), (both through OTs are in the
same End Terminal) the LambdaXtreme™ Transport software will
autodiscover and autoprovision 1 two-way channel for a through
connection for back-to-back End Terminals. This connection is
bi-directional and includes both through OTs corresponding to the add
and drop sides of this channel.

The connections are provisioned separately in End Terminal X and
End Terminal Y. (Every connection is provisioned independent of the
channel in the downstream or upstream back-to-back End Terminal).

40G Through Connections for
Back-To-Back End Terminals
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Autodiscovery and autoprovisioning applies to the connection in End
Terminal X. The connection in End Terminal Y must be provisioned
by the user as an external connection for compatible optics.

40G Through Connections for
Back-To-Back End Terminals
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External Connections for Compatible Optics
....................................................................................................................................................................................................................................

Overview A compatible optics signal for LambdaXtreme™ Transport is defined
as a wave wrapped optical signal which is an equivalent signal to that
produced or accepted by the LambdaXtreme™ Transport OT line side.
Compatible optics connections are supported on End Terminals and
OADM Terminals. These connections bypass the use of OTs. The OT
function is moved out of the LambdaXtreme™ Transport NE to an
external NE. This external NE must be able to accept standard output
from an OD and produce standard input to an OM on the
LambdaXtreme™ Transport NE.

Compatible optics signals have grid frequencies, wave wrapped
optical signals, and transmit power levels the same as
LambdaXtreme™ Transport. The compatible optics signals to a
LambdaXtreme™ Transport NE may originate from another
LambdaXtreme™ Transport NE (e.g., back-to-back terminals with
through OTs) or from other Lucent optical products with compatible
DWDM signals (e.g., Lucent Technologies LambdaUnite™

MultiService Switch (MSS)).

Provisioning External
Connections for

Compatible Optics

The LambdaXtreme™ Transport NE can not autodiscover compatible
optics connections because the OT, which would sense the input
signal, gets bypassed and therefore the NE does not know when the
external connection is turned on. Connections for compatible optics
must be manually provisioned. This can be done via the CIT, TL1
cut-through (ENT-CONN command), or the EMS.

The following parameters must be specified for a compatible optics
connection:

• “EXT” (external) for type of connection

• connection grid frequency

• line AID

Note: When adding a compatible optics connection to a
LambdaXtreme™ Transport NE, it is recommended that the user first
provision an external (EXT) type connection (see “Add Compatible
Optics Connection” (A-129)) before applying the input signal from the
external source to the LambdaXtreme™ Transport NE. Users must
ensure that the external source is transmitting a stable signal
(non-fluctuating) before applying it to the LambdaXtreme™ Transport
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NE in order to preserve stable transmission and not cause a power
transient.
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6 System Maintenance

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides detailed “how to” instructions for performing
basic maintenance activities and test procedures on the
LambdaXtreme™ Transport Transport optical networking product.

Contents
Remove Front Cover 6-2

Inspect/Replace Air Filter 6-4

Install Front Cover 6-7
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Remove Front Cover
....................................................................................................................................................................................................................................

Purpose This procedure describes how to remove a front cover which allows
access to the air filter.

CAUTION
Use a static ground wrist strap whenever handling circuit
packs or working on a LambdaXtreme™ Transport System
network element to prevent electrostatic discharge damage to
sensitive components.

Procedure ............................................................................................................................................................

1 Each front cover is secured by a pair of latches located in the
top-right and top-left corners of the front cover. Rotate the locking
screws 90 degrees counter-clockwise to release the latch handles (see
Figure 6-1, “Front Cover Latch - Rotate” (6-2)).

............................................................................................................................................................

2 Push on the outside edge of each latch handle so that the inside edge
lifts up (see Figure 6-2, “Front Cover Latch - Up” (6-2)).

Figure 6-1 Front Cover Latch - Rotate

Figure 6-2 Front Cover Latch - Up
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............................................................................................................................................................

3 Rotate the open handles 90 degrees counter-clockwise to release the
latches (see Figure 6-3, “ Front Cover Latch - Release” (6-3)).

............................................................................................................................................................

4 Pull the top of the cover several inches toward you, while supporting
it so that it does not fall.

............................................................................................................................................................

5 Remove the front cover by lifting it straight up to free it from the two
hinge brackets located at the bottom of the shelf.

Figure 6-3 Front Cover Latch - Release
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Inspect/Replace Air Filter
....................................................................................................................................................................................................................................

Purpose This procedure is used to remove the air filter in the bay for
inspection, and when necessary, to replace the air filter.

Note: An appropriate screwdriver is needed for this procedure.

Important! A dirty filter causes a substantial reduction in the amount
of available cooling air to the bay. The air filter should be inspected
periodically and changed every six months.

Procedure ............................................................................................................................................................

1 Identify the location of the plastic cover on the shelf in the bay that
contains the air filter. See Figure 6-4, “Air filter removal process”
(6-5).

System Maintenance
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............................................................................................................................................................

2 Remove the front cover (see “Remove Front Cover” (6-2)) to expose
the air filter slide holder assembly. The following figure shows the
steps to remove the air filter.

............................................................................................................................................................

3 Turn the screw (counterclockwise) on the air filter slide holder to free
it and then pull it toward you.

Result:

The air filter which was held in place by the slide holder is
released.

Figure 6-4 Air filter removal process
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............................................................................................................................................................

4 Remove the air filter and inspect it for any dirt or dust accumulation
that may clog it. The following figure shows the air filter.

............................................................................................................................................................

5 The filter can be reused if in good condition, but must be replaced if
dirt or dust has accumulated.

............................................................................................................................................................

6 Insert a filter back into the shelf. While holding it up into position,
push the air filter slide holder back into position (make sure the back
lip of the assembly slides under the filter to secure it).

Important! When inserting a filter into the shelf, make sure the air
flow arrows (located on the filter’s edge) are pointing up.

............................................................................................................................................................

7 Turn the screw (clockwise) on the air filter slide holder to secure it.

............................................................................................................................................................

8 Replace the front cover (see “Install Front Cover” (6-7)).

Figure 6-5 Air Filter
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Install Front Cover
....................................................................................................................................................................................................................................

Purpose This procedure describes how to re-install a front cover.

Procedure ............................................................................................................................................................

1 Replace the front cover, inserting the bottom corners of the cover into
the two hinge brackets located at the bottom of the shelf, and pressing
the top of the front cover into place, flush with the shelf.

............................................................................................................................................................

2 Rotate the open latch handles 90 degrees clockwise to close the
latches.

............................................................................................................................................................

3 Push on the raised edge of each latch handle to close it, so it is flush
with the latch mechanism.

............................................................................................................................................................

4 Rotate the locking screws 90 degrees clockwise to secure the latch
handles.
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7 Craft Interface Terminal

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides a description of the LambdaXtreme™ Transport
Craft Interface Terminal (CIT).

Note: Specific task-oriented procedures performed via the CIT are
covered in Appendix A, “Using the CIT”.

Contents
CIT Functionality 7-2

OLS Manager 7-4

Node Manager 7-6

TL1 Cut-Through Interface 7-9

Data Tables and Lists 7-12

....................................................................................................................................................................................................................................

365-575-781R1.1
Issue 1, June 2002

Lucent Technologies - Proprietary
See notice on first page

7 - 1



CIT Functionality
....................................................................................................................................................................................................................................

Description The CIT provides a GUI that allows users to interact with
LambdaXtreme™ Transport NEs from a PC via a 10/100BaseT
physical connection. The CIT may be connected to the NE either
locally through a physical connection to the CIT port located on the
SIO, or remotely via a Data Communications Network (DCN)
connection or dial-up connection to the NE’s EMS port.

The LambdaXtreme™ Transport CIT GUI is a common interface to all
LambdaXtreme™ Transport NEs regardless of type, and provides a
powerful, flexible, and user friendly interface to execute the most
frequently used actions. The GUI also supports numerous
customization options so that users may tailor the displays in
accordance with their own preferences. The CIT operates as an
enhanced graphical tool and as a general provisioning aid. It is
designed to take advantage of the capabilities of the LambdaXtreme™

Transport NEs, and optimize the role of the NEs in management
functions to create an intelligent operations environment. The CIT
provides the user with access to command functions that are required
to install and operate LambdaXtreme™ Transport NEs and to maintain
the LambdaXtreme™ Transport Optical Line System (OLS).

Note: Typically, for an established OLS system, the users perform
their maintenance functions by using an Element Management System
such as Lucent Technologies Navis™ Optical Element Management
System (EMS) to operate the NE on an ongoing basis.

Craft Interface Terminal
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The CIT user interface is divided into three primary windows:

• OLS Manager – This window first appears when the user starts
the CIT. The OLS Manager displays OLS (End Terminal-End
Terminal) topology and provides the user with the facilities to
launch login connections to any accessible network element.

• Node Manager – This window appears when the user connects to
a network element from the OLS Manager. It provides the
functions necessary to work with the network element across a
variety of command functional areas such as Provision/Info,
Performance, Test/Analysis, and Fault.

• Cut-Through Interface – This window appears when the user
connects to a network element from the OLS Manager by
selecting the cut-through option. It is a command line driven
interface to the network element and requires specific knowledge
of the commands in their TL1 form. One powerful feature of the
cut-through interface is the scripting capability. Here the user can
sequence any number of TL1 commands in a single file and have
the CIT batch execute them one after the other. This is useful for
provisioning large numbers of parameters at one time.

Important! For details on installing and setting up the CIT software
and associated documentation, see LambdaXtreme™ Transport
Installation Manual and System Turn-up Services, Release 1.1.

CIT Functionality Craft Interface Terminal
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OLS Manager
....................................................................................................................................................................................................................................

Introduction Once the CIT application is launched, the OLS Manager window
appears. After NEs and/or OLSs have been identified on the CIT, the
OLS Manager becomes the launching point for providing the CIT user
the ability to interact with NEs. The OLS manager allows the user to
specify which types of NEs to display.

Step-by-step instructions for using the OLS Manager via the CIT are
covered in Appendix A, “Using the CIT”.

After a user has identified at least one network element, the user can
perform actions on it. These include:

• Displaying the network map for the OLS to which the NE
belongs.

• Logging into an NE within the maintenance subnetwork and
using the CIT Node Manager to invoke CIT user functions on the
NE.

• Logging into an NE within the maintenance subnetwork and
issuing the appropriate TL1 command directly to the NE without
use of the CIT GUI. This is called the cut-through option.

OLS Manager Features During a CIT session the user is able to perform the following OLS
Manager functions by accessing these functions from one of the OLS
Manager menus:

• Retrieve information about NEs and their associated OLSs

• Display the network map for the OLS to which the NE belongs

• Login to an NE

• Access Cut-Through option to issue TL1 commands

• Establish communications to NEs

• Search for a node.

OLS Manager Display The OLS Manager contains the following sections:

• Title Bar – Displays the title of the software. Also contains the
window controls to minimize, maximize or close the window.

• Menu Bar – Provides access to the OLS manager functions.
These menus are also accessible via keyboard shortcuts.
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• Toolbar – Provides the ability to choose which OLS Map to
display, filter the NEs via the Show drop down list, login to an
NE, and retrieve an OLS Map.

• OLS Network Map – Displays the NEs defined for this system.

• Status Bar – Displays messages from the OLS Manager.

• Node Monitor Toolbar – Displays which NEs you are currently
connected to. Provides ability to restore or disconnect a Node
Manager or display the properties of the node.

OLS Network Map The intent of the network map that is displayed in the OLS Manager
window is to give the CIT user information that is needed to help
expedite the process of connecting to an NE. To find out more
detailed information about an NE, the user must first log into the NE
and invoke the desired function from the Node Manager menu.

The CIT OLS network map displays the following information:

• All NEs in the selected OLS. Network map information is
provided for all network map icons including NE type, NE TID
or alias, and any NEs that are part of the OLS map but may not
be currently reachable.

• The connections between the NEs.

• Any LAN/WAN accessible gateway NEs.
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Node Manager
....................................................................................................................................................................................................................................

Introduction The Node Manager appears once you log into a network element from
the OLS Manager. From this window the user performs network
management functions on the NE such as performance, fault
management, provisioning, channel connection management and
administration.

Step-by-step instructions for using the Node Manager via the CIT are
covered in Appendix A, “Using the CIT”.

The Node Manager window remains on the screen as long as the user
is logged into the NE. The Node Manager screen closes when the NE
login session is terminated via one of the following:

• the user disconnects from the NE

• the user manually closes the Node Manager window

• the connection with the NE is terminated due to network
problems, NE reboot, logout due to session inactivity, etc.

Node Manager Display The Node Manager contains the following sections:

• Title Bar – This displays the title of the software and displays the
TID of the NE to which you are connected. Also contains the
window controls to minimize, maximize, or close the window.

• Menu Bar – Provides access to the Node Manager functions (also
available via the keyboard shortcuts). From this, the user can
manage the NE and perform any of the available functions.

• Alarm Toolbar – Displays a summary of the current alarms in the
system by severity including the counts for each occurrence. The
user can click on this display to view more details for each alarm
severity. Also displayed in the Alarm Toolbar is the date and time
of the latest alarm that contributed to the alarm summary (Alarms
Last Updated). This toolbar is undockable (can be separated from
the Node Manager window). This is useful if more than one NE
is being monitored at a time and the user would like to minimize
some Node Managers while retaining the ability to monitor
alarms.
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• View Toolbar – Displays the buttons to access the five different
views that correspond to the Node Manager functions (i.e.,
Equipment, Provision/Info, Performance, Test/Analysis, and
Fault). The icons associated with each different view are
automatically dimmed if they are not applicable for the
equipment chosen in the NE Equipment Tree.

• NE Equipment Tree – This is similar to a windows explorer tree.
This hierarchical display allows the user to select equipment that
is part of the NE. A piece of equipment is selected by clicking on
it. The alarm icon in the tree automatically becomes dimmed if
the View chosen in the View Toolbar is not applicable to the
associated equipment.

• Display Panel – Displays the appropriate information based on
the highlighted equipment and the view. This area may display
graphics, static information, or allow the user to enter data. When
existing data is modified, a change gliff symbol appears next to
the field that has been modified and also in the display panel tab.
This indicates a change is pending but has not yet been applied.

• Status Bar – The status bar is located across the bottom of the
Node Manager window and is divided into three sections. The
left side of the status bar displays any messages or instructions
from the Node Manager. The middle section displays the AID of
the equipment selected in the tree. The right side displays the
currently active view from the View Toolbar.

NE Equipment Tree The NE Equipment Tree allows the user to navigate through the NE
equipment in a hierarchical fashion from the system level down to the
port level and select a single entity from the hierarchy. The NE
Equipment Tree is always displayed on the Node Manager and
provides the equipment selection mechanism for all the NE
management functions supported within the Node Manager window.
The selection on the NE Equipment Tree is always in sync with the
information displayed in the Display Panel.
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When navigating the equipment tree, the following applies:

• Click on the plus sign (+) in front of the piece of equipment to
expand the tree (or double-click the piece of equipment when
closed).

• Click on the minus sign (-) in front of a piece of equipment to
collapse the tree (or double-click the piece of equipment when
open).

• Click on a piece of equipment to select it.

Equipment Tree Hierarchy

The Equipment Tree hierarchy is as follows:

• System (Level 1) – This is the highest level on the NE
Equipment Tree.

• Miscellaneous Discretes (Level 2)

• Optical Lines 1E and 1W (Level 2)

• Bay (Level 2)

• Shelf (Level 3)

• Slot (Level 4)

• Port (Level 5)
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TL1 Cut-Through Interface
....................................................................................................................................................................................................................................

Overview The CIT cut-through interface is a command line interface for issuing
TL1 commands directly to the NE. This interface requires specific
knowledge of TL1 commands. Step-by-step instructions for using the
TL1 cut-through interface via the CIT are covered in Appendix A,
“Using the CIT”. For information regarding TL1 command usage via
EMS, see the Navis™ Optical Element Management System (EMS)
Provisioning Guide, Release 8.0 (190-224-156R8.0).

Note: The set of supported TL1 commands for LambdaXtreme™

Transport can be accessed by clicking on the Documentation Library
icon which appears on the PC desktop once the documentation CD is
installed. A link to the TL1 command library is available from the
HTML page which is launched from this desktop icon. When
connected to an NE, the supported TL1 commands can be viewed in
the TL1 command list displayed in the TL1 cut-through interface.

The CIT user has the ability to see TL1 messages sent to the NE and
the responses received from the NE. The following modes can be
selected:

• Sent/Reply – Display only those commands sent to the NE and
the responses received from the NE.

• Autonomous – Display only the autonomous messages received
from the NE.

• All – Display all commands (includes both of the above).

Features Once the CIT user invokes the cut-through function, the user has the
following capabilities:

• Send commands to the NE.

• Display the TL1 response.

• Toggle logging on or off (user can specify a file name for the
log).

• Start/stop the FTP server.

• Execute a script containing a sequence of commands.

Note: When using cut-through, the semi-colon character is not
supported as data since it has special meaning to the TL1 commands.
Therefore, semi-colons cannot be sent via the cut-through interface in
any command.
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TL1 Cut-Through
Functionality

The cut-through interface provides two basic modes to issue
commands - interactive and scripting. Interactive mode allows the user
to issue TL1 commands one at a time. Scripting mode allows the user
to issue a group of TL1 commands to the NE. This is useful for
provisioning large numbers of parameters at one time. The user can
script any number of TL1 commands in a single file and have the CIT
batch execute them one after the other.

The cut-through window is divided into the following five sections:

• TL1 Command List (Interactive mode only) – This lists the TL1
commands available for the current release of the software. The
user can choose to view all the commands in an alphabetical list
or a list organized by functionality. There are tabs on the
command list that allow the user to choose which to display.

• OLS/TID Selection (Interactive mode only) – There are two drop
down lists that allow the user to select an OLS and the TID to
which the TL1 command(s) are to be sent. The TL1 command
will have the TID field pre-populated with this value.

• Interactive Command Line (Interactive mode only) – This section
displays a template of the TL1 command that was highlighted in
the TL1 command list. The user has the opportunity to edit the
parameters and add any optional parameters that are desired
before pressing the Send button to send the command to the NE.
The Command Line also functions as a drop down to view and
select previously sent commands.

• Message Monitor – This area displays the TL1 command sent to
the NE and the response from the NE. The user can choose to
display only those commands sent to and the responses from the
NE (Interactive tab), the autonomous messages received from the
NE (Autonomous tab), or all the commands (All tab).

• Logging – This section allows the user to specify whether they
want to log the communications between the CIT and the NE. It
provides the user with the ability to specify which file to log the
commands to and also the ability to view the log file.

TL1 Logging The CIT provides the ability to turn on/off a logging function that
logs communications between the CIT and the NE. The CIT user has
the ability to perform the following TL1 logging functions:

• Activate a TL1 message logging function.

• Choose the TL1 log file.
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• View the TL1 log file.

• Toggle the TL1 logging function on/off. At the beginning of a
cut-through session, the TL1 logging function is initially be set to
“Off” and the TL1 log file name is set to a default.

FTP Server Starting and stopping the FTP server can be performed via the CIT
cut-through interface. This feature provides the user with a convenient
method of launching an FTP server task which must be done prior to
performing backup and restore operations or downloading software.
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Data Tables and Lists
....................................................................................................................................................................................................................................

Overview This section includes general information regarding data tables and
lists available with LambdaXtreme™ Transport.

Following is an overview of the features available in the CIT data
tables and lists:

• All data tables and lists in the CIT GUI contain the TID and the
System Date/Time of the NE to which the information applies.
All dates and times are in the format designated on the NE
(SONET or SDH).

• A Report button lets the user send data to the PC browser and
the user can then save the data to a file and/or print it. When the
Report button is clicked, the PC’s default browser is launched.
For this functionality, there must be an HTML browser properly
installed on the PC.

• Data tables and lists support column resizing and rearranging.
The user can resize columns by placing the cursor between
column headings and dragging horizontally. The user can move
entire columns by dragging on the column heading.

• Data tables and lists support sorting (ascending and descending)
of rows based on the values in one of the columns. The user
clicks on the header of the column whose values are to be used
for the sort.
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Appendix A: Using the CIT

Overview
....................................................................................................................................................................................................................................

Purpose This section illustrates through procedural exercises, the features and
capabilities of Lucent Technologies LambdaXtreme™ Transport CIT
application software. The CIT provides the user with access to the
command functions that are necessary to operate a newly installed NE
and maintain the LambdaXtreme™ Transport OLS. The procedures in
this section should prove useful when training new personnel
regarding user operations on the CIT. It is strongly recommended that
such training only be run with a LambdaXtreme™ Transport
network/subnetwork that is out of service.
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Identify CIT Software Version A-7

Install Initial NE Software A-8

Access Node A-10

Disconnect Node A-11
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Set OLS Manager Preferences A-18

View OLS Details A-19
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Rename OLS A-20

Delete OLS A-21

Export OLS Map Information A-22

Import OLS Map Information A-23

Node Search A-24

View/Edit Node Properties A-27

Execute Commands Interactively via TL1 Cut
Through

A-28

Run Scripts via TL1 Cut Through A-31

Log Into Node A-34

Access the Equipment View in Node Manager A-36

Access the Provision/Info View in Node Manager A-39

View System Details A-41

Provision Optical Line Settings A-42

View Circuit Pack Details A-43

Provision Mode for OT Client Side Input Port A-44

Generate a Circuit Pack Inventory Report A-48

Provision Monitoring Status of SIO Ports A-50

Provision Orderwire Type and Timing Source A-52

Provision OT Line In Error Response A-54

Access the Performance View in Node Manager A-56

Set Start Time for Performance Monitoring A-58

Generate Performance Monitoring Data A-60

Establish Baseline Values for Signal/Total Power A-62

Provision Analog Threshold Levels and Message
Notification

A-64

Provision Digital Threshold Levels and Message
Notification

A-66

Reset Digital Performance Monitoring Storage
Registers

A-68

Access the Test/Analysis View in Node Manager A-70

Test System Office Alarms A-72
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Test Circuit Pack LEDs A-74

Verify Fiber Connectivity A-76

Obtain OT Section Trace A-77

Specify OT Section Trace Settings A-79

View Signal Status of OT Port A-81

Obtain Optical Channel Path Trace A-83

Specify Optical Channel Path Trace Settings A-85

Access the Fault View in Node Manager A-87

Set Options and Generate Alarm List for Selected
Equipment

A-89

Provision Alarm Severity Levels A-91

Provision System Alarm Settings A-93

Provision Miscellaneous Discretes Environmental
Points

A-95

Provision/Operate Miscellaneous Discretes Control
Points

A-97

Provision System Level Attributes for the NE A-99

Auto Update Messages A-102

View Alarm List Report A-103

Cut Off Audible Alarms A-105

View Neighbors Report A-106

View Event History Log A-107

View Channel Map Report A-108

View OLS Configuration Report A-110

View OLS Software/Database Report A-111

Refresh Alarms A-112

Refresh Equipment A-113

Security Administration - Add a User A-114

Security Administration - View/Change User
Security Settings

A-116

Security Administration - Delete a User A-118

Security Administration - Set System Security
Parameters

A-119
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Security Administration - Change Password A-121

View Software Release Information A-122

Download Software A-123

Copy Software A-125

Reboot System A-127

Add Compatible Optics Connection A-129

Delete Optical Connection A-133

OADM Configuration A-135

Access the Help Viewer A-138
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Launch CIT Application
....................................................................................................................................................................................................................................

Purpose Bring up the LambdaXtreme™ Transport CIT application on the PC.

Procedure ............................................................................................................................................................

1 At the Windows desktop, double-click on the LambdaXtreme™

Transport CIT icon that was created when the LambdaXtreme™

Transport CIT applications software was installed.

Result:

The following legal notice appears:

............................................................................................................................................................

2 Read the Legal Notice and click OK.
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Result:

The OLS Manager window appears:
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Identify CIT Software Version
....................................................................................................................................................................................................................................

Purpose To determine the version of the LambdaXtreme™ Transport CIT
software currently being used.

Procedure ............................................................................................................................................................

1 From the OLS Manager menu, select Help > About LambdaXtreme
Transport CIT.

Note: When logged into an NE, this procedure can also be performed
from the Node Manager menu.

Result:

The following window is displayed with the CIT software
Release and Build information:

............................................................................................................................................................

2 Click OK to close the window.
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Install Initial NE Software
....................................................................................................................................................................................................................................

Purpose Copy the NE software generic (executable code and data) from the
CIT-PC to the FMM for use by the NE.

Procedure ............................................................................................................................................................

1 Insert the FMM into the PCMCIA slot on the CIT PC.

Note: See the LambdaXtreme™ Transport Software Release
Description, Release 1.0 (C109163642) for formatting information.

............................................................................................................................................................

2 From the OLS Manager menu, select Manager > PC-Card Loader...

Result:

The PC Card Loader window appears:

............................................................................................................................................................

3 Make the appropriate selections for Software Release and Logical
Drive.

Result:

............................................................................................................................................................

4 Click OK or Apply.
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Result:

The progress bar displays the progress of the Copy operation.

When finished, the following window appears:

............................................................................................................................................................

5 Click OK.

............................................................................................................................................................

6 Remove the FMM from the CIT. Insert the FMM into the slot on the
NCTL and the software will automatically be used on the NE.
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Access Node
....................................................................................................................................................................................................................................

Purpose Define access to a node. (Necessary only if accessing the NE via the
LAN/WAN).

Procedure ............................................................................................................................................................

1 From the OLS Manager menu, select OLS > Access Node...

Result:

The Access Node window appears:

............................................................................................................................................................

2 Enter the appropriate information in this window.

............................................................................................................................................................

3 Click Login to connect to the node (see “Log Into Node” (A-34)), or
click Retrieve Map to update the graphical map of the OLS that
contains the node (see “Retrieve OLS Map” (A-14)), or click Cut
Through to start a Cut Through interface to the node (see “Execute
Commands Interactively via TL1 Cut Through” (A-28)).
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Disconnect Node
....................................................................................................................................................................................................................................

Purpose Disconnects from selected node(s) that the user is currently logged
into.

Note: You can also disconnect from a node by right-clicking the NE
in the Node Monitor, or by selecting File > Disconnect from the
Node Manager menu.

Procedure ............................................................................................................................................................

1 From the OLS Manager menu, select Node > Disconnect...

Result:

The Disconnect Nodes window appears:

............................................................................................................................................................

2 Select the node(s) to be disconnected. Click OK.

Result:

The node is disconnected and the user is returned to the OLS
Manager.
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Assign/Unassign Gateway Nodes
....................................................................................................................................................................................................................................

Purpose To define access to nodes that do not have an IP address and to which
you are not currently connected. These nodes can only be accessed
through a Gateway node.

Procedure ............................................................................................................................................................

1 From the OLS Manager menu select OLS > Gateway Assignments

Result:

The Gateway Assignments window appears:

............................................................................................................................................................

2 Select the gateway by clicking the down arrow next to the Node field
and clicking on the appropriate selection from the drop down list.

Using the CIT
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............................................................................................................................................................

3 Select the Node(s) to be assigned to the selected gateway by clicking
on the TID (or Alias) in the list. The Ctrl key and Shift key can be
used along with the mouse in order to make multiple selections.

............................................................................................................................................................

4 Click on the Add button to move the selected Node(s) over to the
Assigned list.

Result:

The selected Node(s) appear in the Assigned list and the Apply
button is enabled.

............................................................................................................................................................

5 Click OK or Apply to have the assignments take effect.

............................................................................................................................................................

6 To unassign a Node(s), select the TID (or Alias) from the assigned list
and click on the Remove button. Then click on the OK or Apply
button.

Note: Nodes will be displayed by their TIDs or aliases based on the
Preferences settings (see “Set OLS Manager Preferences” (A-18).
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Retrieve OLS Map
....................................................................................................................................................................................................................................

Purpose Display all NEs in the OLS map that contains the NE where the
command is issued.

Procedure ............................................................................................................................................................

1 In the OLS Manager, select the desired node by clicking on its icon.

Result:

The Login and Retrieve Map buttons become enabled (only if
access is defined - see “Assign/Unassign Gateway Nodes”
(A-12).

............................................................................................................................................................

2 Click on the Retrieve Map button. You can also perform this by
selecting Node > Retrieve Map from the OLS Manager menu.

Result:

The Retrieve Map window appears:

............................................................................................................................................................

3 Enter an OLS name or select one from the drop down list. Click on
OK.
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If certain nodes are not reachable from the selected node, the
following window will appear:

Click OK.

Result:

The Retrieve Map process is complete and you are returned to
the OLS Manager window which displays the newly retrieved

Retrieve OLS Map Using the CIT

....................................................................................................................................................................................................................................

365-575-781R1.1
Issue 1, June 2002

Lucent Technologies - Proprietary
See notice on first page

A - 1 5



OLS map. The OLS selection will be set to the value specified
in the Retrieve Map dialog.

Note: The OLS Manager allows you to specify which type(s) of
NEs are displayed in the OLS map. To filter the NE display,
select the desired NE type from the Show: drop down list.

............................................................................................................................................................

4 To view map information click the Map Info button.

Retrieve OLS Map Using the CIT
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Result:

The following Map Information window appears:
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Set OLS Manager Preferences
....................................................................................................................................................................................................................................

Purpose Use this procedure to specify how the CIT displays the OLS Map in
the OLS Manager.

Procedure ............................................................................................................................................................

1 From the OLS Manager menu, select Manager > Preferences...

Result:

The Preferences window appears:

Note: To define Aliases, see “View/Edit Node Properties” (A-27)
.

............................................................................................................................................................

2 Specify the OLS Manager preferences to be used.

............................................................................................................................................................

3 Click OK.
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View OLS Details
....................................................................................................................................................................................................................................

Purpose Display a report listing all NEs in the OLS currently selected in OLS
Manager.

Procedure ............................................................................................................................................................

1 From the OLS Manager menu, select OLS > Details.

Result:

The OLS Details window appears.

............................................................................................................................................................

2 To close the OLS Report window, click on Cancel or X.
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Rename OLS
....................................................................................................................................................................................................................................

Purpose Change the OLS name for an existing OLS map.

Procedure ............................................................................................................................................................

1 Select the OLS to be renamed from the OLS field drop down list.

............................................................................................................................................................

2 From the OLS Manager menu, select OLS > Rename...

Result:

The Rename OLS window appears:

............................................................................................................................................................

3 Enter the new OLS name.

............................................................................................................................................................

4 Click OK.

Result:

The specified OLS is renamed and the OLS selection is set to
the new value.
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Delete OLS
....................................................................................................................................................................................................................................

Purpose Delete an existing OLS map that is no longer needed/applicable.

Procedure ............................................................................................................................................................

1 Select the OLS to be deleted from the OLS field drop down list.

............................................................................................................................................................

2 From the OLS Manager menu, select OLS > Delete.

Result:

The following warning appears:

............................................................................................................................................................

3 Click Yes.

Result:

The specified OLS is deleted and the user is returned to the
OLS Manager.
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Export OLS Map Information
....................................................................................................................................................................................................................................

Purpose Save OLS network map information that can then be read in using the
“Import OLS Map Information” (A-23) function.

Procedure ............................................................................................................................................................

1 From the OLS Manager menu, select Manager > Export...

Result:

The Export window appears:

............................................................................................................................................................

2 Select the OLS(s) to be exported and specify the Export filename to
be used.

............................................................................................................................................................

3 Click OK.

Result:

The file is saved to a predetermined directory (lx_xportcit/
workspace on the same drive where the CIT is installed) using
the specified filename. The information can then be read in
using the “Import OLS Map Information” (A-23) function. The
file may be transferred to other CIT PCs as needed.
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Import OLS Map Information
....................................................................................................................................................................................................................................

Purpose Import a file containing OLS network map information. The file must
have been created previously using the “Export OLS Map
Information” (A-22) function.

Note: The execution of the Import function may cause existing OLS
information to be replaced.

Procedure ............................................................................................................................................................

1 From the OLS Manager menu, select Manager > Import...

Result:

The Import window appears:

............................................................................................................................................................

2 Select an existing file from the drop down list and click OK.
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Node Search
....................................................................................................................................................................................................................................

Purpose Search for a node(s) on all LANs that the CIT PC has access to.

Procedure ............................................................................................................................................................

1 From the OLS Manager menu, select Node > Search...
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....................................................................................................................................................................................................................................

A - 2 4 Lucent Technologies - Proprietary
See notice on first page

365-575-781R1.1
Issue 1, June 2002



Result:

The Node Search window appears:

............................................................................................................................................................

2 Enter the IP Address Range and Search Criteria. Click Search Now.

Result:

The search results appear.
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............................................................................................................................................................

3 Click on the desired node in the Search Results list. Then click Login
to connect to the node (see “Log Into Node” (A-34)), or click
Retrieve Map to update the graphical map of the OLS that contains
the node (see “Retrieve OLS Map” (A-14)), or click Cut Through to
start a Cut Through interface to the node (see “Execute Commands
Interactively via TL1 Cut Through” (A-28)).
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View/Edit Node Properties
....................................................................................................................................................................................................................................

Purpose To view/edit properties of existing nodes and to define new gateway
nodes by specifying the values used to connect to the node (the
connection method).

Procedure ............................................................................................................................................................

1 From the OLS Manager, click on the desired node to select it. From
the OLS Manager menu select Node > Properties... or right-click on
the desired node and select Properties...

Result:

The Node Properties window appears:

............................................................................................................................................................

2 After information has been entered or viewed, click on OK to apply
changes and return to the OLS Manager.

Using the CIT

....................................................................................................................................................................................................................................

365-575-781R1.1
Issue 1, June 2002

Lucent Technologies - Proprietary
See notice on first page

A - 2 7

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Execute Commands Interactively via TL1 Cut Through
....................................................................................................................................................................................................................................

Purpose To execute a TL1 command on an interactive basis directly to the NE.

Note: The set of supported TL1 commands for LambdaXtreme™

Transport can be accessed by clicking on the Documentation Library
icon which appears on the PC desktop once the documentation CD is
installed. A link to the TL1 command library is available from the
HTML page which is launched from this desktop icon.

Important! When using cut-through, the semi-colon character is not
supported as data since it has special meaning to the TL1 commands.
Therefore, semi-colons cannot be sent via the cut-through interface in
any command.

Procedure ............................................................................................................................................................

1 In the OLS Manager, click the desired node to select it. From the
menu select Node > Cut Through... or right-click on the node icon
and select Cut Through...
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Result:

The Cut Through window is displayed:

............................................................................................................................................................

2 From the Cut Through window, select the desired OLS and TID from
the drop down list(s) and click (highlight) the appropriate selections.
Be sure that the Interactive tab (not the Scripts tab) is selected.

............................................................................................................................................................

3 Click on the desired command from the TL1 Command List.

Result:

The TL1 template for the selected command is displayed. Insert
your desired parameters into the template. TL1 syntax and
guidance is obtained by clicking TL1 Help.

Execute Commands Interactively via TL1
Cut Through
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The two button tabs (All, Filter) located at the top af the TL1
Command List panel can be used to modify the list. The
purpose of these are as follows:

• All – This shows all of the TL1 commands available for
selection.

• Filter – This allows the user to filter the list by checking or
unchecking the desired boxes. The Filter field can also be
used to enter a command or part of a command to filter the
list.

............................................................................................................................................................

4 Click on the Send button.

Result:

When the command is executed, the command information is
displayed in the Message Monitor.

Other available features in this window include:

• Information can be recorded in a Log File by clicking the “On”
box under Logging. The Log File is set or viewed by clicking the
Log File... button.

• The FTP server can be started/stopped by clicking the FTP
Server tab and then clicking Start or Stop. Server information
can be viewed by clicking Info.

• Sent/Reply, Autonomous, or All messages can be selected for
display in the Message Monitor by clicking the desired tab above
the Message Monitor.

............................................................................................................................................................

5 To close the Cut Through window, click on Close.

Execute Commands Interactively via TL1
Cut Through
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Run Scripts via TL1 Cut Through
....................................................................................................................................................................................................................................

Purpose To script any number of TL1 commands in a single file and batch
execute them all one after the other. This is useful for provisioning
large numbers of parameters at one time.

Procedure ............................................................................................................................................................

1 In the OLS Manager, click the desired node to select it. From the
menu select Node > Cut Through... or right-click on the node icon
and select Cut Through...

Result:

The Cut Through window is displayed.

............................................................................................................................................................

2 Click on the Scripts tab.
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Result:

The Cut Through window is displayed in scripting mode:

............................................................................................................................................................

3 Create a new script which can then be executed, or select the desired
script from the TL1 script list.

............................................................................................................................................................

4 Click the Run button.

Result:

The execution of the commands is displayed in the Message
Monitor as the script is run.

Run Scripts via TL1 Cut Through Using the CIT
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The four icons located at the top af the TL1 Script List panel are used
as follows:

• Left icon (New) – Click this to create a new script (a Notepad
window opens).

• Second to left icon (Open) – Click this to open the selected
(highlighted) script from the list (a Notepad window opens).

• Second to right icon (Refresh) – Click this to refresh the list
after a new script has been created.

• Right icon (Delete) – Click this to remove selected (highlighted)
script files that are not needed.

The user has the ability to select Send All, Pause after each
command, or Pause after Deny response during command
execution.

............................................................................................................................................................

5 To close the Cut Through window, click on Close.
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Log Into Node
....................................................................................................................................................................................................................................

Purpose Log into a node to perform network management functions on the
NE.

Procedure ............................................................................................................................................................

1 First make sure an access method is defined (see “Assign/Unassign
Gateway Nodes” (A-12)). In the OLS Manager, select the desired
node by clicking on its icon. Click on the Login button. You can also
login by selecting Node > Login... from the OLS Manager menu, or
by double-clicking or right-clicking on the node icon.

Result:

The Login window is displayed.

............................................................................................................................................................

2 Enter User ID and Password information (this is case sensitive).
Click on OK.

Note: If Save User ID and Password is checked, the User ID and
Password are retained (only during this session of the OLS Manager)
for subsequent NE logins.
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Result:

The Node Manager window appears:
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Access the Equipment View in Node Manager
....................................................................................................................................................................................................................................

Purpose Display a graphical representation of the equipment selected in the
Equipment Tree.

Procedure ............................................................................................................................................................

1 Click the Equipment button on the View Toolbar in the Node
Manager. This can also be accessed from the Node Manager menu by
selecting View > Equipment.

Note: The Equipment View is the default view that appears when you
log into a node.

Result:

The Equipment View appears in the display panel of the Node
Manager.

............................................................................................................................................................

2 When equipment is selected in the Equipment Tree, the Equipment
View displays a graphical representation (when available) of the
selected equipment.

Note: When System or Bay level equipment (see “NE Equipment
Tree” (7-7)) is graphically displayed, the user can click on specific
equipment in the graphic to display it. If the selected equipment is
open (expanded) in the Equipment Tree, it is displayed with a single
click. If it is not open in the Equipment Tree, double-clicking displays
it. As more detailed equipment is selected in the Equipment Tree
hierarchy, the piece of equipment becomes outlined in the display in
order to identify it.
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Result:

The following is an example:

Access the Equipment View in Node
Manager
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The following shows the display for equipment selection that
has no graphical representation.

Access the Equipment View in Node
Manager
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Access the Provision/Info View in Node Manager
....................................................................................................................................................................................................................................

Purpose Set or view provisioning parameters for the NE or for the piece of
equipment selected in the Equipment Tree.

Procedure ............................................................................................................................................................

1 Click the Provision/Info button on the View Toolbar in the Node
Manager. This can also be accessed from the Node Manager menu by
selecting View > Provision/Info.

Result:

The Provision/Info View appears in the display panel of the
Node Manager.

............................................................................................................................................................

2 As equipment is selected in the Equipment Tree, the Provision/Info
View offers details and/or other Provision/Info options (when
available) for the selected equipment.
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Result:

The following is an example:

............................................................................................................................................................

3 The available option(s) for the selected equipment are chosen from the
tab(s) at the top of the display panel.

Access the Provision/Info View in Node
Manager
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View System Details
....................................................................................................................................................................................................................................

Purpose Display the provisioned information for the NE.

Procedure ............................................................................................................................................................

1 “Access the Provision/Info View in Node Manager” (A-39).

............................................................................................................................................................

2 Select the System (highest level) in the Equipment Tree. Click on the
Details tab in the display panel.

Result:

The System Details window appears:
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Provision Optical Line Settings
....................................................................................................................................................................................................................................

Purpose Provision parameters associated with an optical line.

Procedure ............................................................................................................................................................

1 “Access the Provision/Info View in Node Manager” (A-39).

............................................................................................................................................................

2 From the Equipment Tree, select the Optical Line to be provisioned.
Click on the Details tab in the display panel.

Result:

The Optical Line Details window appears:

............................................................................................................................................................

3 Click the Retrieve button to display the currently provisioned data.
Make the appropriate selections and click Apply.
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View Circuit Pack Details
....................................................................................................................................................................................................................................

Purpose Display the equipage information for a circuit pack.

Procedure ............................................................................................................................................................

1 “Access the Provision/Info View in Node Manager” (A-39).

............................................................................................................................................................

2 Select the appropriate circuit pack slot in the Equipment Tree. Click
on the Details tab in the display panel.

Result:

The Circuit Pack Details window appears:
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Provision Mode for OT Client Side Input Port
....................................................................................................................................................................................................................................

Purpose Set the OT port state as it relates to channel connections.

Procedure ............................................................................................................................................................

1 “Access the Provision/Info View in Node Manager” (A-39).

............................................................................................................................................................

2 From the Equipment Tree, select the OT Client In Port to be
provisioned. Click on the Details tab in the display panel.

Result:

The OT Client In Port Details window appears:

............................................................................................................................................................

3 Click Retrieve and the currently provisioned data is displayed.
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............................................................................................................................................................

4 Select the Port Mode from the drop down list.

............................................................................................................................................................

5 Make the appropriate selection from the Apply to: drop down menu
and click Apply.

Provision Mode for OT Client Side Input
Port
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Note: If All Ports, This & Selected Bays is chosen, the following
Bay Selection window appears:

............................................................................................................................................................

6 Select the appropriate Equipped/Unequipped Bay(s) to which the
settings are to be applied. Use the Add button to move the selected

Provision Mode for OT Client Side Input
Port
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bay(s) to the Selected Bays area. To remove a bay(s) from this area,
select the bay(s) and click Remove.

............................................................................................................................................................

7 Click OK to apply the settings. A completion indicator (checkmark) is
displayed beside each selected bay as the respective operation is
completed.

Provision Mode for OT Client Side Input
Port
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Generate a Circuit Pack Inventory Report
....................................................................................................................................................................................................................................

Purpose Generate a report that contains circuit pack inventory information
from the NE(s).

Procedure ............................................................................................................................................................

1 “Access the Provision/Info View in Node Manager” (A-39).

............................................................................................................................................................

2 Select the System level (highest level) in the NE Equipment Tree.
Click on the Circuit Pack Inventory tab in the display panel.

Result:

The following window is displayed:
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............................................................................................................................................................

3 Make appropriate selections and click Generate to view the Circuit
Pack Inventory Report.

Result:

The Circuit Pack Inventory window appears:
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Provision Monitoring Status of SIO Ports
....................................................................................................................................................................................................................................

Purpose Select SIO port(s) to be monitored for LAN failure (link integrity
failure).

Note: This procedure is not supported in the current release but will
be available in the future.

Procedure ............................................................................................................................................................

1 “Access the Provision/Info View in Node Manager” (A-39).

............................................................................................................................................................

2 From the Equipment Tree, select the slot containing the SIO Pack to
be provisioned. Click on the Port Monitoring tab in the display panel.

Result:

The SIO Pack Port Monitoring window appears:
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............................................................................................................................................................

3 Click the Retrieve button to display the currently provisioned data.
Make the appropriate selections and click Apply.
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Provision Orderwire Type and Timing Source
....................................................................................................................................................................................................................................

Purpose Set parameters used for voice communication between
LambdaXtreme™ Transport NEs.

Procedure ............................................................................................................................................................

1 “Access the Provision/Info View in Node Manager” (A-39).

............................................................................................................................................................

2 From the Equipment Tree, select the slot containing the SUPVY Pack
to be provisioned. Click on the Orderwire Type & Timing Source tab
in the display panel.

Result:

The Orderwire window appears.
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............................................................................................................................................................

3 Click the Retrieve button to display the currently provisioned data.
Make the appropriate selections and click Apply.

Provision Orderwire Type and Timing
Source
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Provision OT Line In Error Response
....................................................................................................................................................................................................................................

Purpose Determine how an OT responds when various signal errors are
detected.

Procedure ............................................................................................................................................................

1 “Access the Provision/Info View in Node Manager” (A-39).

............................................................................................................................................................

2 From the Equipment Tree, select the Port to be provisioned (Port
in_wxyz selected below). Click on the Error Response tab in the
display panel.

Result:

The OT Line In Error Response window appears:
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............................................................................................................................................................

3 Click the Retrieve button to display the currently provisioned data.
Make the appropriate selections and click Apply.
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Access the Performance View in Node Manager
....................................................................................................................................................................................................................................

Purpose Execute performance management functions to monitor transmission
quality and equipment health.

Procedure ............................................................................................................................................................

1 Click the Performance button on the View Toolbar in the Node
Manager. This can also be accessed from the Node Manager menu by
selecting View > Performance.

Result:

The Performance View appears in the display panel of the Node
Manager.

............................................................................................................................................................

2 When equipment is selected in the Equipment Tree, the Performance
View displays available Performance Management options (if any) for
the selected equipment..
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Result:

The following is an example:

............................................................................................................................................................

3 The available option(s) for the selected equipment are chosen from the
tab(s) at the top of the display panel.

Access the Performance View in Node
Manager
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Set Start Time for Performance Monitoring
....................................................................................................................................................................................................................................

Purpose Select or view the start time for the measurement of performance
monitoring.

Procedure ............................................................................................................................................................

1 “Access the Performance View in Node Manager” (A-56).

............................................................................................................................................................

2 Select the System (highest level) in the Equipment Tree. Click on the
Start Time tab in the display panel.

Result:

The Start Time window appears:
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............................................................................................................................................................

3 Click the Retrieve button to display the currently provisioned data.
Make the appropriate selections and click Apply.
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Generate Performance Monitoring Data
....................................................................................................................................................................................................................................

Purpose Request current and historical PM data for optical line, supervisory
channel, optical channel, or OT port.

Procedure ............................................................................................................................................................

1 “Access the Performance View in Node Manager” (A-56).

............................................................................................................................................................

2 From the Equipment Tree, select the optical line, supervisory channel,
optical channel, or OT port for which the report is to generated. Click
on the Report tab in the display panel.

Result:

Depending upon which piece of equipment is selected in the
Equipment Tree, a Report Parameters window such as the
following appears:
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............................................................................................................................................................

3 Specify all appropriate parameters and click on Generate to launch
your browser and display the report.

Note: In a 15 minute PM report, the first bin of data will usually not
contain a full 15 minutes of data. This is because the request will
probably not be made exactly at a 15 minute time boundary.

Generate Performance Monitoring Data Using the CIT

....................................................................................................................................................................................................................................

365-575-781R1.1
Issue 1, June 2002

Lucent Technologies - Proprietary
See notice on first page

A - 6 1

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Establish Baseline Values for Signal/Total Power
....................................................................................................................................................................................................................................

Purpose Set baseline values for power transmitted/received in order to provide
a basis from which to measure deviation from nominal.

Procedure ............................................................................................................................................................

1 “Access the Performance View in Node Manager” (A-56).

............................................................................................................................................................

2 From the Equipment Tree, select the optical line, supervisory channel,
or optical channel to be baselined. Click on the Analog Baseline tab
in the display panel.

Result:

Depending upon which piece of equipment is selected in the
Equipment Tree, an Analog Baseline window such as the
following appears:
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............................................................................................................................................................

3 Click the Retrieve button to display the currently provisioned data.
Select appropriate settings and click Apply.

Establish Baseline Values for Signal/Total
Power
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Provision Analog Threshold Levels and Message Notification
....................................................................................................................................................................................................................................

Purpose Set analog threshold level/crossing alert parameters to monitor
transmission quality and equipment health.

Procedure ............................................................................................................................................................

1 “Access the Performance View in Node Manager” (A-56).

............................................................................................................................................................

2 From the Equipment Tree, select the optical line, supervisory channel,
or optical channel to be provisioned. Click on the Analog Threshold
tab in the display panel.

Result:

Depending upon which piece of equipment is selected in the
Equipment Tree, an Analog Threshold window such as the
following appears:
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............................................................................................................................................................

3 Click the Retrieve button to display the currently provisioned data.
Enter appropriate values and click Apply.

Provision Analog Threshold Levels and
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Provision Digital Threshold Levels and Message Notification
....................................................................................................................................................................................................................................

Purpose Set digital threshold level/crossing alert parameters to monitor
transmission quality and equipment health.

Procedure ............................................................................................................................................................

1 “Access the Performance View in Node Manager” (A-56).

............................................................................................................................................................

2 From the Equipment Tree, select the supervisory channel, or OT port
to be provisioned. Click on the Digital Threshold tab in the display
panel.

Result:

Depending upon which piece of equipment is selected in the
Equipment Tree, a Digital Threshold window such as the
following appears:
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............................................................................................................................................................

3 Click Retrieve and the currently provisioned data is displayed.

............................................................................................................................................................

4 Enter appropriate values and click Apply.
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Using the CIT

....................................................................................................................................................................................................................................

365-575-781R1.1
Issue 1, June 2002

Lucent Technologies - Proprietary
See notice on first page

A - 6 7

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Reset Digital Performance Monitoring Storage Registers
....................................................................................................................................................................................................................................

Purpose Initialize (reset) the error counts for all current day and/or all current
15-minute PM storage registers.

Procedure ............................................................................................................................................................

1 “Access the Performance View in Node Manager” (A-56).

............................................................................................................................................................

2 From the Equipment Tree, select an optical line or OT port to be
reset. Click on the Digital Reset tab in the display panel.

Result:

Depending upon which piece of equipment is selected in the
Equipment Tree, a Digital Reset window such as the following
appears:
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............................................................................................................................................................

3 Make the appropriate selections and click Apply.

Result:

The following window appears:

Click Yes.

Reset Digital Performance Monitoring
Storage Registers
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Access the Test/Analysis View in Node Manager
....................................................................................................................................................................................................................................

Purpose Perform test and analysis procedures on equipment/signals.

Procedure ............................................................................................................................................................

1 Click the Test/Analysis button on the View Toolbar in the Node
Manager. This can also be accessed from the Node Manager menu by
selecting View > Test/Analysis.

Result:

The Test/Analysis View appears in the display panel of the Node
Manager.

............................................................................................................................................................

2 When equipment is selected in the Equipment Tree, the Test/Analysis
View displays available Test/Analysis options (if any) for the selected
equipment.
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Result:

The following is an example:

............................................................................................................................................................

3 The available option(s) for the selected equipment are chosen from the
tab(s) at the top of the display panel.

Access the Test/Analysis View in Node
Manager
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Test System Office Alarms
....................................................................................................................................................................................................................................

Purpose To insure the integrity of the audible and visible office alarms and
status indicators.

Procedure ............................................................................................................................................................

1 “Access the Test/Analysis View in Node Manager” (A-70).

............................................................................................................................................................

2 Select the System (highest level) in the Equipment Tree. Click on the
Office Alarms tab in the display panel.

Result:

The Office Alarms window appears:

............................................................................................................................................................

3 Make the appropriate selections and click Start.
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Result:

The LED alarm indications on the NE light and the alarm relays
on the NE operate causing local office audible and visual alarms
to activate. The corresponding User Panel LEDs are illuminated
simultaneously with each office alarm and status indicator.
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Test Circuit Pack LEDs
....................................................................................................................................................................................................................................

Purpose Visually inspect the circuit pack LEDs during installation or regular
maintenance.

Procedure ............................................................................................................................................................

1 “Access the Test/Analysis View in Node Manager” (A-70).

............................................................................................................................................................

2 From the Equipment Tree, select the desired slot to be tested. Click on
the LEDs tab in the display panel.

Result:

The Test Equipment LED window appears:

............................................................................................................................................................

3 Make the appropriate selections and click Start.
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Result:

The LED(s) under test is turned on and off for ten seconds, after
which it reverts to normal operation.
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Verify Fiber Connectivity
....................................................................................................................................................................................................................................

Purpose Test the add-side fiber connectivity between an OT and OM after
installing growth OTs in the in-service NE.

Procedure ............................................................................................................................................................

1 “Access the Test/Analysis View in Node Manager” (A-70).

............................................................................................................................................................

2 From the Equipment Tree, select the desired OT slot to be tested.
Click on the Fiber Connectivity tab in the display panel.

Result:

The Fiber Connectivity window appears.

............................................................................................................................................................

3 Select the line to be tested and click Start.
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Obtain OT Section Trace
....................................................................................................................................................................................................................................

Purpose Compare the expected incoming section trace byte (J0) identifier with
the received incoming section trace to verify the integrity of the
signal/connection.

Procedure ............................................................................................................................................................

1 “Access the Test/Analysis View in Node Manager” (A-70).

............................................................................................................................................................

2 From the Equipment Tree, select the appropriate port. Click on the
Section Trace tab in the display panel.

Result:

The OT Section Trace window appears:
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............................................................................................................................................................

3 Click Retrieve and the currently provisioned data is displayed.

............................................................................................................................................................

4 To set the value of the expected identifier to that received, check the
box.

............................................................................................................................................................

5 Make the appropriate selection from the Apply to: drop down menu
and click Apply.
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Specify OT Section Trace Settings
....................................................................................................................................................................................................................................

Purpose Set the mode (length of the received and expected incoming
messages) and specify the expected trace identifier.

Procedure ............................................................................................................................................................

1 “Access the Test/Analysis View in Node Manager” (A-70).

............................................................................................................................................................

2 From the Equipment Tree, select the desired port. Click on the Trace
Settings tab in the display panel.

Result:

The OT Trace Settings window appears:

............................................................................................................................................................

3 Click Retrieve and the currently provisioned data is displayed.
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............................................................................................................................................................

4 Select/enter the appropriate values.

............................................................................................................................................................

5 Make the appropriate selection from the Apply to: drop down menu
and click Apply.
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View Signal Status of OT Port
....................................................................................................................................................................................................................................

Purpose Retrieve incoming signal status of any OT input port to isolate signal
defect conditions during installation of NEs.

Procedure ............................................................................................................................................................

1 “Access the Test/Analysis View in Node Manager” (A-70).

............................................................................................................................................................

2 From the Equipment Tree, select the desired input port. Click on the
Signal Status tab in the display panel.

Result:

The OT Signal Status window appears:
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............................................................................................................................................................

3 Select the appropriate port(s) from the drop down list and click
Retrieve.

Result:

The signal status is displayed for the port(s) selected.
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Obtain Optical Channel Path Trace
....................................................................................................................................................................................................................................

Purpose Compare the expected identifier with the received identifier at the
drop side of an Add/Drop OT.

Procedure ............................................................................................................................................................

1 “Access the Test/Analysis View in Node Manager” (A-70).

............................................................................................................................................................

2 From the Equipment Tree, select the drop side line port of the
Add/Drop OT. Click on the Optical Channel Path Trace tab in the
display panel.

Result:

The Optical Channel Path Trace window appears:
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............................................................................................................................................................

3 Click Retrieve to obtain the results of the path trace.

............................................................................................................................................................

4 To set the value of the expected identifier to that received, check the
box.

............................................................................................................................................................

5 Make the appropriate selection from the Apply to: drop down menu
and click Apply.
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Specify Optical Channel Path Trace Settings
....................................................................................................................................................................................................................................

Purpose Set the expected/transmitted identifiers for the optical channel path
trace to verify connectivity between path terminating NEs.

Procedure ............................................................................................................................................................

1 “Access the Test/Analysis View in Node Manager” (A-70).

............................................................................................................................................................

2 From the Equipment Tree, select the appropriate drop/add port.
Depending on the port selected, click the Trace Settings tab or the
Optical Channel Path Trace Settings tab in the display panel.

Result:

For the drop side port, the following Optical Channel Path Trace
Settings window appears:
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For the add side port, the following Optical Channel Path Trace
Settings window appears:

............................................................................................................................................................

3 Click Retrieve and the currently provisioned data is displayed.

............................................................................................................................................................

4 Select/enter the appropriate values.

............................................................................................................................................................

5 Make the appropriate selection from the Apply to: drop down menu
and click Apply.
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Access the Fault View in Node Manager
....................................................................................................................................................................................................................................

Purpose Provision parameters related to system alarm options and settings, and
generate alarm lists.

Procedure ............................................................................................................................................................

1 Click the Fault button on the View Toolbar in the Node Manager.
This can also be accessed from the Node Manager menu by selecting
View > Fault.

Result:

The Fault View appears in the display panel of the Node
Manager.

............................................................................................................................................................

2 When equipment is selected in the Equipment Tree, the Fault View
displays available Fault options for the selected equipment.
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Result:

The following is an example:

............................................................................................................................................................

3 The available option(s) for the selected equipment are chosen from the
tab(s) at the top of the display panel.

Access the Fault View in Node Manager Using the CIT

....................................................................................................................................................................................................................................

A - 8 8 Lucent Technologies - Proprietary
See notice on first page

365-575-781R1.1
Issue 1, June 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Set Options and Generate Alarm List for Selected Equipment
....................................................................................................................................................................................................................................

Purpose Set options to be used when generating an Alarm List for selected
equipment.

Procedure ............................................................................................................................................................

1 “Access the Fault View in Node Manager” (A-87).

............................................................................................................................................................

2 From the Equipment Tree, select the piece of equipment for which an
Alarm List is to be generated. Click on the Alarm List tab in the
display panel.

Result:

The Fault Equipment Report window appears:
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............................................................................................................................................................

3 Select the settings to be applied to the Alarm List. Click Generate to
create the Alarm List for the selected equipment.

Result:

The Alarm List is displayed for the selected equipment.

Set Options and Generate Alarm List for
Selected Equipment
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Provision Alarm Severity Levels
....................................................................................................................................................................................................................................

Purpose Customize individual alarm severities to tailor operations plans to
specific operations environments.

Procedure ............................................................................................................................................................

1 “Access the Fault View in Node Manager” (A-87).

............................................................................................................................................................

2 Select the System (highest level) in the Equipment Tree. Click on the
Alarm Level tab in the display panel.

Result:

The System Alarm Level window appears:

............................................................................................................................................................

3 Click Retrieve to display the currently provisioned data.
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Result:

The System Alarm Level window appears displaying the
alarmable conditions.

............................................................................................................................................................

4 From the drop down lists, select the appropriate alarm level for any
alarm condition being modified. Click Apply.
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Provision System Alarm Settings
....................................................................................................................................................................................................................................

Purpose Configure the parameters that control the Office Alarms behavior.

Procedure ............................................................................................................................................................

1 “Access the Fault View in Node Manager” (A-87).

............................................................................................................................................................

2 Select the System (highest level) in the Equipment Tree. Click on the
Alarm Settings tab in the display panel.

Result:

The System Alarm Settings window appears:

............................................................................................................................................................

3 Click Retrieve to display the currently provisioned data.
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............................................................................................................................................................

4 Select the appropriate values and click Apply.
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Provision Miscellaneous Discretes Environmental Points
....................................................................................................................................................................................................................................

Purpose Define the alarm severities and the alarm messages for miscellaneous
discrete alarms in order to monitor the environment around the bay.

Procedure ............................................................................................................................................................

1 “Access the Fault View in Node Manager” (A-87).

............................................................................................................................................................

2 From the Equipment Tree, select Miscellaneous Discretes. Click on
the Environmental Points tab in the display panel.

Result:

The Environmental Points Provisioning window appears:

............................................................................................................................................................

3 Click Retrieve to display the currently provisioned data.
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............................................................................................................................................................

4 Enter/select the appropriate values and click Apply.

Provision Miscellaneous Discretes
Environmental Points
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Provision/Operate Miscellaneous Discretes Control Points
....................................................................................................................................................................................................................................

Purpose Define the condition names for the miscellaneous discrete controls and
activate/release control points.

Procedure ............................................................................................................................................................

1 “Access the Fault View in Node Manager” (A-87).

............................................................................................................................................................

2 From the Equipment Tree, select Miscellaneous Discretes. Click on
the Control Points tab in the display panel.

Result:

The Control Points Provisioning window appears:

............................................................................................................................................................

3 Click Retrieve to display the currently provisioned data.
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Result:

The window is populated with the currently provisioned data:

............................................................................................................................................................

4 The following applies:

• Status shows the current status of the control point (Open or
Closed).

• Action allows you to operate the control point. If the current
status is Open, then it possible to Close or Pulse (close
momentarily) the control point. If the current status is Closed,
then it is possible to Open it.

Enter/select the appropriate values and click Apply.

Provision/Operate Miscellaneous Discretes
Control Points
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Provision System Level Attributes for the NE
....................................................................................................................................................................................................................................

Purpose Provision the system level attributes for the NE including parameters
for Configuration, TID, EMS Port, Date/Time, and OA Pack.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Administration > System...

Result:

The following System Administration window is displayed.

Note: The tab titled Repeater Type is only visible when
connected to a Repeater NE.

............................................................................................................................................................

2 Select the appropriate tab(s) at the top of this window to enter any
system parameter changes needed.
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............................................................................................................................................................

3 Click on OK or Apply to execute changes.

Important! All the parameters which cause a reboot of the system are
set from within the Configuration tab in order to avoid repetitive
reboots. The user should finish setting all system parameters that
cause a reboot of the NE before executing the change for any of these
parameters.

............................................................................................................................................................

4 For any further changes needed to the system level parameters, select
the TID, EMS Port, Date/Time, or OA Pack tabs at the top of the
window and enter relevant information.

............................................................................................................................................................

5 Click OK or Apply to provision all changes.

Result:

The following warning is displayed. The included message(s)
are generated based upon which parameters are changed:

............................................................................................................................................................

6 Click Yes.

Provision System Level Attributes for the
NE
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Result:

The following notification is displayed prior to disconnecting the
Node Manager session if caused by this provisioning:

............................................................................................................................................................

7 Click OK.

Result:

The system provisioning operation is complete and the user is
disconnected from the NE if necessitated by the provisioning.

Provision System Level Attributes for the
NE
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Auto Update Messages
....................................................................................................................................................................................................................................

Purpose Allow/disallow the reporting of autonomous messages.

Note: The setting is on a per login basis and works as a toggle.

Procedure ............................................................................................................................................................

1 The system default allows the reporting of autonomous messages. To
disallow reporting of these messages, click once on the Auto Update
button located in the View Toolbar. Selecting it again will allow
reporting of autonomous messages.

Note: This option can also be toggled from the Node Manager menu
by selecting File > Auto Update. When reporting of autonomous
messages is allowed, the icon next to the menu item is highlighted.

Note: Every time the user logs into the Node Manager, Autonomous
Messages are automatically set to Allow.
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View Alarm List Report
....................................................................................................................................................................................................................................

Purpose Display a report listing the active alarms retrieved from the NE.

Procedure ............................................................................................................................................................

1 From the Node Manager, click on the desired icon in the Alarm
Toolbar. You can also view an alarm list via the Node Manager menu
by clicking on View > Alarm/Message List > [Selection].

Result:

The Alarm List window displays information for the selected
category.

............................................................................................................................................................

2 The Report Filters section of the window summarizes the total number
of alarms retrieved and the total number of informational messages.
Each report is launched with a default set of filters. The filters may be
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changed by clicking on the appropriate filter button (Critical, Major,
Minor). To display the informational messages, click on the
Messages icon.

View Alarm List Report Using the CIT
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Cut Off Audible Alarms
....................................................................................................................................................................................................................................

Purpose Turn off (silence) existing alarm sounds.

Procedure ............................................................................................................................................................

1 From the Node Manager, click on the Audible CutOff icon to the right
of the View Toolbar. You can also select Audible CutOff from the
Node Manager menu by clicking on Administration >Audible
CutOff.

Result:

Existing audible alarms are silenced.
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View Neighbors Report
....................................................................................................................................................................................................................................

Purpose Display a report listing all neighboring NEs that are connected to this
NE.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select View > Neighbors.

Result:

The Neighbors window appears:
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View Event History Log
....................................................................................................................................................................................................................................

Purpose Display the contents of an Event History log for the NE.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select View > Event History.

Result:

The Event History window appears:
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View Channel Map Report
....................................................................................................................................................................................................................................

Purpose Display a report listing all optical channels that are being used at the
current NE or all NEs in the OLS.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select View > Channel Map > This
NE or All NEs.

Result:

The Channel Map window appears.

............................................................................................................................................................

2 To view any possible errors encountered during data collection, you
can click the View Log button.
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Result:

The Channel Map Log appears:

View Channel Map Report Using the CIT

....................................................................................................................................................................................................................................

365-575-781R1.1
Issue 1, June 2002

Lucent Technologies - Proprietary
See notice on first page

A - 1 0 9

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



View OLS Configuration Report
....................................................................................................................................................................................................................................

Purpose Display a report listing all NEs in the OLS.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select View > OLS Configuration.

Result:

The OLS Configuration window appears:

............................................................................................................................................................

2 To view any possible errors encountered during data collection, you
can click the View Log button.
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View OLS Software/Database Report
....................................................................................................................................................................................................................................

Purpose Display a report listing current software and database information on
all NEs in the OLS.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select View >OLS
Software/Database.

Result:

The OLS Software/Database window appears:

............................................................................................................................................................

2 To view any possible errors encountered during data collection, you
can click the View Log button.

Using the CIT
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Refresh Alarms
....................................................................................................................................................................................................................................

Purpose Update the Node Manager Alarm Toolbar.

Note: This function is not necessary when Autonomous Messages are
Allowed (see “Auto Update Messages” (A-102)).

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select View > Refresh > Alarms.

Result:

The alarm toolbar is reinitialized.

Using the CIT
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Refresh Equipment
....................................................................................................................................................................................................................................

Purpose Update the Node Manager Equipment Tree.

Note: The Equipment Tree is never updated automatically when NE
equipment changes. The user must operate this function to refresh the
tree manually.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select View > Refresh > Equipment.

Result:

The equipment tree is updated and any new equipment is added.
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Security Administration - Add a User
....................................................................................................................................................................................................................................

Purpose Add a new user to the system.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Administration > Security >
Users...

Result:

The User Security Administration window is displayed:

............................................................................................................................................................

2 Click the Add... button.

Using the CIT
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Result:

The Add User window is displayed.

............................................................................................................................................................

3 Enter all pertinent information for the new user.

............................................................................................................................................................

4 Click OK or Apply.

Security Administration - Add a User Using the CIT
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Security Administration - View/Change User Security Settings
....................................................................................................................................................................................................................................

Purpose View or change security settings for an existing user.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Administration > Security >
Users...

Result:

The User Security Administration window is displayed.

............................................................................................................................................................

2 Select the user whose security settings are to be viewed/changed.

Result:

The Details... button becomes enabled as shown.

Using the CIT
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............................................................................................................................................................

3 Click on Details...

Result:

The following User Security Administration Details window is
displayed:

............................................................................................................................................................

4 View or change all pertinent information for the specified user.

............................................................................................................................................................

5 Click OK or Apply to process any new settings.

Security Administration - View/Change User
Security Settings
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Security Administration - Delete a User
....................................................................................................................................................................................................................................

Purpose Delete an existing user from the system.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Administration > Security >
Users...

Result:

The User Security Administration window is displayed.

............................................................................................................................................................

2 Highlight the user to be deleted.

Result:

The Delete button becomes enabled.

............................................................................................................................................................

3 Click on Delete.

Result:

The following warning is displayed:

............................................................................................................................................................

4 Click on Yes to delete the specified user.
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Security Administration - Set System Security Parameters
....................................................................................................................................................................................................................................

Purpose Set security parameters on the network element.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Administration > Security >
System...

Result:

The System Security Administration window is displayed:

............................................................................................................................................................

2 View or change appropriate information for the following as
necessary:

• User ID Lockout

• Inactivity Timeouts

• User ID Expiration

• Passwords

Using the CIT
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............................................................................................................................................................

3 Click OK or Apply to process new settings.

Security Administration - Set System
Security Parameters
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Security Administration - Change Password
....................................................................................................................................................................................................................................

Purpose Change your current password.

Note: From this screen, the only password that can be changed is the
password of the user who is currently logged in.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Administration > Security >
Change Password...

Result:

The Change Password window is displayed:

............................................................................................................................................................

2 Enter the required information in the appropriate fields.

............................................................................................................................................................

3 Click OK to change the password.
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View Software Release Information
....................................................................................................................................................................................................................................

Purpose Display the current software information for the active and inactive
areas of the FlashDisk Memory Module (FMM).

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Administration > Software >
Release Information...

Result:

The Software Release Information window is displayed:

............................................................................................................................................................

2 Click OK to close the window.
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Download Software
....................................................................................................................................................................................................................................

Purpose Download a software generic to the inactive partition of the NE
Controller (NCTL) circuit pack FlashDisk Memory Module (FMM).

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Administration > Software >
Download...

Result:

The Software Download window is displayed:

............................................................................................................................................................

2 Network Element Software Information is displayed for the active and
inactive partition of the FlashDisk Memory Module (FMM). From the
drop down list, select the NE software release to be downloaded.
Click OK or Apply.

Result:

The software is downloaded and the View Log button is
enabled.

Using the CIT
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Note: If the box is checked to swap the software between the active
and inactive areas which requires a reboot, the following warning
appears:

............................................................................................................................................................

3 To view a File Transfer Log of this operation, click View Log.
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Copy Software
....................................................................................................................................................................................................................................

Purpose Copy the software generic contained in the active or the inactive
memory partition of the network element currently connected (the
source) to the inactive memory partition of another network element
(the destination).

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Administration > Software >
Copy...

Result:

The Software Copy window is displayed:

Using the CIT
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............................................................................................................................................................

2 Network Element Software Information is displayed for the active and
inactive releases. For Copy from software area select Active or
Inactive to specify the software source to be copied.

............................................................................................................................................................

3 Select the copy destination from Destination TID(s) Available or
enter the TID in the Enter Destination TID field.

............................................................................................................................................................

4 Use the Add button to move the selected TID(s) to the Selected
Destination TID(s) area (maximum of 16 destination nodes). To
remove a TID(s) from this area, select the TID(s) and click on the
Remove button.

............................................................................................................................................................

5 Click OK or Apply to copy the software to the TID(s) in the
destination area.

............................................................................................................................................................

6 To view a Software Copy Log of this operation, click View Log.
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Reboot System
....................................................................................................................................................................................................................................

Purpose Reboots the NE and swaps NE software between the active and
inactive areas if so desired.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Administration > System
Reboot...

Result:

The System Reboot window is displayed:

............................................................................................................................................................

2 Network Element Software Information is displayed for the active and
inactive software releases. To Swap the software between the active
and inactive areas, click this box.

............................................................................................................................................................

3 Click OK.
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Result:

The following warning is displayed:

............................................................................................................................................................

4 Click Yes.

Result:

The following message is displayed:

............................................................................................................................................................

5 Click OK.

Result:

The Node Manager is disconnected.

Reboot System Using the CIT
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Add Compatible Optics Connection
....................................................................................................................................................................................................................................

Purpose Add an external (EXT) connection which bypasses the use of OT
equipment and therefore cannot be autodiscovered/autoprovisioned.

Note: This procedure does not apply to Repeaters.

Important! When adding a compatible optics connection to a
LambdaXtreme™ Transport NE, it is recommended that the user first
provision an external (EXT) type connection before applying the input
signal from the external source to the LambdaXtreme™ Transport NE.
Users must ensure that the external source is transmitting a stable
signal (non-fluctuating) before applying it to the LambdaXtreme™

Transport NE in order to preserve stable transmission and not cause a
power transient.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Channels > Optical
Connections... or click on the Connections button located in the
View Toolbar.
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Result:

The Optical Channel Connections window is displayed:

............................................................................................................................................................

2 To add a compatible Optics Channel Connection, click on the Add...
button.

Add Compatible Optics Connection Using the CIT
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Result:

The Add a Compatible Optics Channel Connection window is
displayed:

............................................................................................................................................................

3 Select the appropriate Line value from the drop down list (if node
type is OADM). Next, select the channel frequency by moving the
slider or typing the value directly into the field.

All valid and available channel frequencies are selectable. These
values are based on node type. For End Terminals, all channel
frequencies that are available (not in use by other connections) are
selectable. For OADM, only the available frequencies configured to
Add/Drop are selectable.

Note: To provision connections on an OADM node, the OADM
frequency must first be configured to Add/Drop (see “OADM
Configuration” (A-135)). In an OADM NE, the NE only validates and
allows booting of OTs which have frequencies that can be
added/dropped. In the OADM NE, only OTs that have frequencies
that end in 0 (as opposed to 5) can be used to add/drop channels. The
express channels (frequencies that end in 5) cannot be added/dropped.

............................................................................................................................................................

4 Once the channel frequency has been chosen, click the Add Selected
Frequency check box.
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............................................................................................................................................................

5 Click on OK or Apply to add the Optical Channel Connection.

............................................................................................................................................................

6 To view autoprovisioned connection events received during this
session, click Events.

Add Compatible Optics Connection Using the CIT

....................................................................................................................................................................................................................................

A - 1 3 2 Lucent Technologies - Proprietary
See notice on first page

365-575-781R1.1
Issue 1, June 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Delete Optical Connection
....................................................................................................................................................................................................................................

Purpose Delete an Optical Channel Connection that is no longer needed or
cannot be accessed.

Note: This procedure does not apply to Repeaters.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Channels > Optical
Connections... or click on the Connections button located in the
View Toolbar.

Result:

The Optical Channel Connections window is displayed.

............................................................................................................................................................

2 Select the connection to be deleted.

Using the CIT
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Result:

The Delete button becomes enabled.

............................................................................................................................................................

3 Click Delete.

Result:

For connections that are not external (Type not equal to EXT),
the following warning is displayed:

For external connections (Type=EXT), the following warning is
displayed:

............................................................................................................................................................

4 Click Yes to delete the connection.
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OADM Configuration
....................................................................................................................................................................................................................................

Purpose Configure OADM frequencies to Add/Drop (so a channel can be
added/dropped) or Through.

Note: This procedure applies only to OADM NEs.

Procedure ............................................................................................................................................................

1 From the Node Manager menu, select Channels > OADM
Configuration

Using the CIT
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Result:

The OADM Configuration window is displayed:

............................................................................................................................................................

2 Specify the configuration for the desired frequency by clicking on the
appropriate box (Add/Drop or Through). More than one frequency can
be configured.

............................................................................................................................................................

3 Click on Apply.

OADM Configuration Using the CIT
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Result:

Depending on the reconfiguration being applied, a warning such
as the following may appear:

............................................................................................................................................................

4 Click on Yes to reconfigure.
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Access the Help Viewer
....................................................................................................................................................................................................................................

Purpose View or search for help topics.

Procedure ............................................................................................................................................................

1 From the OLS Manager menu or Node Manager menu, select Help >
Help Contents & Find.

Result:

The Help Viewer is displayed:

Using the CIT
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............................................................................................................................................................

2 To find a help topic, click one of the following tabs:

• Contents - To browse through the table of contents, click the
Contents tab. The table of contents is an expandable list of
available topics.

• Search - To locate every occurrence of a word or phrase that is
contained in any help file, click the Search tab, and then type the
word followed by the Enter key.

............................................................................................................................................................

3 Click the Contents entry, or Search Results entry to display the
corresponding topic.
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Glossary

NUMERICS
3R (Reshaping, Reamplification, Retiming) Functionality
When a signal is converted from optical to electrical, optical translators reshape, reamplify, and
retime the electrical signal.

10/100 BASE-T
A twisted-pair cable version of an IEEE 802.3 network.

100BASE-TX
A 100-Mbps Ethernet implementation over Category 5 twisted-pair cabling. In other words, this
is a 100 megabit-per-second local area network known by the generic name of Fast Ethernet
operating over twisted copper cable. This technology is becoming very popular and
cost-effective. It is designed to integrate with existing networks with minimal disruption.

....................................................................................................................................................................................................................................

A ACO (Alarm Cut-Off)
A push-button switch on the indicator strip that can be used to retire an audible office alarm.

AID (Access Identifier )
AIDs identify an entity or a range of entities within a NE in a TL1 message (for example, a
port or list of ports). See also TL1. This field is optional.

AIM (Alarm Indication Message)
A message sent from a one NE to another NE to indicate that it has received a signal so
degraded that it raised an alarm.

AIS (Alarm Indication Signal )
A signal sent downstream by a NE to indicate that its incoming signal has failed.

Alarm
External notification or display of a failure condition. The indication of a failure towards an
external system interface or via audible or visible indicators.

....................................................................................................................................................................................................................................
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Alarm List
A status report that lists active alarms on the NE.

Alarm Log
A history of the setting and clearing of system alarms on the NE.

Alarm Severity
An attribute defining the priority of the alarm message. The way alarms are processed depends
on the severity.

Alarm Suppression
Selective removal of alarm messages from being forwarded to the GUI or to network
management layer OSs.

Angular Misalignment
Loss at a connector due to misaligned fiber end face angles.

Anomaly
Any deviation from normal behavior. Anomalies do not result in any consequent actions, but are
contributors to defects and performance monitoring counts.

ANSI (American National Standards Institute)
A United States standards body that accredits standards for programming languages,
communications and networking; it is the U.S. representative in the International Organization
for Standardization (ISO).

APC (Angle Polished Connector)
An 5″-15″ angle on the connector tip for the minimum possible back reflection.

Apparatus Code
ASCII name assigned by the manufacturer to identify a particular circuit pack by pack type and
number.

APR (Automatic Power Reduction)
The lowering of the laser power to a limit that fits into class 1 category for handling fiber
cables. APR replaces the full power off feature known as ALS (automatic laser shutdown) or
APSD (automatic power shutdown).

AR (Antireflection coating)
A thin, dielectric or metallic film applied to an optical surface to reduce its reflection and
thereby, increase its transmission.

ASE (Amplified Spontaneous Emission)
An optical noise generated in an erbium-doped fiber amplifier (EDFA) with and without signal
input power.
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ASTM (American Society for Testing and Materials)
A non-profit industry wide organization that publishes standards, methods of test, recommended
practices, definitions and other related material.

Asynchronous
Data that is transmitted without an associated clock signal.

ATAG (Autonomously generated correlation TAG)
An autonomous TL1 message (event) counter used to detect lost events.

ATM (Asynchronous Transfer Mode )
A digital transmission switching format, containing 5 bytes of header information followed by
48 data bytes. Part of the B-ISDN standard.

Attenuation
The decrease in signal strength along a fiber optic waveguide caused by absorption and
scattering. Attenuation is usually expressed in dB/km.

Attenuator
In optical systems, a passive device that reduces the amplitude of a signal without distorting the
waveform.

Auto-Provisioning
Configuration of system parts without pre-provisioning. When a part is plugged into the system
it is accepted with its default configuration.

Automatic Protection Switch
A protection switch that occurs automatically in response to an automatically detected fault
condition.

Autonomous Messages
Messages sent to the CIT to notify it of state changes in the system. These messages are
initiated by the system. They are not responses to a CIT-initiated command.
Examples of Autonomous Messages include alarms, events (non-alarmed condition), notification
of connections that are added or deleted, and changes in the node database.

....................................................................................................................................................................................................................................

B Backscattering
The return of a portion of scattered light to the input end of a fiber; the scattering of light in
the direction opposite to its original propagation.

Bay
A mechanical facility to mount shelves and other equipment for system configurations. Bays can
be accessed from the front side or front and rear side. It is made of aluminum or steel and is
attached to the wall or ceiling. Equipment cabling is laid in or attached to the Bay. Also known
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as rack.

BCM (Board Controller Module)
A small module (printed wiring board plus components) that plugs into almost every circuit
pack (other than the NCTL, SCTL, and SUPVY) to supply the processor, memory and intra-NE
communications capabilities needed to operate the pack in the system.

Beamsplitter
An optical device, such as a partially reflecting mirror, that splits a beam of light into two or
more beams. Used in fiber optics for directional couplers.

Bend Radius
The smallest radius an optical fiber or fiber cable can bend before increased attenuation or
breakage occurs.

Bending Loss
Attenuation caused by high-order modes radiating from the outside of a fiber optic waveguide,
which occur when the fiber is bent around a small radius. See also macrobending,
microbending.

BER (Bit Error Rate)
BER measures how accurately a bit stream is transmitted through a system. It measures how
many bits are received in error compared to how many are sent.

Birefringent
When the refractive index differs in light of different polarizations.

....................................................................................................................................................................................................................................

C Cable Assembly
A cable that is connector terminated and ready for installation.

Cable Plant
The cable plant consists of all the optical elements including fiber connectors, splices, etc.
between a transmitter and a receiver.

CCITT (Consultative Committee for the International Telephone and Telegraph)
An international advisory committee under United Nations’ sponsorship that has composed and
recommended for adoption worldwide standards for international communications. Recently
changed to the International Telecommunications Union Telecommunications Standards Sector
(ITU-TSS).

CDS (Complementary Double Shelf)
The double shelf used in an Extension Bay; two per bay.
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CE (Conformite Europeenne)
The CE Mark is a European proof of conformity and is also described as ″passport″ that allows
manufacturers and exporters to circulate products freely within the EU. The letters ″CE″
indicate that the manufacturer has satisfied all assessment procedures specified by law for its
product.

Center Wavelength
In a laser, the nominal value central operating wavelength. It is the wavelength defined by a
peak mode measurement where the effective optical power resides. In a LED, the average of the
two wavelengths measured at the half amplitude points of the power spectrum.

Channel
A communications path or the signal sent over that path.

Chirp
In laser diodes, the shift of the laser’s central wavelength during single pulse duration due to
laser instability.

Chromatic Dispersion
The speed at which an optical pulse travels depends on the fiber wavelength. This is caused by
several factors including material dispersion, waveguide dispersion and profile dispersion. The
net effect is that if an optical pulse contains multiple wavelengths (colors), then the different
colors travel at different speeds and arrive at different times, smearing the received optical
signal.

CIO (Controller Input/Output) Circuit Pack
CIO indicates Ethernet port status.

CIT (Craft Interface Terminal)
The terminal used as the local interface between humans and an NE. It is used to issue
commands to the local system or, by way of a remote login, to another system on the same
fiber as the local system.

CL (Coupling Ratio/Loss)
The ratio/loss of optical power from one output port to the total output power, expressed as a
percent.

Cladding
The material that surrounds the core of an optical fiber which has a lower index of refraction
compared to that of the core. The lower index of refraction causes the transmitted light to travel
down the core.

CLEI (Common Language Equipment Identifier)
For circuit packs in domestic markets, this is assigned by Telecordia and is 10 bytes (characters)
long. The CLEI is mapped to the ECI (Equipment Code Identifier) in the customer database. For
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international market, the CLEI is assigned by CClib and is 9 characters long.

Connector
A mechanical or optical device that provides a demountable connection between two fibers or a
fiber and a source or detector.

Connector Plug
A device used to terminate an optical conductor cable.

Connector Receptacle
The fixed or stationary half of a connection that is mounted on a panel/bulkhead. Receptacles
mate with plugs.

Connector Variation
The maximum value in dB of the difference in insertion loss between mating optical connectors
(for example, with re-mating, temperature cycling, etc.). Also called optical connector variation.

Core
The central portion of the fiber that transmits light. It is composed of material with a higher
index of refraction than the cladding.

Coupler
An optical device that combines or splits power from optical fibers.

CR (Coupling Ratio/Loss)
The ratio/loss of optical power from one output port to the total output power, expressed as a
percent. For a 1 x 2 WDM or coupler with output powers O1 and O2, and Oi representing both
output powers.

CRC (Cyclic Redundancy Check)
A method to detect skipped bits in a byte stream.

CSA (Canadian Standards Association)
A non-profit independent organization which operates a listing services for electrical and
electronic materials and equipment. It is the body that establishes telephone equipment (and
other) standards of use in Canada. At least in part, CSA is the Canadian counterpart of the
Underwriters Laboratories. CSA also is heavily involved in the development of the ISO
standards on quality and Environmental Management.

CSMA/CD (Carrier Sense Multiple Access with Collision Detection)
A control technique for getting onto and off a LAN. All devices attached to the network listen
for transmissions in progress (that is, carrier sense) before starting to transmit (multiple access).
If two or more begin transmitting at the same time and their transmissions crash into each other,
each backs off (collision detection) for a different amount of time (determined by an algorithm)
before again attempting to transmit.
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CTAG (Correlation Tag)
The CTAG of a TL1 command is repeated in the associated response and allows an operator to
find matches.

Current SW Generic (Current Software Generic)
The software and data that the NE is currently using. It is loaded on to the active partition of
the FMM.

CW (Continuous Wave)
The constant optical output from an optical source when it is turned on, but not modulated with
a signal.

....................................................................................................................................................................................................................................

D DAR (Deutscher AkkreditierungsRat)
The German Accreditation Council (DAR) is a working group established by the Federal
Government, the Ministries of the Federal German States and the German industry. DAR
coordinates the activities in the area of accreditation and recognition of testing and calibration
laboratories, certification and inspection bodies in Germany; runs a central registration of
German accreditations and recognitions granted; and represents German interests in national,
European and international organizations dealing with general questions of accreditation and
recognition.

Dark Current
The flow of electricity through the diode in a photodiode when no light is present.

DCC (Data Communication Channel)
A portion of the SDH/SONET signal that contains alarm, surveillance, and performance
information.

DCF (Dispersion Compensating Fiber)
DCF is a special fiber with a negative chromatic dispersion coefficient used to compensate the
positive chromatic dispersion of the transmission fiber in the third optical window.

DCM (Dispersion Compensation Module)
Spooled fiber used to control excess dispersion found in certain fiber types at pre- and
post-amplification.

DCN (Data Communication Network)
DCN supports communications between NEs and the NMS.

DCS (Digital Cross-Connect System)
A system that has multiple input and output streams, and can interconnect a signal from any
input to any output.
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DEMUX or DMX (Demultiplexer)
A module that separates two or more signals previously combined by compatible multiplexing
equipment.

Detector
An opto-electric transducer used in fiber optics to convert optical power to electrical current.
Usually referred to as a photodiode.

DGEF (Dynamic Gain Equalization Filter)
A filter that equalizes the gain of an optical signal

DHCP (Dynamic Host Control Protocol)
DHCP enables PCs and workstations to get temporary or permanent IP addresses from the
server.

DIN (Deutsche Industrie Norm)
DIN is the German Institute for Standardization in Berlin. Since 1975 it has been recognized by
the German government as the national standards body and represents German interests at
international and European level.

Directional Coupler
A coupling device for separately sampling (through a known coupling loss) either the forward
(incident) or the backward (reflected) wave in a transmission line.

Dispersion
The temporal spreading of a light signal in an optical waveguide caused by light signals
traveling at different speeds through a fiber either due to modal or chromatic effects.

Distortion
The difference in value between two measurements of a signal (transmitted and received.)

DL (Data Link)
The communication links used for data transmission from a source to a destination.

DSA (Directory System Agent)
A DSA is an operating system application process that provides the Directory functionality.

DSF (Dispersion-Shifted Fiber)
Standard single-mode fibers exhibit optimum attenuation performance at 1550 nm and optimum
bandwidth at 1300 nm.

DTE (Data Terminal Equipment)
DTE is part of a broader grouping of equipment known as customer premises equipment which
includes voice, data, and end terminals.

....................................................................................................................................................................................................................................
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Duplex Cable
A two-fiber cable suitable for duplex transmission.

Duplex Transmission
Transmission in both directions, either one direction at a time (half-duplex) or both directions
simultaneously (full-duplex).

DWDM (Dense Wavelength Division Multiplexing)
Transmitting two or more signals of different wavelengths simultaneously over a single fiber.

....................................................................................................................................................................................................................................

E E-LEAF (Enhanced -Large Effective Area Fiber)
A fiber type manufactured by Corning.

EDC (Error Detection Code)
Code construction that provides a way to protect, correct data from errors, and maintain the data
integrity.

EDCV (Error Detection Code Violation)
An EDCV occurs when the calculated checksum over a signal does not match the received
checksum.

EDFA (Erbium-Doped Fiber Amplifier)
Optical fibers doped with the rare earth element erbium which can amplify light in the 1550 nm
region when pumped by an external light source.

EEPROM (Electrical Erasable and Programmable Read-Only Memory)
Kind of non-volatile memory. Often used to store inventory data.

EMI (Electromagnetic Interference)
High-energy, electrically induced magnetic fields that cause data corruption in cables passing
through the fields.

EML (Externally Modulated Laser)
When laser is modulated using a Mach-Zehnder modulator.

EMR (Electromagnetic Radiation)
Radiation made up of oscillating electric and magnetic fields and propagated with the speed of
light. Includes gamma radiation, X-rays, ultraviolet, visible and infrared radiation, and radar and
radio waves.

EMS (Element Management System)
Element management systems, for example, OCI or SNMS, which are either directly attached to
a NE or remotely by using the DCN.
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Engineering Rules
A set of rules that determine the system configuration possibilities based on fiber type, OA, rate
and number of wavelengths. These rules determine the maximum loss per span that can be
tolerated, the maximum distance between spans allowed and the maximum number of spans that
can be supported.

EOL (End-Of-Life)
EOL defines the status or values at the end of the guaranteed lifetime. EOL is reached when the
wear-out failure rate dominates the component failure rate.

Error Recovery
The intent to recover from a detected error, such as inconsistent state or configuration
information. See also Operational Recovery.

ES-IS (End System to Intermediate System Protocol)
An ISO OSI network layer protocol (ISO 9542) for End Systems (alias hosts) communicating to
Intermediate Systems (alias routers) that dynamically builds the relevant network routing
databases (administrative protocol).

ESD (Electro-Static Discharge)
Static electrical energy potentially harmful to circuit packs and humans.

ET (End Terminal)
Optical equipment that terminates optical line signals.

ETSI (European Telecommunications Standards Institute)
Located in Sophia-Antipolis in France, ETSI is the European counterpart to ANSI. Its task is to
pave the way for telecommunications integration in the European community as part of the
single European market program. It establishes telecommunication standards for the European
community.

External Modulation
Modulation of a light source by an external device that acts like an electronic shutter.

Extinction Ratio
The ratio of the low, or OFF optical power level (Pl) to the high, or ON optical power level
(Ph).

Eye Pattern
Also called eye diagram. The proper function of a digital system can be quantitatively described
by its BER, or qualitatively by its eye pattern. The ″openness″ of the eye relates to the BER
that can be achieved.
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....................................................................................................................................................................................................................................

F Fabric
The part of an optical system that is responsible for switching voice, data or video from one
place to another

Failure
A failure is declared when a fault cause persists for a certain period of time.

Failure Rate
The number of failures of a device per unit of time.

Fall Time
The time required for the trailing edge of a pulse to fall from 90% to 10% of its amplitude; the
time required for a component to produce such a result. Typically measured between the 80%
and 20% points or alternately the 90% and 10% points. Also called turn-off time.

Far-End Crosstalk
Crosstalk which travels along a circuit in the same direction as the signals in the circuit.

FAS (Frame Alignment Signal)
A sequence at the beginning of an SDH/SONET frame that detects the frame start.

FC (Fiber Optic Connector)
A threaded optical connector (originated in Japan), good for single-mode or multimode fiber and
applications requiring low back reflection.

FC/PC
A special curved polish on the connector for very low back reflection.

FCC (Federal Communications Commission)
The U.S. federal regulatory agency responsible for the regulation of interstate and international
communications by radio, television, wire, satellite and cable.

FDDI (Fiber Distributed Data Interface)
A 100 Mbps fiber optic LAN.

FE (Far End)
Any other network element in a maintenance subnetwork other than the one the user is at or
working on. Also called remote.

FEBE (Far End Block Error)
A maintenance signal transmitted in the physical overhead indicating that a bit error has been
detected at the physical layer at the far end of the link.
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FEC (Forward Error Correction)
A method to correct bit errors in a transmission signal. Additional information is put into the
data signal to allow the correction of bit errors. There is no acknowledge information in the
back direction.

Ferrule
A rigid tube that confines or holds a fiber as part of a connector assembly.

Fiber Optic Attenuator
A component installed in a fiber optic transmission system that reduces the power in the optical
signal. It is often used to limit the optical power received by the photo detector to within the
limits of the optical receiver.

Fiber Optic Cable
A cable containing one or more optical fibers.

Fiber Optic Link
A transmitter, receiver, and cable assembly that can transmit information between two points.

Fiber Optic Span
An optical fiber/cable terminated at both ends which may include devices that add, subtract, or
attenuate optical signals.

FIT (Failure In Time)
A unit of failure rate in reliability analysis. One FIT is equivalent to one failure per one billion
operating hours.

FIT Rate
Number of device failures in one billion device hours.

FMM (FlashDisk Memory Module)
A nonvolatile memory device used to store the installation software generic or the NE database.

Fresnel Reflection
A reflection of light that occurs at the air-glass interface at the ends of an optical fiber.

Fused Fiber
A bundle of fibers fused together so they maintain a fixed alignment with respect to each other
in a rigid rod.

Fusion Splicer
An instrument that permanently bonds two fibers together by heating and fusing them.
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....................................................................................................................................................................................................................................

G Gain
The increase in power and magnitude of a signal.

GNE (Gateway Network Element)
A system node that has a physical attachment to the management system to support the access
of the remote NE. The number of remote NEs a GNE can serve is specified in terms of the
number of OSI stack associations the GNE can support without running out of local resources.

GPIO (General Purpose Input/Output)
GPIO provides a flexible way of interfacing a wide range of peripheral devices with a computer.
Among the interface methods GPIO uses are the configurable data sense and handshaking
(signals used between a computer and a peripheral to inform each other when either is ready to
receive or transmit data).

Grooming
Consolidating or segregating traffic for efficiency.

Ground Loop Noise
Noise that results when equipment is grounded at points having different potentials thereby
creating an unintended current path. The dielectric properties of optical fiber provide electrical
isolation that eliminates ground loops.

....................................................................................................................................................................................................................................

H HDDS (High Density Double Shelf)
The double shelf used in Line Bays; two per bay.

....................................................................................................................................................................................................................................

I ICEA (Insulated Cable Engineers Association)
ICEA (previously IPCEA) is a professional organization dedicated to developing cable standards
for the electric power, control, and telecommunications industries.

IDI (Initial Domain Identifier)
Part of the NSAP, the IDI defines the country code of the registration authority responsible for
the allocation and assignment of the NSAP address.

IEC (International Electrotechnical Commission)
The international standards and conformity assessment body for all fields of electrotechnology,
including electricity and electronics.

IEEE (Institute of Electrical and Electronic Engineers)
The IEEE helps advance global prosperity by promoting the engineering process of creating,
developing, integrating, sharing, and applying knowledge about electrical and information
technologies and sciences for the benefit of humanity and the profession.

....................................................................................................................................................................................................................................

365-575-781R1.1
Issue 1, June 2002

Lucent Technologies - Proprietary
See notice on first page

G L O S S A R Y
G L - 1 3



IMF (Infant Mortality Factor)
The ratio of the first year failure rate to the steady-state failure rate.

Index of Refraction
Also refractive index. The ratio of the velocity of light in free space to the velocity of light in a
fiber material. Symbolized by n and is greater than or equal to one.

Index-Matching Gel
A gel with an index of refraction nearly equal to that of the fiber’s core. This gel is used to
reduce Fresnel reflection at fiber ends.

Insertion Loss
The loss of power that results from inserting a component, such as a connector or splice, into a
previously continuous path.

Intrinsic Losses
Splice losses arising from differences in the fibers being spliced.

IR (Intermediate Reach)
Optical sections from a few kilometers (km) to approximately 15 km.

Irradiance
The amount of power per unit area.

ISO (International Standards Organization)
A United Nations agency concerned with international standardization in a broad range of
industrial and technical field.

ITU (International Telecommunication Union)
A United Nations telecommunications established to provide standardized communications
procedures and practices including frequency allocation and radio regulations on a worldwide
basis.

....................................................................................................................................................................................................................................

J Jacket
The outer, protective covering of the cable.

Jitter
Small and rapid variations in the timing of a waveform due to noise, changes in component
characteristics, supply voltages, imperfect synchronizing circuits, and so forth.

Jumper
A short fiber optic cable with connectors on both ends.
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....................................................................................................................................................................................................................................

L L-Band (Long Band)
A dispersion-shifted fiber range of 1570 to 1610 nm, where a wide range of wavelengths are
possible with low loss. L-Band doubles the number of wavelengths best suited in DWDM
applications and uses newer, more expensive optical amplifiers. In LambdaXtreme™ Transport,
the L-Band is widened and referred to as an Extended L-Band.

LAN (Local Area Network)
1. A communication link between two or more points within a small geographic area, such as
between buildings. 2. A data network which has a size of normally up to 10 km. Important
LANs are Ethernet, Token Ring, Token Bus and FDDI.

LAPD (Link Access Protocol on D-channel)
A special protocol of the OSI Data Link Layer, which provides the functional and procedural
means to establish, maintain, and release data link connections for NEs. For NE-NE
communications over the DCC, Layer 2 services are provided by LAPD.

Launch Fiber
An optical fiber used to couple and condition light from an optical source into an optical fiber
Often the launch fiber is used to create an equilibrium mode distribution in multimode fiber.
Also called launching fiber.

LBC (Laser Bias Current)
Current that runs through the laser to make it work. LBC is monitored by performance
monitoring. If the current goes beyond a certain threshold, it means that the circuit pack must
be replaced.

LBO (Line Build Out)
Attenuation used to simulate a load.

LC (Lucent Connector)
A small-form-factor (SFF) design based on a proven 1.25 mm ceramic ferrule. This connector
uses RJ-style latching. It facilitates high-speed applications with lower power requirements due
to lower insertion loss (0.1 dB typical) and higher return loss (55 dB single mode).

LD (Laser Diode)
A semiconductor that emits coherent light when forward biased.

LEAF (Large Effective Area Fiber)
A type of fiber manufactured by Corning.

LED (Light-emitting diode)
Diodes which translate electrical current into light. Made out of semiconductor material like
Gallium-Arsenide; a semiconductor that emits incoherent light when forward biased.
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LGX (Lightguide Cross-Connect)
(Lucent product family) Fiber termination shelves and hardware used for interconnecting fiber
cables, jumpers and closures that connect the switching systems to the transmission equipment.

LH (Long Haul)
A 10 Gbps application for transmission of 128 channels, giving a capacity of 1.28 Tbps and a
reach of up to 2000 km. Payload (per channel) can be one OC192/STM-64 or four
OC48/STM-16 signals.

LID (Link ID Protocol)
A Lucent proprietary protocol for exchange of neighbor information over a DCC link. LID
makes use of LAPD (OSI) or PPP (IP).

lnterchannel Isolation
The ability to prevent undesired optical energy from appearing in one signal path as a result of
coupling from another signal path.

LOF (Loss of Frame)
Loss of frame is detected when the OOF anomaly persists for a certain time.

Loose-Tube
A type of fiber optic cable construction where the fiber is contained within a loose tube in the
cable jacket.

LOS (Loss of Signal)
When the optical input power falls below a certain threshold.

Loss
The amount of a signal’s power, expressed in dB, that is lost in connectors, splices, or fiber
defects.

LR (Long Reach)
A standard for optics, concerning transmitters and receivers in a system and ensuring that
transmission can be maintained for long distances (tens of kilometers). This standard constrains
the output power of the transmitter and the sensitivity of the receiver for long-haul applications
(up to 80 km) without the need for regeneration.

....................................................................................................................................................................................................................................

M Macrobending
In a fiber, all macroscopic deviations of the fiber axis from a straight line.

MAN (Metropolitan Area Network)
A network covering an area larger than a local area network. A wide area network (two or more
local area networks), that covers a metropolitan area.
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Margin
The allowance for attenuation in addition to that explicitly accounted for in system design.

MAS (Multiplex Alignment Signal)
A byte in the 40G overhead which checks if the four-bit multiplexed 10G data streams are
demultiplexed correctly. It has a value of 10100101 in the first 10G data stream, and 01011010
in the other 10G data streams.

MDI (Miscellaneous Discrete Inputs)
System input ports used to supervise external equipment in the office, for example, doors, fire
alarm, and so forth.

MDO (Miscellaneous Discrete Outputs)
System binary output ports used to control external equipment in the office, for example, light,
and so forth.

Mechanical Splice
An optical fiber splice accomplished by fixtures or materials, rather than by thermal fusion.

Microbending
Minute but severe bends in fiber that result in light displacement and increased loss.

Modulation
The process by which the characteristic of one wave (the carrier) is modified by another wave
(the signal). Examples include amplitude modulation (AM), frequency modulation (FM), and
pulse-coded modulation (PCM).

MPI (Multipath Interference)
Signal reflections and delayed signal images that interfere with the proper signal path. MPI is
caused by reflections from dirty/damaged connectors, and return loss of the jumpers/patch cords.
MPI may cause severe system degradation.

MS (Multiplex Section)
A multiplex section is a maintenance entity between two MS TT functions.

MTBF (Mean Time Between Failures)
The expected time between failures, usually expressed in hours.

MTTR (Mean Time To Repair)
The average time that it takes until a failure is repaired, usually expressed in hours.

Multimode Fiber
An optical fiber that has a core large enough to propagate more than one mode of light The
typical diameter is 62.5 micrometers.
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Multiplexing
The process by which two or more signals are transmitted over a single communications
channel. Examples include time-division multiplexing and wavelength-division multiplexing.

MUX (Multiplexer)
A device that combines two or more signals into a single output.

....................................................................................................................................................................................................................................

N Navis Optical Element Management System (OEMS)
Navis OEMS is an element management system that provides networks with operational
functions such as configuration management, fault management, performance management, and
security management.

NCTL (Network Element Controller)
The NCTL provides control and user interfaces at the NE level.

NE (Network Element)
Processor controlled entities of a telecommunications network that primarily provide switching
and transport network functions and contain network operations functions.

Near Infrared
The part of the infrared near the visible spectrum, typically 700 nm to 1500 nm or 2000 nm.

Near-End Crosstalk
The optical power reflected from one or more input ports, back to another input port. Also
known as isolation directivity.

NEBS (Network Equipment Building Systems)
Developed by Telcordia, these are standards that vendors must adhere to if they want to sell
equipment to the Regional Bell Operating Companies (RBOCs) and the Competitive Local
Exchange Carriers (CLECs).

NEC (National Electric Code)
A standard governing the use of electrical wire, cable and fixtures installed in buildings;
developed by the NEC Committee of the American National Standards Institute (ANSI), and
sponsored by the National Fire Protection Association (NFPA).

NEMA (National Electrical Manufacturers Association)
NEMA, created in the fall of 1926 by the merger of the Electric Power Club and the Associated
Manufacturers of Electrical Supplies, provides a forum for the standardization of electrical
equipment, enabling consumers to select from a range of safe, effective, and compatible
electrical products.
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NFPA (National Fire Protection Association)
A not-for-profit organization which works with U.S. Congress and federal agencies to promote
the adoption and use of fire protection codes and standards, and to promote a uniform national
approach to fighting the problem of fires.

NIM (Non-intrusive Monitor)
A kind of sink termination point function which does not touch SDH/SONET signals but
monitors quality of service.

NSAP (Network Service Access Point)
The access point where the Network Layer Services are available to network service users.

NVM (Non-Volatile Memory)
NVM denotes memory which survives a shut-down or power-down of the system such as a hard
disk, floppy or tape. Xtreme uses a PCMCIA card for NVM.

NZDSF (Non-Zero Dispersion Shifted Fiber)
Fiber that was designed to introduce a small amount of dispersion without the zero point
crossing being in the WDM passband. With this type of fiber you can eliminate, or at least
greatly reduce the degradation due to four wave mixing, a distortion mechanism that requires
the spectral components to be phase matched along the fiber. Examples are the TrueWave fiber
from Lucent and the LS fiber from Corning.

....................................................................................................................................................................................................................................

O OA (Optical Amplifier)
A device that amplifies an input optical signal without converting it into electrical form. The
best OAs developed are optical fibers doped with the rare earth element, erbium.

OADM (Optical Add Drop Multiplexer) Terminal
A terminal capable of adding and dropping lower-rate signals from a higher- rate multiplexed
signal without completely demultiplexing the signal.

OBA (Optical Booster Amplifier)
An optical amplifier with high output power.

OC-n (Optical Carrier-level n)
A carrier rate specified in the SONET standard.

OCWR (Optical Continuous Wave Reflectometer)
An instrument used to characterize a fiber optic link where an unmodulated signal is transmitted
through the link, and the resulting light scattered and reflected back to the input is measured.

OD (Optical Demultiplexer)
ODs extract individual wavelengths from the DWDM optical that is generated using an Optical
Multiplexer (OM).
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OGC (Optic Gate Controller)
The controller of an Optic Gate module. Its tasks are to control the components of the module
and connect it to a circuit pack.

OLS (Optical Line System)
A lightwave transmission system that can multiplex up 8, 16, 80 or more wavelengths, transmit
the resulting multiplexed signal, and then demultiplex the signal at the other end.

OM (Optical Multiplexer)
The process by which two or more wavelengths are combined onto a single fiber.

OMON (Optical MONitor)
The OMON circuit pack scans the entire DWDM spectrum to provide Optical Spectrum
Analysis (OSA) for up to 4 or 8 selected locations in an NE.

OMS (Optical Multiplex Section)
A layer in the Xtreme transmission hierarchy.

OOF (Out of Frame)
State in which the frame alignment sequence of an SDH/SONET frame has not been found for
several consecutive frames.

OOS (Out-of-Service)
The circuit pack is not providing its normal service function (removed from either the working
or protection state) either because of a system problem or because the pack has been removed
from service.

Operational Recovery
A recovery with the intent to perform an operation, such as to activate new software version.

Optical Channel
An optical wavelength band for WDM optical communications.

Optical Channel Spacing
The wavelength separation between adjacent WDM channels.

Optical Channel Width
The optical wavelength range of a channel.

Optical Isolator
A component used to block out reflected and unwanted light. Used in laser modules, for
example. Also called an isolator.
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Optical Link Loss Budget
The range of optical loss over which a fiber optic link will operate and meet all specifications.
The loss is relative to the transmitter output power.

Optical Path Power Penalty
The additional loss budget required to account for degradations due to reflections, and the
combined effects of dispersion resulting from intersymbol interference, mode-partition noise,
and laser chirp.

Optical Power Meter
An instrument that measures the amount of optical power present at the end of a fiber or cable.

Orderwire
A section of the supervisory signal that is used for communication between sites.

ORL (Optical Return Loss)
The ratio (expressed in units of dB) of optical power reflected by a component or an assembly
to the optical power incident on a component port when that component or assembly is
introduced into a link or system.

OSA (Optical Spectrum Analyzer)
Optoelectronic device that resolves the incident light into individual wavelengths and display
power vs. wavelength. Usually these are based on diffraction-grating.

OSC (Optical Supervisory Channel)
See SUPVY/SU (Supervisory Channel).

OSI (Open System Interconnection)
The internationally accepted grouping of standards for communication between different systems
made by different vendors.

OSNR (Optical Signal to Noise Ratio)
The ratio between the optical power of the data signal and the power of the optical noise signal.

OT (Optical Translators)
OTs do frequency adaptation between LambdaXtreme™ Transport equipment and external
equipment that are not optically compatible with LambdaXtreme. OTs also provide 3R
functionality (retiming, reshaping, reamplification); and, perform fault management and
performance monitoring (Non-intrusive Monitoring) on the SONET/SDH and WaveWrapper
signal.

OTDR (Optical Time Domain Reflectometer)
An instrument that locates faults in optical fibers or infers attenuation by backscattered light
measurements.
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OXC (Optical Cross-connect)
Devices that can switch optical signals between different optical fibers, without the need for
conversion to electrical signals.

....................................................................................................................................................................................................................................

P Passive Branching Device
A device which divides an optical input into two or more optical outputs.

PCMCIA (Personal Computer Miniature Communications International Association)
An international standards body and trade association that establishes standards for Integrated
Circuit cards and promotes interchangeability among mobile computers where ruggedness, low
power, and small size were critical.
PCMCIA publishes the PC Card standard which contains all of the physical, electrical and
software specifications for the PC card technology. .

PCMCIA Adapter (Personal Computer Miniature Communications International Association)
Adapter
A slot on the Network controller or PC where the flash disk is inserted.

PD (Photodetector)
An optoelectronic transducer such as a PIN photodiode or avalanche photodiode.

PDU (Protocol Data Unit)
PDUs are used for the information exchange between equal protocol layers.

Peak Power Output
The output power averaged over that cycle of an electromagnetic wave having the maximum
peak value that can occur under any combination of signals transmitted.

Photodiode
A device that converts optical energy to electrical energy.

PID (Password Identification)
A word or character string recognized by automatic means that permits a user access to
protected storage, files, or input or output devices.

Pigtail
A short optical fiber permanently attached to a source, detector or other fiber optic device.

Plastic Clad Silica
Also called hard clad silica (HCS). A step-index fiber with a glass core and plastic or polymer
cladding instead of glass.
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Plenum
The air handling space between walls, under structural floors, and above drop ceilings, which
can be used to route intrabuilding cabling.

Plenum Cable
A cable that has flammability and smoke characteristics which allow it to be routed in a plenum
area without being enclosed in a conduit.

PLL (Phase Locked Loop)
An electronic circuit that controls an oscillator so that it maintains a constant phase angle
relative to a reference signal.

PM (Performance Monitoring)
Measures the quality of service and identifies any degrading or marginally operating systems
(before an alarm would be generated).

PMD (Polarization Mode Dispersion)
PMD is an inherent property of all optical media. It is caused by the difference in the
propagation velocities of light in the orthogonal principal polarization states of the transmission
medium. The net effect is that if an optical pulse contains both polarization components, then
the different polarization components travel at different speeds and arrive at different times,
smearing the received optical signal.

pN_EBC (Near-end Errored Block Count)
Every second the number of near-end errored blocks (N_Bs) within that second is counted as
the Near-end Errored Block Count (pN_EBC). This counter is used to determine the degraded
defect and as an input for the performance monitoring process.

Point-to-Point Transmission
The transmission between two designated stations.

Polarization
The direction of the electric field in the lightwave.

PPP/IP (Point-to-Point Protocol/Internet Protocol)
A protocol used by a computer to connect to the Internet via a dial up telephone line and
modem.

Pre-Provisioning
The capability to provision a slot before installing a circuit pack.

Previous SW Generic (Previous Software Generic)
The previous SW generic is the software and data on the alternate partition to the currently
executed SW/data of the PCMCIA card. It might be installed and activated per user command.
After installation previous and current SW generic are exchanged.
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Provisioning
Placing and configuring hardware and software required to activate a telecommunications
service for a customer. If the equipment is in place, provisioning may consist of creating or
modifying a customer record in a database to activate the services.

Pulse Spreading
The dispersion of an optical signal as it propagates through an optical fiber.

Pump laser
A laser used in an optical fiber amplifier.

....................................................................................................................................................................................................................................

Q QoS (Quality of Service)
A set of performance parameters that characterize the transmission quality over a given virtual
connection.

....................................................................................................................................................................................................................................

R Raman Amplification
A technique in which high-power laser light is sent into the outside plant fiber (OSP)
transforming part of the fiber itself into an amplifier.

Rayleigh Scattering
The scattering of light that results from small inhomogeneties of material density or
composition.

RBOC (Regional Bell Operating Company)
One of the seven regional holding companies formed after the AT&T divestiture. These
companies included Ameritech, Bell Atlantic, BellSouth, NYNEX, Pacific Telesis, Southwestern
Bell, and U.S. West. Later on, Bell Atlantic and NYNEX merged and became Verizon;
Ameritech, Pacific Telesis and Southwestern Bell merged and became SBC; and U.S. West was
renamed Quest.

RDI (Remote Defect Indication)
RDI signals convey the defect status of the trail signal at the trail destination (that is, at trail
termination sink function) back to the trail origin (that is, trail termination source function).
This mechanism allows alignment of the near-end and far-end performance monitoring
processes.

Receiver
A terminal device that includes a detector and signal processing electronics. It functions as an
optical-to-electrical converter.

Receiver Overload
The maximum acceptable value of average received power for an acceptable BER or
performance.

....................................................................................................................................................................................................................................
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Receiver Sensitivity
The minimum acceptable value of received power needed to achieve an acceptable BER or
performance. It takes into account power penalties caused by use of a transmitter with
worst-case values of extinction ratio, jitter, pulse rise and fall times, optical return loss, receiver
connector degradations, and measurement tolerances.

Refractive Index
A property of optical materials that relates to the speed of light in the material.

Refractive Index Gradient
The change in refractive index with distance from the axis of an optical fiber.

Refractive Index Profile
The description of the value of the refractive index as a function of distance from the optical
axis along an optical fiber diameter

Regenerator
A repeater, designed for digital transmission, in which digital signals are amplified, reshaped,
retimed, and retransmitted. For optical transmission, a device that receives an optical signal,
converts it to electrical, regenerates the signal, converts it to optical, then transmits it.

REI (Remote Error Indication)
REI signals contain either the exact or truncated number of error detection code violations
detected in the trail signal at the trail termination sink. This information is conveyed to the trail
termination source. REI allows alignment of the near-end and far-end performance monitoring
processes. Examples of REI signals are the FEBE bits in SDH signals.

Repeater
A receiver and transmitter set designed to amplify attenuated signals. Used to extend operating
range.

Responsivity
The ratio of a photodetectors electrical output to its optical input in Amperes/Watt.

Ribbon Cables
Cables in which many fibers are embedded in a plastic material in parallel, forming a flat
ribbon-like structure.

Rise Time
The time taken to make a transition from one state to another, usually measured between the
10% and 90% completion points of the transition. Alternatively the rise time may be specified
at the 20% and 80% amplitudes. Shorter or faster rise times require more bandwidth in a
transmission channel.
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Riser Cables
High-strength cables used in vertical shafts between floors in multi-story buildings.

RJ (Random Jitter)
Random jitter is due to thermal noise and may be modeled as a Gaussian process. The
peak-to-peak value of RJ is of a probabilistic nature, and thus any specific value requires an
associated probability.

RM (Registration Manager)
The Registration Manager is an application process that initiates the Registration Request
Protocol, and communicates the DSA address and Name-prefix information to the Registration
Agent.

RP (Raman Pump)
In LambdaXtreme Transport, RPs provide amplification/gain in the outside plant fiber by
supplying a counterpropagating signal. The amplification is provided by ″pumping″
high-intensity wavelengths (that are lower than the signal wavelength) into the fiber that carries
the incoming DWDM signal. (Also see RPG).

RPG (Growth Raman Pump)
In LambdaXtreme Transport, RPGs provide amplification/gain in the outside plant fiber and
internally in the Dispersion Compensation Module. RPGs provide copropagating wavelengths to
the outside plant fiber at the output DWDM signal and counterpropagating wavelengths to the
incoming DWDM signal and to the Dispersion Compensation Module. RPGs are optional; they
are used for channels above 188.45 THz. (Also see RP).

....................................................................................................................................................................................................................................

S SC (Subscription channel connector.)
A push-pull type of optical connector that originated in Japan. Some of its features are high
packing density, low loss, low backreflection, and low cost.

Scattering
The change of direction of light rays or photons after striking small particles. It may also be
regarded as the diffusion of a light beam caused by the inhomogeneity of the transmitting
material.

SCOT (Software Control of Transmission)
The software architecture and algorithms for control of transmissions in LambdaXtreme
Transport. Software control includes the following areas: startup, transient control, APR and
APR recover, single node failure in a network, adding/deleting channels, and adding the
expansion pump pack (RPG).

SCTL (Shelf Controller)
SCTL provides control at the double shelf backplane level (half of a bay).
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SDH (Synchronous Digital Hierarchy)
A family of digital transmission rates from 51.84 Mb/s to 9.953 Gb/s that allows the
interconnection of transmission products around the world.

SEC (SDH Equipment Clock)
A timing device (equipment) used to synchronize network equipment that operates according to
the principles governed by SDH.

Shelf
A shelf is a mechanical facility that is in general a housing for circuit packs. Shelves are housed
in Bays.

Simplex
Single element (for example, a simplex connector is a single-fiber connector).

Simplex Cable
A term sometimes used for a single-fiber cable.

Simplex Transmission
Transmission in one direction only.

SIO (System Input/Output) Circuit Pack
SIO CP connects the NCTL to the SCTLs, provides the main interface to the system, provides
LAN interfaces, provides orderwire interfaces, and provides performance monitoring interfaces.

SNMS (Sub-Network Management System)
See Navis OEMS.

Soliton Pulse
An optical pulse having a shape and power level designed to take advantage of nonlinear effects
in an optical fiber waveguide, for the purpose of essentially negating dispersion over long
distances. The result is that the pulse retains its original shape as it travels.

SONET (Synchronous Optical Network)
A North-American standard developed by Bell-Labs for the optical long distance networks.

Span
Fiber link between NEs that may be unidirectional or bidirectional, depending upon network
design.

Span Loss
Loss (in dB) of optical power due to the span transmission medium (includes fiber loss and
splice losses).

....................................................................................................................................................................................................................................
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Spectral Width
A measure of the extent of a spectrum. For a source, the width of wavelengths contained in the
output at one half of the wavelength of peak power. Typical spectral widths are 50 to 160 nm
for an LED and 0.1-5 nm for a laser diode.

Splice
A permanent connection of two optical fibers through fusion or mechanical means.

Splitting Ratio
The ratio of power emerging from two output ports of a coupler.

SPOT (Synchronous Partial Overhead Transparency)
Overhead bytes of SDH/SONET transmission signals which are sent together with payload
although they are mapped into higher rate signals. The transparency feature is often used in
combination with fiber shortage solutions.

SR (Short Reach)
Optical sections of 2 km or less.

SRS (Simulated Raman Scattering)
a broadband effect where power is transferred from a low wavelength channel to a
higher-wavelength channel. The short wavelength source acts like a ″pump″ .

SSMF (Standard single-mode fiber)
This is the most common type of fiber deployed. This fiber was designed to provide zero
chromatic dispersion at 1310 nm, to support the early long-haul transmission systems operating
at this wavelength. It has a chromatic dispersion of at most 20 ps/(nm*km) in the 1550 nm
wavelength range and usually around 17 ps/(nm*km).

ST (Straight tip connector)
Popular fiber optic connector that uses a bayonet style coupling rather than a screw-on coupling.

Step-Index Fiber
Fiber that has a uniform index of refraction throughout the core.

Strength Member
The part of a fiber optic cable composed of aramid yarn, steel strands, or fiberglass filaments
that increase the tensile strength of the cable.

SUPVY Pack (Supervisory Pack)
SUPVY circuit pack is a low-speed transmission pack that facilitates communication between
LambdaXtreme NEs.
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SUPVY/SUP (Supervisory Channels)
SUPVY/SUP supports the following communications: node-to-node, interworking, client LAN,
and orderwire communication.

SW Generic (Software Generic)
The whole software and (static) data associated with a particular NE release. See also current
and previous SW generic.

Synchronous
A data signal that is sent along with a clock signal.

....................................................................................................................................................................................................................................

T T-Carrier
Generic designator for any of several digitally multiplexed telecommunications carrier systems.

Tap
The entry point into a system module

Tap Loss
In a fiber optic coupler, the ratio of power at the tap port to the power at the input port.

Tap Port
In a coupler where the splitting ratio between output ports is not equal, the output port
containing the lesser power

TBOS (Telemetry Byte Oriented Serial) Protocol
A protocol used for transmitting alarms, status, and control points between a NE and the
operating system.

TC (Tandem Connection)
An arbitrary series of contiguous link connections and/or subnetwork connections.

TCA (Threshold-Crossing Alert)
A condition set when a counter exceeds a user-selected high or low threshold. A TCA does not
generate an alarm but is available on demand through the CIT.

TCP/IP (Transmission Control Protocol/Internet Protocol)
A suite of several networking protocols developed for the Internet that provides communication
across interconnected networks, between computers with diverse hardware architectures and
various operating systems. Some examples are FTP, SMTP, SNMP, and so forth.

TD (Transmit Degrade)
Indicates that the transmitted signal has degraded to a level where a certain threshold of error
code violations is exceeded.

....................................................................................................................................................................................................................................
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TDC (Tunable Dispersion Compensator)
A device which has negative chromatic dispersion where the amount of dispersion can be
adjusted. It is used for compensation of the chromatic dispersion of the transmission fibers.

Thermal Noise
Noise resulting from thermally induced random fluctuation in the receiver load resistance
current.

Throughput Loss
In a fiber optic coupler, the ratio of power at the throughput port to the power at the input port.

TID (Target Identifier)
A provisionable parameter used to identify a NE within a TL1 command.

TL1 (Transaction Language 1)
TL1 is an OS/NE machine-to-machine language. TL1 messages are expressed as ASCII strings.
TL1 messages and syntax are defined by Telcordia requirements.

TrueWave® Fiber
Non–zero dispersion-shifted fiber manufactured by Lucent Technologies.

TSD (Trail Signal Degrade)
The TSD signal (generated by a trail termination sink function) informs the next function(s) of
the ″signal degrade″ condition of the associated data signal.

TSF (Trail Signal Fail)
The TSF signal (generated by a trail termination sink function) informs the next downstream
function(s) of the ″signal fail″ condition of the associated data signal (which contains, due to
that ″signal fail″ condition, the all-ONEs (AIS) pattern).

TT (Trail Termination)
An atomic function within a layer that generates, adds, and monitors information concerning the
integrity and supervision of adapted information.

....................................................................................................................................................................................................................................

U UART (Universal Asynchronous Receiver and Transmitter)
A receiver/transmitter that converts incoming serial data from a port into parallel form.

UFEC (Ultra Forward Error Correction)
An improved method to correct bit errors in a transmission signal. Additional information is put
into the data signal to allow the correction of bit errors. There is no acknowledge information in
the back direction.
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UHC (Ultra High Capacity)
A 40G application for transmission of 64 channels for a capacity of 2.56 Tbps and a reach of up
to 1000 km. Payload (per channel) can be one OC768/STM-256 or four OC192/STM-64 signals.

UID (User Identification)
A CIT user code that comprises one to ten alphanumeric, case-sensitive characters. UID
identifies a user when he/she logs into a system.

ULH (Ultra Long Haul)
A 10 Gbps application for transmission of 128 channels giving a capacity of 1.28 Tbps and a
reach of 2000–4000 km. Payload (per channel) can be one OC192/STM-64 or four
OC48/STM-16 signals.

UNITE (UNIversal high speed TDM Equipment for multi-services)
A 10G/40G platform.

....................................................................................................................................................................................................................................

V VOA (Variable Optical Attenuator)
VOA correct the signal strength differences that occur in the transmission line.

VSR (Very Short Reach)
VSR is a SONET/SDH interface that provides a low-cost solution interconnection of less than
300 meters between routers, switches and DWDM systems.

....................................................................................................................................................................................................................................

W WAN (Wide Area Network)
A network whose elements are separated by long distances.

Waveguide
A material medium that confines and guides a propagating electromagnetic wave.

Waveguide Couplers
A coupler in which light is transferred between planar waveguides.

Waveguide Dispersion
The part of chromatic dispersion arising from the different speeds light travels in the core and
cladding of a single-mode fiber (that is, from the fiber’s waveguide structure).

Wavelength
The distance between points of corresponding phase of two consecutive cycles of a wave. The
wavelength, is related to the propagation velocity, and the frequency.

Wavelength Growth
A type of growth in which all eight wavelengths are added to a single line before more lines are
added.
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WaveWrapper
WaveWrapper provides network management functions such as optical-layer performance
monitoring, error correction and ring protection on a per-wavelength basis.

WDM (Wavelength-Division Multiplexing)
Sending several signals through one fiber with different wavelengths of light.

WGR (Waveguide Grating Router)
Device used to take a mix of wavelengths and separate into the component wavelengths

WTR time (Wait To Restore time)
The WTR time ensures that a previous failed synchronization source is only again considered as
available by the selection process if it is fault free for a certain time.

....................................................................................................................................................................................................................................

X XT Crosstalk X-talk
Undesired coupling from a circuit, part of a circuit, or channel to another.

....................................................................................................................................................................................................................................

Y Y Coupler
A variation on the tee coupler in which input light is split between two channels (planar
waveguide) that branch out like a Y.

....................................................................................................................................................................................................................................

Z Zero DSF (Zero Dispersion Shifted Fiber)
DSF where the zero dispersion point is shifted from 1310nm to 1550 nm. It is best suited for
applications involving single channel transmission at 1550 nm, providing the benefits of zero
dispersion as well as taking advantage of the lower attenuation wavelength.
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See: Craft Interface
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LambdaXtreme™

Transport Ultra Long
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See: Light-emitting diode
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2-9
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2-3
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Environmental points,
2-20
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TBOS interface, 2-20
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NCTL
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Provisioning external
connections for
compatible optics,
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Overview, 4-12

Provisioning optical
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vector, 4-12
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Optical Translator (OT),
1-2, 4-8
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DB15S connectors, 2-10

Implementation, 2-10

OSC
See: Optical Supervisory

Channel

OT
See: Optical Translator
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See: Performance

Management
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4-9
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Software and Database
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Viewing software
release information,
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Volatile memory, 2-24

Solicited outputs
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SONET environment, 2-6

Supervisory Channel, 2-10

Supervisory Channel
Provisioning, 4-14

Orderwire, 4-14

Overview, 4-14

Provisioning Orderwire
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(SUPVY), 4-14

Supervisory Data Link, 2-2

SUPVY
See: Supervisory Channel
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System Input/Output Panel
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Technical support, xviii
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7-9
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Features, 7-9
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